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Preface 

ResEdiell, an extensible standalone resource editor for the Macintoshl computer, is a 
powerful tool you can use to speed your software development process and to 
create icons, menus, and other resources for Macintosh programs and flies. This 
manual is a complete reference to ResEdit that includes introductions to the various 
resource type editors included in the program, and a discussion of the framework 
that is provided so that you can extend the capabilities of the program by adding 
your own resource pickers and editors. 

xi 



Prerequisites 

To run ResEdit 2.0, the system you use must have at least 128 KB of ROM and at least 1 
megabyte of memory.; 

ResEdit 2.0 works with system software version 5.0 and later. ResEdit is compatible with (but 
does not require) 32-bit QuickDraw™. 

What this manual contains 

Chapter 1 introduces the concepts behind ResEdi~ starting with an overview of Macintosh 
resources. Chapter 2 tells you about the user interface. Chapter 3 discusses the editors in 
ResEdit that handle various kinds of bitmap resources (CUlSOrs, icons, and so on), and Chapter 
4 discusses the other built-in editors. Chapter 5 describes template editing and tells you how 
to build your own templates. Chapter 6 is a "hints and kinks" area that contains useful 
information that will help you make efficient use of ResEdit Chapter 7 describes the 
programmatic interface to ResEdit and tells you what you need to know in order to write your 
own picker and editor. Appendix A describes the inner workings of the 'KCHR' editor, 
Appendix B describes the inner workings of the 'BNDL' resource, Appendix C lists a number 
of extant resource types, and Appendix D is a chart of the regular Macintosh character set 

How to use this manual 

If you have used. previous versions of ResEdit, you will probably want to take a quick look at 
Chapter 2, which describes the user interface in some detail, specifically because the interface 
has been changed extensively in version 2.0. 

If you have never used ResEdit, you should probably read Chapters 1 and 2 and look over the 
rest of the book. Use the program for a while, and then look at the book again. It will 
probably make a lot more sense after you've actually played with ResEdit. 

xii ResEdit 2.1 Reference 



Conventions used in this book 

The following visual rues are used throughout this book to identify different types of 
information: 

• Note: A note like this contains information that is interesting but not essential for an 
understanding of the main text 

6 Important A note like this contains information that is essential. t::. 

.. Warning Warnings like this indicate potential problems. .A. 

This manual uses courier type to represent code fragments and the names of procedures. 

Graphics 

Most of the artwork in this book is taken directly from Macintosh screens. Some illustrations 
show a condensed version of the screen with a sequence of windows or some particular 
feature (such as a menu) evident Others show only an active window, or an alert or 
dialog box. 

Where to get information 

Apple technical books published by Addison-Wesley, such as Inside Macintosh, are available 
at commercial bookstores. Books and manuals published by Apple are available through 
APOA, the Apple Programmers and Developers Association, at the address listed below. 
Technical notes and other materials of interest to Macintosh application developers are also 
available from APOA. 
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AboutAPDA 

APDA provides a wide range of technical products and documentation, from Apple and other 
supplielS, for programmelS and developelS who work on Apple equipment You can contact 
them as follows. 

APDA 
Apple Computer, Inc. 
20525 Mariani Avenue, MIS 33-<1 
Cupertino, CA 9501~299 

Telephone: 1-800-282-APDA or 1-800-282-2732 if you are inside the United States; 
in canada, 1-800-637-0029; elsewhere in the world, 01-408-562-3910. 
Pax: 408-562-3971 Telex: 171-576 AppleLink: DEY.CHANNELS 

About Developer Programs 

If you plan to develop hardware or software products for sale through retail channels, you 
can get valuable support from Apple Developer Programs. Write to them at the 
following address: 

Apple Developer Programs 
Apple Computer, Inc. 
20525 Mariani Avenue, MIS 75-2C 
Cupertino, CA 9501~299 
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Chapter 1 ResEdit Overview 

This chapter introduces the concept of resources as they are handled on the 
Macintosh8 computer, and introduces ResEdiell, an interactive, graphically 
based application for manipulating resources in Macintosh fIles. Some 
Macintosh flIes don't contain any resources, but all applications and roost of 
the System Folder flIes do. 

1 



Resources 

One of the ways in which the Macintosh is different from other computelS is its handling of 
resoun;e; (typefaces, icons, dialog boxes, and so on). In the Macintosh, resources are distinct 
from data (for example, the text in a word-processing ftle). The Macintosh does not insist on 
keeping resources in a central pool; they may be placed in any me. 

In IIX>St computelS, a me consists of a set of bytes, perhaps beginning with a header that 
contains some information about the structure of the data contained in the me, and possibly 
ending with some sort of trailer; in any case, the me is one set of bytes. The Macintosh has, 
instead, a me structure that is designed to include two sets of bytes, a data fork and a resource 
fork. Any fUe may contain only a data fork, only a resource fork, or both. While a plain 
HypelCard stack, for example, has only data in it, people commonly add icons and sounds to 
their stacks, creating resource fOlks for those stacks in the process. 

Resources are classifted by type. Each type has its own name, which consists of exactly four 
charactelS. Any charactelS in the Macintosh character set can occur in resource type names, 
even unprintable ones, but typically they consist of lower- and uppercase lettelS, numerals, 
punctuation marks, space, and Option-space. Resource type names are shown here with 
single straight quotation marks around them (for example, 'idO'). If you see a name that 
appealS to be shorter, the empty slots are probably filled with spaces (for example, 'snd '). 
Sotre resource types are named and described in Appendix C. There are many different types 
of resources, and you can create your own resource types with ResEdit if you don't ftnd the 
type you need. 

• Note: Apple Computer, Inc., reserves all names that don't contain any uppercase letters. 
Any combination with at least one uppercase letter in it is youlS to use, though it is a good 
idea to avoid using any type natre that someone else has already used that you know of. 

Another feature of this system is that code is regarded as a resource. It even has its own 
resource type name (very straightforwardly, 'CODE'). Any application, then, must have a 
resource fork, which is where its code resides, along with various other resources, such as 
menus. 

2 ResEdit 2.1 Reference 



( ResEdit lets you copy and paste all resource types, and lets you edit many of them ('NFNT' is 
an exception, and is discussed briefly in the section on 'FONT' editing, in Chapter 3.) ResEdit 
actually includes a number of different resource editors: There is a general resource editor 
for editing any resource in hexadecimal and ASCII formats, and there are individual resource 
editors for various specific resource types. There is also a template editor, which lets you 
edit some kinds of resources in a dialog box forma~ with fields that you can fIll in as 
appropriate. There are predefmed templates for quite a few resources already built into 
ResEdit, and you can create others. For further information on template editing and on 
generating your own templates, see Chapters 4 and 5. 

New and changed resource types supported by ResEdlt 2.0 

The 'den' color icon resource type is up to S bits deep and contains its own color lookup 
information. It defaults to a size of 32 x 32 pixels, though both its height and its width can be 
changed independently to be anything from S to 80 pixels. This icon resource includes a 
monochrome version and rmsk. ResEdit 2.0 includes an editor for 'dcn' resources. 

Finder icons for system software version 7.0 occur in 6 variants, including the old 'ICN#' and 
the new'ies#' types, as well as the new 4- and 8-bit small and large color icons ('ics4', 'iesS', 
'icl4', and 'iclS'). A comprehensive editor in ResEdit 2.0 lets you deal with each set of Finder 
icons as a coherent group. 

ResEdit 2.0 includes an editor for bundles, resource type 'BNDL' (bundles also involve other 
resources, as described in Appendix B), and an editor for menus, resource types 'MENU', 
'cmnu', 'CMNU', and 'mctb'. These editors are discussed in Chapter 3. 

Resource categories in ResEdit 

ResEdit behaves as if there were three kinds or categories of resources on the Macintosh. 

Resources of the first kind are accessed with individual pickers and edited with individual 
editors. These resources and their editors are described in some detail in Chapters 3 and 4. 
Several of these resources ('CURS', 'FONT', 'ICON', 'PAT', and so on) are in some sense 
pictorial. All of the pictorial resources are edited with bit editors, which are discussed in 
Chapter 3. 
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Resources of the second kind are edited as templates. That is, if you open a resource of this 
kind, you are presented with a dialog box in which there are various labeled fields. You can 
change the contents of the frelds. Information on existing templates and on genetating your 
own templates appears in Chapter 5, and an example of template editing appears in 
Chapter 6. 

Resources of the third kind are edited with the hexadecimal editor, unless you write your own 
templates or editors for them. 

Uses 

ResEdit is especially useful for creating and changing gtaphic resources such as dialog boxes 
and icons. For example, you can use ResEdit to try out different formats and presentations of 
resources in the process of putting together a quick prototype of a user interface. Anyone can 
quickly learn to use ResEdit for ttanslating resources into languages other than English 
without having to recompile prograrm. You can use ResEdit to modify a program's resources 
at any stage in the process of program development ResEdit is also useful for modifying the 
'LA YO' (desktop layout controO resource in a copy of the Finder™ so that you can 
reconfigure some aspects of the desktop display. See Chapter 6 for more details about the 
'LA YO' resource. 

Extensibillty 

A key feature of ResEdit is its extensibility. Because it can't anticipate the formats of all the 
different types of resources that you may use, ResEdit is designed so that you can teach it to 
recognize and parse new resource types. 

There are two ways that you can extend ResEdit to handle new types: 

• You can create templates for your own resource types. ResEdit lets you edit most resource 
types by filling in the fields of a dialog box; this is the way you edit the Finder's desktop 
layout control resource, for example. The ordering of the items in these dialog boxes is 
determined by a template in ResEdit's resource me, and you can add templates to ResEdit 
or to the ResEdit preferences flle yourself to edit new resource types. Resource templates 
are described in Chapters 4 and 5, and the desktop layout control resource is discussed in 
some detail in Chapter 6. 
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• You can progIam your own special-purpose resource picker or editor (or both) and 
add it to either ResEdit or to the ResEdit Preferences file. (The resource picker is the code 
that displays all the resources of one type in the resource type window. The editor is the 
code that displays and allows you to edit a particular resource. These pieces of code are 
separate from the main code of ResEdit.) A set of Pascal or C routines, called ResEd, is 
available for this purpose-see Chapter 7 for information. The advantage of adding your 
code to the ResEdit Preferences fde rather than to ResEdit itself is that doing so facilitates 
updating to new versions of ResEdit as they become available. 

The resource development cycle 

ResEdit is often used with Macintosh Programmer's Workshop (MP~ and other program 
development systems. Once you have created or modified a resource with ResEdi~ you can 
use the MPW resource decompiler, DeRez, to convert the resource to a textual representation 
that can be processed by the resource compiler, Rez. You can then add comments to this text 
fde or otherwise modify it with the MPW Shell or another text editor. Rez and DeRez are fully 
described in the Macintosh Programmer's Workshop Reference (MPW Reference). It is not 
necessary to use Rez or DeRez unless you have some specific need or desire to modify or 
conurent the code that DeRez produces; the resources generated by ResEdit are, in general, 
entirely acceptable. 

Chapter 1 ResEdit Overview 5 
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Chapter 2 Getting Started 

If you are new to ResEdi~ you will want to proceed with some caution, as 
ResEdit is quite powerful and can easily damage or destroy your files. If you 
are acrustomed to earlier versions of ResEdi~ you will notice that the user 
interface has been extensively changed and now conforms rrore closely to 
the guidelines established by Apple Computer, Inc. 
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Invoking ResEdit 

ResEdit is a regular application, so if you are in the Finder or in HyperCard you can start it up 
just as you would any other application. If you are using MPW, you can start ResEdit by 
entering either of these conumnds in the MPW Shell: 

ResEdit 

ResEdit file! file2 .•. 

The latter command causes ResEdit to open the named fIles automatically. 

When ResEdit fIrst starts up, it displays an animlted ·splash screen. It Figure 2-1 shows one of 
the stages of this animation. 

• Flgure2-1 Splash screen 
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The animation continues until you click the mouse anywhere or press any key. If you click 
the mouse or press an unmodified key ResEclit puts up a dialog box, shown in Figure 2-2, that 
lets you create a new flle or open an existing one. If you press a command-key combination, 
the splash screen is dismissed and ResEdit perl'onns the action you have requested. This is 
especially useful for conunand keys assigned to the Open Special menu, described in this 
chapter. You can, if you wish, use the Preferences conunand on the rue menu to choose not 
to have ResEdit put up the dialog box. 

• Figure 2-2 ResEdit fde open dialog 

10 utllsl 
.... 111 t'I1"-..:rII;ti • 

~ Rbout Time 
o Rntlulral 
~ Apple HD SC Setup 
o Bostonll 

. . 
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o Clock Doc ; i 

~ ~=;~!:t~!e;O~!d Sampler : I 
~ Disk First Rid 

r'-' Ntlabatlattl ••• 

Ele(t 

Orlu~ 

New 

I Open D 
Cancel 

You can select a fllename by clicking it or by typing one or more characters of the filename. 

Working with rues 
ResEdit proVides facilities to let you open flles, create new files, create resources, move and 
edit them, and perl'orm two levels of verification on them. 
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Resource checkJng 

Sometimes a resource me gets corrupted. This is typically the result of a crash occurring while 
the me is being updated. In the past, ResEdit would occasionally crash when you tried to 
open a damaged file with it. Version 2.0 of ResEdit provides resource me checking facilities to 
help avoid crashes and to minimize loss of data. The checking facility does not detect 
corrupted individual resources; it bases its tests on the me's resource map. 

When you open a file, ResEdit performs a partial resource check on it. This test verifies only 
that the resource map is located after the end of the resource data area, and that the header, 
data, and map do not extend beyond the EOF of the resource fork. If the file does not pass 
these initial tests, a full test is automatically performed. If you choose "Verify mes when they 
are opened" in the Preferences dialog, ResEdit performs a full test whenever you open a file. 

If you want to invoke the full test yourself, choose Verify Resource File from the File menu. 

In order to perform a full resource check, ResEdit walks through the entire resource map and 
verifies that the type list, the reference lists, and the name list are consistent, that all resource 
data areas can be located, and that they do not exceed the available me size. It also checks for 
duplicate types, and for duplicate ID numbers within each type. ResEdit has several 
techniques for locating the resource map, the existence and location of which is critical to the 
process of recovering damaged resource meso 

If damage is discovered, the user is offered a repair option. This procedure does not change 
the damaged file. Instead, ResEdit creates a new me, extracts all the resources it can fInd in 
the damaged file, and copies them to the new me. It then renames the old file (with an 
extension of "(damaged)". ResEdit also presents the user with status information about the 
resources that were extracted. 

There is one exception to the rule that the damaged me is not "touched" minor damage 
occurs whenever a resource me is not properly closed. ResEdit repairs this damage without 
asking the user's permission. (The actual process involved is quite simple: ResEdit opens the 
me using the Resource Manager, calls the UpdateResFile routine to rewrite the resource 
map, and closes the me.) After performing the repair, it presents an alert to the user. 

Open1ngaIDe 

To list the resource types in a me, select and open the fIlename from the list in the me open 
dialog. If you try to open a me that does not have a resource fork, ResEdit displays a dialog 
box, shown in Figure 2-3, that asks you whether you want to open the me anyway. If you 
permit it to open the me, ResEdit extends the me by creating a resource fork in it. 
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( Add resource fork alert 

the file 'MHose Funny' has no 
resource fort. Opening it will add one. 
Do you wish to open It? 

[ Cancel I OK » 

.. Warning You can edit any file shown in the window, including the System file and 
ResEdit itself, though there are some restrictions (the Finder and the 
Desktop File cannot be opened by ResEdit under MultiFinder™, for 
example). It's dangerous, though, to edit a file that's currently in use. In 
general, it is much wiser to edit a duplicate instead of the me itself. .A 

When you open a me, a file window appears. This window displays a pictorial list of all the 
resource types in that file (See Figure 2-4), unless you choose "by Name" from the View menu 
(See Figure 2-18). If you do choose to view the resource list by name, you can also choose to 
show the total size of each resource type . 

• Figure2-4 A ResEdit 2.0 me window 

~ ~ CJCJ f,:? ~ .... ...... 
• m raIIr 1:-

!iJ ---- ~ ~ ~1i!: 
Jan nil nlII 
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When a file window is the active window, you can create new resource types, copy or delete 
existing resources, and paste resources from other flies. Here, operations are performed on 
sets of resources. For example, selecting the resource type 'ALRT' in a fde causes all resources 
of type 'ALRT' in that file to be selected as a group. Any operation you then petfonn on that 
group affects all 'ALRT' resources in the file. To select more than one resource type, hold 
down the Command key while clicking the individual items or click an item at the beginning 
of the range you want to select, hold down the Shift key, and click the item at the end of the 
range. The Shift key allows you to select the items in a rectangular area. You can then 
continue to select or deselect individual resource types with the Command key. (These 
techniques will also work within an open resource type for selecting individual resources.) 

• Note: Many appUcations put more than one resource type at a time into the scrap when 
Copy is chosen. For example, when an object is copied in MacDra~, an 'MDPL' resource 
and a 'PIer resource are put into the scrap. When you paste into the fde window in 
ResEdi~ all resources that are present are pasted. 

• Note: You can no longer use ResEdit to delete fdes; also, ResEdit does not manipulate or 
read data forks (this means, for example, that it cannot copy them). 
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Menus in ResEdit 

The structure of menus in ResEdit has been changed with the 2.0 release. There are five main 
menus disrussed here (File, Edit, Resource, Window, View), and special menus for particular 
resources that are discussed in the sections on editing those resources, in Chapter 3. 

TheFnemenu 

Figure 2-5 shows the File menu. 

• Figure 2-5 File menu 

Get Info for Finder 
Get File/Folder Info ••• 
Derlty Resource File ••• 

Pege Setup ••• 
Print ••• 

Preference •••• 

liN 
110 

The File menu commands act as follows: 

New ... Brings up the new file dialog box. 

Open ... Brings up the file open dialog box similar to the one shown in Figure 2-2, but 
without a New button. 

Open Special Allows you to open flIes quickly. The Modify This Menu command, which always 
appears at the bottom of the submenu, brings up the dialog box shown in Figure 2-<1, 
which allows you to add and remove files and command keys. 
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Close 

Save 

Revert me 

Closes the currently active window. (Using this command has the same effect as 
clicking the close box.) 

Saves the currently active me, if there is one. 

Restores the currently active me, if there is one, to the last version you saved. 

Get Info for This FUe 
When no me is open this command is gray and cannot be used. When a me is open 
the words -rhis FJ.le" are replaced by the mename, and this command is enabled. It 
displays me information and allows you to change it. (See Figure 2-7.) 

Get FUelFolder Info ... 
Displays file or folder information and allows you to change it Figure 2-7 shows a 
FUe Info window as it appears under system software version 6.0. Figure 2-8 is a 
Folder Info window, also for system software version 6.0. 

Verify Resource File ... 

Page Setup ... 

Print ... 

Preferences ... 

Quit 

Allows you to check the resource map of a me you specify. 

Brings up the page setup dialog box. 

Allows you to print from almost any picker or editor. When no files are open, it is 
gray and cannot be used. 

Brings up the dialog box shown in Figure 2-9. This lets you specify whether you 
want ResEdit to start up with a me open dialog, whether you want to be warned if 
you attempt to open the System file or ResEdit itself, whether you want ResEdit to 
perform a verify opel3tion on mes when you open them, and also allows you to set 
the sizes of type picker and resource picker windows. 

Quits ResEdit and returns to the Finder (or the MPW Shell, HyperCard, or whatever 
program launched ResEdit). 
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( • Figure 2-6 Open Special dialog box 

Files on Open Special menu 

Fa~ade ~ 
Finder 
finder Sounds 
Flash-It 

[ Cancel) 

Rdd File ••• 

Remoue File 

Set cmd key ••• 

[Remoue cmd key) 

I OK ] 

• Figure 2-7 A File Info window 

File 

Type L..-__ ...I 

o System 
DOn Desk 
o Shared 0 No Inits 
o Rlways switch launch 

o Resource map Is read only 0 File Protect 

o Printer drluer Is MultlFlnder compatible 0 File Busy 

Created 3/10/86 3:19:20 PM 0 File Locked 

Modified 8/12/86 2: 16:46 PM 

Size 10855 bytes In resource fork 
o bytes In data fork 
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• Figure 2-8 A Folder Info window 

Folder ~ 

o System 0 Inulsible color:1 Blact 
o On Desk I8J Inlted 

• Figure 2-9 Preferences dialog box 

Preferences 

Window at startup: (j) Open dialog 0 None 

I8J Warning when System or ResEdlt Is opened 

I8J Derlfy flies when they are opened 

Default window size: 
Type pldcen 

Width In plHels: IfliMl 
Height in piHe's: ~ 

(cance.) 
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The Edit menu 

Figure 2-10 shows the Edit menu. It has only one unusual feature, the Select Changed 
command on the last line. This command allows you to select only those items that have been 
changed since the last time you saved the fIle you are working on. 

• Figure 2·10 Edit menu 

.. File" Resoun:e Window Ulew 
Undo :-:Z 

101 The 

1:;:1 
Cut aH 
Copy ac eEl Paste au 
Clear 

[7J Ouplfc<'Ife :-:0 
Select All aA 

CUI. Select Changed 

~ [7J en ~' il 
.IOG »UI. IOD 
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The Resource menu 

The Resource menu is configured to provide the commands appropriate for the frontmost 
window. The same items are always present on the menu, but they have slightly different 
meanings, depending on the context The wording of the iteIm on the menu always tells you 
what they do when you choose them. Figure 2-11 shows the Resource menu with a resource 
type picker open and the 'BNDL' type selected. 

• Figure 2-11 The Resource menu for 'BNDL' 

[1J 
can »AD. am. 

r:J.[1J ~ 
alDG aan -

The Create New Resoun:e command lets you create any resource type. The Open Picker 
command invokes a picker for the particular kind of resource that is selected. This is reflected 
in its name, which includes the name of the selected resource type. At this level, the only 
other command you can use is the Revert Resources command, which takes the resources 
back to the last saved version. If you have made changes in individual resources of the 
selected type since the last time you saved the file, you can undo those changes here. 
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Figure 2-12 shows the Resource menu again, this time with a resource picker open. Note that 
it is now possible to open a resource with a resource editor or template (if one is available) or 
with the hexadecimal editor. 

• Figure 2-12 The Resource menu with a picker open 

• rile Edit .:1' I Window Ulew 
Create New Resource lICK 

The Dwar Open Resource Editor 
JlDI BNDls Open Using Template ••• 

~ Open using HeN Editor 

Reuert This Resource 

[ Get Resource Info IICI 

I 
.1Ir ~ 

Figure 2-13 shows the result of attempting to use the Open Using Template command on a 
'CODE' resource. There is, in fact, no template for resources of this type. It is generally not 
useful to open a resource of one type with a template for a resource of a different type. 

• Figure 2-13 There is no template for 'CODE' resources 

• File Edit .. I Window Ulew 

The Dwarf Banana I 
CODEs from The Dwarf Be 

~ 1M. -
1 1032 
2 21120 Select Template 

[ 3 16712 
4 5388 
5 4 CCut ~ 0 6 3436 clut 
7 3246 cmnu 

I 
8 728 

CNTL i I )1 CTY# OK 
dctb 

"- om ( Cancel 1 
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It is also possible to get information on the selected resource. Figure 2-14 shows the Get Info 
window for a resource of type 'ICN". 11lis dialog lets you change the name and ID number of 
the resoUlte, and select or deselect sorre of its attributes. 

• System Heap: If this attribute is set, the resource is placed in the System heap unless it is 
too large to fit In that ease, the resource is placed in the Application heap, as if the box 
were not checked. 11lis attribute should not be set for an Application's resources. 

• PurgeabJe: If this attribute is set, the resoUite can be purged from menx>ry if nx>re room 
is needed. It is typically a good idea to set this attribute, but there are exceptions. 

• Locked: If this attribute is set, the resource is locked in place in the heap, and cannot be 
nx>ved. 11lis attribute overrides the "Purgeable" attribute. 

• Protected: If this attribute is set, the Resource Manager cannot change the name or ID 
number of the resource, trodify its contents, or remove the resource from the file that 
contains it The Toolbox routine that sets these attributes can be called, however, to unset 
this one. 

• Preload: Setting this attribute causes the ResoUite Manager to load the resource into 
rrenx>ry immediately after opening the resource file. 

• Figure 2-14 An 'ICN" Get Info window 

- t2M SllII 
Neme: 

~ ~ 
Owner type 

& Owner 10: I 1== 1m :I0IO 33+f Sub 10: 

~ C G~ 
Httributes: 
DSystem Heep DLoc:ked DPreloed ,.,., .. 12 ... ImPurge.ble DProtected 

Opening a resource type produces a window that lists each resource of that type in the me. 
The list is generated by a resoUite picker, and will take different forms, depending on the 
particular resource picker that is displaying it The general resource picker displays the 
resources by type, name, ID number, or order in the file; pickers for specific resoUite types 
generate displays that are appropriate for their type. Figure 2-15 shows a picker for the 'ICN" 
resource type. 

You can also write your own pickers. For nx>re information, see Chapter 7. 
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• Figure 2-15 A resource type window (with custom picker) 

Fe~edelcons I 
ICN#s from FelYed 

< 4 l:] @ 
:»12 l29t 1.3111 

& ~ ~ 
I'" - -
~ C G~ 

"""- :tI77 44112 - I-

When a resource type window is the active window, the Edit menu commands have the 
following effects: 

Undo 

Cut 

Copy 

Paste 

Not usable. 

Removes the resources that are selected, placing them in the ResEdit scrap. If only 
one resource is selected, it is placed in the clipboard. 

Copies all the resources that are selected into the ResEdit scrap. If only one resource 
is selected, it is copied to the clipboard. 

Copies the resources from the ResEdit scrap (or from the clipboard) into the resource 
type window. 

• Note: Only resources of the currently open type are copied into the resource type window. 

Clear 

Duplicate 

Removes the resources that are selected without placing them in the ResEdit scrap. 

Creates a duplicate of the selected resources and assigns a unique resource ID 
number to each new resource. 

When you choose Open Using Template from the Resource menu, a list of templates is 
displayed, and you can pick the one you want to use. 
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The Window menu 

The Wmdow menu, shown in Figure 2-16, gives you an overview of what windows are 
currently open, and indicates the currently active window with a checkmark. It also lets you 
select a new current window. Note that the Wmdow menu is sorted not by window depth, 
but by me. 

• Figure 2·16 The Wmdow menu 

.. File Edit Resource I BNDL 
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~ 
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U 
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The View menu 

The View menu is configured to match the frontroost window. When a me window is the 
currently active window, the View menu lets you show the resource types in a file by Icon or 
type name, and if you show them by type, it lets you show the size of each type. O'hat is, the 
sum of the sizes of aU resources within the type.) See Figure 2-17. 

• Figure 2-17 The View menu and a ResEdit 2.0 file window 

• ril. Edit R •• ourc. Window 

;UDE 'j 5J; io 
CRn .. 5'1 
DATA 1 3120 
Dm. 10 2* 
DLOO 10 369 
DREL 1 896 
POND 2 186 
PONT 9 16372 
PRl!F 1 7 
OOBB 1 163 
icW 1 512 
icB 1 102'1 
ICN. I 256 

by Icon 
..... byTyp • 

..... Show Siz. With T p. 

When a resource type window is the currently active window, the View menu lets you choose 
among several viewing styles (see Figure 2-18), and lets you show some attributes for each 
resource when you are viewing by ID, Name, Size, or Order in File (See Figure 2-19). 
Attributes cannot be edited in this view, only displayed. 

For some resources, the "By Special" line that is grayed out in Figure 2-18 is changed to a 
type-specific alternate (for example, "By cien") . Attributes cannot be displayed in the 
special views. 

When an individual resource is open, the View menu is not shown. 
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• Figure 2·18 The View lrenu and a resource type window 

• File Edit Resource Window .m·rn:. 
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• FIgure 2·19 Showing type attributes 
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Starting an editor 

To open an editor for a particular resource in a file, fll'St open the picker for the resource type. 
To do this, either double-click the resource type name or select it and choose Open Picker 
from the Resource menu. (The command will actually name the resource type. For example, 
Open ICON Picker.) Then doubleclick an individual resource, or select it and choose Open 
Resource Editor from the Resource menu. When an editor is invoked, one or more auxiliary 
menus may appear, depending on the type of resource you're editing. Some editors, such as 
the 'Dm' editor, allow you to open additional editors for the elements within the resource. 
The editors vary in their appearance and function, as explained in chapters 3 and 4. 

If you choose Open Using Template from the Resource menu or hold down the Option and 
Command keys while opening a resource, a list of templates is displayed. You may then 
select the template that is appropriate for the resource you are opening. For more information 
on editing with templates, see Chapter 5. 

Resource ID numbers 

Within a given resource type, resource ID numbers must be unique. Resources can, in 
genera~ have any ID number between -32768 and +32767, but you should be aware of the 
following restrictions which apply to most resources: 

• ID numbers from -32768 to -16385 are reserved. Do not use them! 

• ID numbers from -16384 to -1 are used for system resources that are owned by other 
system resources. For example, a dialog box used by a desk accessory (the desk 
accessory is, itself, a resource of type 'DRVR') would have a number in this range. 

• ID numbers from 0 to 127 are used for system resources. 

• ID numbers from 128 to 32767 are available to you for your uses. 

Some system resources own others. The "owner" contains code that reads the "owned" 
resource into memory. For example, desk accessories can have their own patterns, strings, 
and so on. Please see Chapter 5 of Inside Macintosh, Volume I, for more information. 

Fonts constitute a special case. For information about fonts, see the section on 'FONT' 
resources in Chapter 3. 
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Chapter 3 The Bit Editors 

Many important resources on the Macintosh are pictorial. These include 
CUlSOrs, icons, patterns, and fonts. The ResEdit resource editors that handle 
pictorial resources are discussed in this chapter. Other resource editors are 
discussed in Chapter 4. For infonnation on editing template resources, 
please see Chapter 5. 
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Overview of the bit editors 

Pictorial resource types are edited with a bit or pixel editor. The bit editors in ResEdit 2.1 are 
all fundamentally alike except for the 'FONT' editor, which is a special case and is discussed 
separately. 

Figure 3-1 shows the layout of a typical bit editor window. 

• Figure}.l Bit editing window layout 

••• ... • ·11,
• P.d •• 1:-... . 

The bit editor window contains these elements: 

• A tool palette at the left edge of the window. 

• A selector that brings up a tear-off palette of patterns, and (in color editors) another pair 
of selectors, below the tool palette that allow you to select foreground and background 
colors. These bring up tear~ff color palettes. 

• A main editing window that shows an enlarged picture for "fat-bits" editing. The size of 
this window varies from editor to editor. 

• Full-size views of the resoun:e (in monochrome and, when appropriate, in color) and its 
mask (if it has one), to the right of the main editing window. 

• In addition, some of the bit editors have views of the resource against various 
backgrounds, at the right edge of the window. 
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When you open a resource that involves color, the editor window is placed on the display 
with the largest number of colors or gray levels. If you have two monitors, one of which is set 
to black and white and the other is set to sixteen gray levels, the editing window is opened on 
the monitor that can display gray. When you use ResEdit on systems with 24-bit monitors, you 
will probably need to increase the Application Memory size beyond the default 512 KB in 
order to avoid out-of-memory warnings. 

Tools 

The tools in the palette behave as you would expect them to from familiar paint programs, 
with the exception of the color-dropper and the pencil. The color-dropper lets you pick up 
the color of any pixel in the main editing window. 

When you are using other drawing tools (e.g., the paint bucket), you can get the color
dropper by holding down the Option key. This does no~ however, work with the eraser, the 
marquee, or the lasso. 

The middle square on the left side of the tool palette is special, and its content changes from 
editor to editor; in Figure 3-1, which shows the 'erse' editor, it allows you to place the cursor's 
hot spot This is discussed further in the section on cursor editing in this chapter. In some of 
the editors this square is empty. 

When you are editing a colored resource, the pencil tool behaves slightly differently from 
what you might expect if you have only edited in Black & White previously. If you click on a 
pixel in the editing window, that pixel changes to the currently selected color. If it is already 
the currently selected color, it turns white instead. . 

• Note: If you try to paste more bits than there is room for in a resource (for example, if you 
try to paste a 4O-by-40-bit area from a paint program into, say, an 'ICON', which can only 
hold a 32-bY-32-bit area), ResEdit pastes the selection centered into the active area, and 
the boundary of the selection will be outside the active area of the editing window. You 
can shift-<irag to reposition the selection. If a marquee selection is already present in the 
active area when you perform a paste operation, the 'PICI" in the clipboard is scaled into 
the selection. You cannot paste into a lasso selection. 
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Menus 

The bit editolS have two menus in common: Transform, and Color (except for strictly 
monochrome resources, the ediwlS for which do not have a Color menu). Some of the editolS 
also have individual menus, which are discussed in the sections on those resources. 

The Transform menu 

The Transfonn menu is shown in Figure 3-2. It allows you to transfonn selected regions in 
several ways. The FUp Horizontal, FUp Vertical, and Rotate commands are familiar from paint 
programs. The Nudge commands move the selected region by 1 pixel in the indicated 
direction. (You can also nudge the selected region by using the Arrow keys.) FUp and Rotate 
conunands require a rectangular (marquee) selection. 

• Flgure3-2 The Transfonn menu 
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The Color menu 

• Figure 3-3 The Color menu 

po ; File Edit Resource Window Transform I I clcn 
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.... Standard 256 Colon 
Standard 16 Colon 
Standard 16 Grays 
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Heap 0' Grays 
Heap 0' Reds 
Strangebows 
Heap 0' Greens 
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Heap 0' Cyans 
Heap 0' Magentas 
Heap 0' Yellows 
Heap 0' Hues 
Color Picker 

Foreground <-> Background 
&.OS 1-----------1 
7.0_ Recolor Using Palette 

The Color menu is shown in Figure 3-3. It lets you choose anx>ng any available 'clut' or 'pitt' 
resources as well as from a standard set of options. If you have resources of your own that 
you want to use, the ResEdit Preferences file is a good place for them. 

The standard entries on the Color menu include the following: 

Apple Icon Colors Gives you a palette of Apple's recommended colors for icons. 

Recent Colors 

Standard 256 Colors 

Gives you the set of colors that are currently present in the resource. These may 
come from several palettes. This set includes colors that you have chosen since the 
last time you closed the resource but haven't used yet. (When you close a resource, 
unused colors are automatically removed.) 

Gives you the standard 8-bit color palette. 

Standard 16 Colors Gives you the standard 4-bit color palette. 

Standard 16 Grays Gives you 4 bits of gray levels. 

Standard 4 Grays Gives you 2 bits of gray levels. 
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Color Picker Lets you use the standard color picker, with which you can select any of more than 
16 million colors. 

Foreground <-> Background 
Swaps foreground and background colors. 

Recolor Using Palette 
Recolors the resource using the new palette you've chosen. Merely selecting a palette 
does not change any of the colors in the resource you're editing. 

Palette choices are different for Finder Icons. The only color choices available in the 
Finder icon editor are Apple's recommended icon colors, the standard 16<010r (4-bit) palette, 
and the standard 256-color (8-bit) palette. 

• Note: ResEdit automatically rerroves any unused colors from a resource when you close it 

The 'FONT' editor 

The 'FONT editor, discussed in detail later in this chapter, is also a bit editor, but it is older 
and has not been changed; if you need to edit fonts, you should probably use one or more of 
the excellent third-party utilities that are now available. 
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Editing Cursors 

Cursors are pictorial resources of types 'CURS' and 'crse'. Figure 3-4 shows the 'CURS' editor; 
the 'erse' editor is shown twice in Figure 3-3. In each of these editors, the top part of the 
display has a large image for editing and two smaller full-scale images. The upper image 
shows the cursor itself. The lower image is the mask for the cursor, which affects how the 
cursor appears on various backgrounds. The pixel in the editing window that is marked with 
an "X" is the cursor's "hot spot." (The hot spot is the pixel in the cursor that the Macintosh 
recognizes as the cursor's location. The hot spot of the familiar arrow cursor, for example, is 
its point.) There is a special "hot spot" tool on the palette. It is shaped like an "X", as you 
would expect. Click this tool and then click anywhere in the main image in the editing 
window, to place the hot spot. 

In the right edge of the display, the cursor is drawn to scale on five different background 
patterns. To draw the cursor, a hole is made in the background by turning off the pixels in the 
area of the screen covered by the mask. Then the cursor is overlaid on the hole. (Figure 3-5 
shows a pair of explanatory examples.) Ordinarily, the mask should be just a fIlled-in outline 
of the cursor so that the cursor can be seen clearly. To edit the cursor's mask, click on the 
small image labeled "Mask". It is then displayed in the editing window. Initially this image is 
blank; you can drng an upper image to the Mask image to create a mask, or select the mask 
and paste an image into it. 

Notice that the 'CURS' editor does not need (or have) a color-dropper tool. 

• Figure 3-4 'CURS' resource editor 

• 

. ::::~:~:::: .. 
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Figure 3-5 shows two almost identical 'erst' edits. These illustrate the difference between 
pasting the B&W image into the mask (left) and dragging the B&W image to the mask (right). 
As you can see, the cursor on the right is entirely opaque: nowhere does the background 
show through it 

• FIgure 3-5 Color culSOr editing: mask examples 
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The CURS and ersr menus contain the following command: 

Try Pointer Lets you try out your handiwork by having it become the cursor in use 
inside ResEdit, in place of the ordinary arrow cursor. 
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Editing Icons 

ResEdit contains editors for all the coRllIX>n icon resource types. 

Editing 'den' resources 

Ordinary color icons are pictorial resources of type 'den'. Figure 3-6 shows the 'den' editor. 
Please see the inside front cover for a color illustration of the 'den' editor. 

It is possible to transfer images aIOOng the various fraIred images at the right edge of the 'den' 
editor. If you drag across either the color image or the black-and-white image, an outline will 
detach. You can then IOOve that outline to the other image or to the mask. The destination 
highlights to indicate that releasing the mouse button will transfer the image. If you transfer 
the image to the mask, interior bits in the image are set to black. 

• Figure 3-6 Color icon editor 
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CreatIng new color icons 

When you create a new 'den' resource, you get the default set of 16 colors. The color menu, 
shown in Figure 3-6, lets you select other color collections. The most corrunonly used 
collection is Standard 256 Colors, which lets you pick colors from the 8-bit System color table. 
Apple reconunends that you use colors in the standard 16- and 256-color collections and 
specifteally the Apple Icon Colors, as these are typically present when a 'den' icon is drawn. 

The "Icon size" command brin~ up a dialog box that allows you to choose the horizontal and 
vertical sizes of the icon. These sizes are separatej that is, the icon does not have to be a 
square. The minimum for both is 8 pixels, and the maximum is 64. The Delete B&W Icon 
command is only active when the Black and White icon is selected. 

It is possible to create a 'den' resource without a B&W image, but because the system uses the 
B&W image to display the icon on roonitors that are set to black and white or to 4 grays or 
colors, it is probably a good idea to include it. . 

Finder icons 

Finder icons, beginning with system software version 7.0, constitute a suite, or family, of 
pictorial resources. These include srmll and large color icons in 16 and 256 colors (types 'ics4' 
and'iesS' in the small size, 'icl4' and 'icl8' in the larger size) as well as srmll and large 
monochrome icons, now types 'ics#' and the familiar 'ICN#', which is discussed later in this 
chapter. The large icons are 32-by-32 pixels, and effectively share the mask of the 'ICN#' type. 
The small icons are 16-by-16 pixels; they, too, share a corrunon mask, in an 'ics#' resouoce. 

When you use the color~pper, remember that the color selection is tied to the depth of the 
image. That is, if you use the color-dropper to pick up the color of a pixel in, say, the id4 or 
ics4 irmge, this does not change the color selection in the id8 and iesS images (and vice 
versa), nor does it change the ·color" selection (black or white) in the ICN# and iCS# images. 

Opening any of these resoun:es automatically invokes the Finder icon editor and starts the 
subeditor for the particular resource type, provided Color QuickDraw is present. The 'ICN#' 
resource type still has its own individual editor, but is typically edited in the Finder icon editor 
with the other m:rnbers of the suite. (Double-dicking a resouoce of type 'ICN#' opens the 
'ICN#' editor rather than the Finder icon editor if Color QuickDraw is not presen~ or if you 
have installed an 'RMAP' resouoce in the ResEdit Preferences flle to override the Finder Icon 
editor. See Chapter 6 for details.) 

ResEdit 2.1 Reference 



( 

. " , 

( 

Figure 3-7 shows the Finder icon editor during an 'idS' edit The other editing windows are 
quite similar, all of them sharing the tool palette; here, as with the 'den' editor, a monochrome 
illustration cannot fully represent the appearance of a color screen, but should give you some 
idea of the appearance of this editor. Please see the inside front cover for a color illustration 
of the Finder icon editor. 

• Figure 3-7 Finder icon editor 

.. -...'" (~ . • 

When you click one of the eight small pictures labeled with resource type names, that icon is 
opened for editing. Clicking in the display bar on the far right does nothing. This area shows 
the icon in the fonn of three groups of images against the selected background. The groups 
are labeled 'Nonnal', 'Open', and 'Offline'. The display shows the way the icons are drawn by 
the system software version 7.0 Finder. In each group, the icon is shown unselected on the 
left, and selected on the right 

The Icons menu 

The Icons menu is shown in Figure 3-8. It allows you to choose a background for the display 
section at the right edge of the window. The Delete command allows you to delete the icon 
type currently being edited. If a mask is being edited, the Delete command allows you to 
delete the monochrome icon ('ICN#' or 'ies#') that contains the mask. 
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• Figure~ Icons menu 

r ; FIle Edit Resource Window Transform Colors 

o Raku· 10.134 from 0 ..... Whlte Background 

'ICON' resources 

Gray Background 
Black Background 
Desktop Background 

Icons that appear within a program (HypetCard is a good example), are typically resources of 
type 'ICON'. The 'ICON' editor is shown in Figure 3-9. 

• Figure 3-9 'ICON' resource editor 
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( If you cut or copy a marquee selection during editing, you can paste it into a type picker 
window as a 'PIer resource. The 'PIer resource picker does not have to be open when you 
cut, copy, or paste. 

'1CN#' resources 

The 'ICN#' resource is a common target for ResEdit The icons that you see on the desktop in 
system software version 6.0 and earlier, representing applications and their docurrents, are all 
'ICN#' icons, as are folder icons and even the tIashcan. The 'ICNI' resource type is edited 
either in the Finder icon editor, or with its own editor. Both permit you to change any of the 
pixels in the icon, which are in a 32-by-32-pixel square. If you cut or copy a marquee 
selection, you can later paste it as a 'PIer resource: see the description of ' ICON' resource 
editing earlier in this chapter. When you doubleclick a resource of type 'ICNI', the specific 
'ICN#' editor is ordinarily activated only if Color QuickD1'3w is not present,. If you want to edit 
a resource of type 'ICN#' alone and you have Color QuickD1'3w, you need to generate an 
'RMAP' resource in your ResEdit Preferences file to override the normal operation of ResEdit. 
See Chapter 6 for details. 

In system software version 7.0 and later, this icon is part of the Finder icon suite, and is 
typically edited with the Finder icon editor. 

The 'ICN#' editor is shown in Figure 3-10. 

• Figure 3-10 'ICN#' resource editor 
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In recent versions of the Fmr, 'leN#' resources are displayed on the screen as follows: First 
the mask is used to blank an area of the screen. Then an OR operation is performed in the 
same screen area, using the icon as data. (When a highlighted icon is displayed, the 
foreground and background ·colors- (in this case black and white) are swapped ~fore the 
OR operation is performed on the data.) If the mask is not the same shape as the outline of 
the icon, the results will in geneml be unaesthetic unless the background is black. 
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list resources 

Sorre pictorial resoUrtes contain sets or lists of pictures. Together these pictures make up an 
individual resource. Editors for list resources have two kinds of editing regions. The fIrst kind 
is a bit editor, familiar from the editors that have already been described in this chapter. The 
other kind is used to manipulate the elements in the list 

The picture currently being edited is shown in a box as with the other bit editors. To edit a 
different picture, click it in the list on the right You can drag elements to different positions in 
the lis~ you can cu~ copy, and paste elements. If there are more elerrents in the list than will 
fIt in the list display area, the scroll bar is enabled. 

'SICN'resources 

The small icon ('SICN') editor is shown in Figure 3-11. 

You can add a new small-icon picture by chOOSing the Insert New SICN command from the 
Resource menu. Commands on the Edit menu can be used to cu~ copy, paste, clear, or 
duplicate pictures. 

• Figure 3-11 'SICN' resourte editor 
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Editing Patterns 

ResEdit 2.1 includes editors for four kinds of pattern resources: 'PAT' (B&W patterns), 'PATI' 
(B&W pattern lists), 'ppat' (color patterns), and 'ppt#' (color pattern lists). 

Each pattern editor has a menUj the PAT and PAT# menus have only one command: Try 
Pattern. This command lets you use your pattern as the desktop pattern on your screen. 

The ppat and ppt# menus have two commands. The Pattern Size command brings up a 
dialog box, shown in Figure 3-12, that lets you choose the size of the basic cell of your 
pattern. Patterns are replicated or truncated, not scaled. 

The Try Pattern command lets you use your pattern as the desktop pattern on your screen. 
When you are in Try Pattern mode, you can shift back and forth between color and B&W 
versions of the patterns by clicking on their respective pictures in the list area (see Figure 3-15 
or 3-16). 

• Figure 3-12 Pattern Size Dialog Box 
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( 'PAT' resources 

The 'PAT' resource (B&W pattern) editor is shown in Figure 3-13. It displays two panels, with 
the editing area on the left and the pattern shown on the right. The editing area is small, but it 
is possible to make some use of the marquee tool. 

• Figure 3-13 'PAT' resource editor 

-
'PATI'resources 

The 'PATI' resource (B&W pattern list) editor is much like the lSIeN' editor; it is shown in 
Figure 3-14. 

• Figure 3-14 'PATI' resource editor 

-
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'ppat' resources 

The 'ppat' resource (color pattern) editor is shown in Figure 3-15. 

The B&W pattern is limited to 8-x-8 pixels, and cannot be resized, though it can be edited. It 
is displayed on the right edge of the editor window, and is automatically sized to match the 
color display above it. Unless your color pattern is also 8 pixels square, the B&W pattern 
probably won't look quite like it, as is evident in Figure 3-15. 

• FIgure 3-15 'ppat' resource editor 

'pptl' resources 

e! 
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The 'ppt#' resource (color pattern list) editor is shown in Figure 3-16 There are three displays 
in this editor. The display on the left is a color (or B&W) fat-bits version for editing. The 
display in the middle shows the resulting pattern at full scale, both in color and in B&W. The 
B&W pattern is sized to match the Color pattern. The display on the right is the list area. 
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• FIgure 3-16 'ppt#' resource editor 
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FONT resources 

The 'FONT' resource is one of two major ways of representing bitmap (screen) fonts for the 
Macintosh. (The 'NFNr resource, desaibed briefly later in this section, is the other.) The 
'FONT' resource contains a series of pictures that typically represent items in the Macintosh 
character set, though they need not do so. A chart of the Macintosh character set is presented 
in Appendix D. 

Because the Macintosh displays a character of type on its screen as a bitmap, however, it is 
possible for the pictures to be just that-pictures. 'FONT' resources on the Macintosh can 
contain scanned images and other pictures just as easily as they can contain the alphabet, 
numerals, and punctuation marks. 

The Macintosh can modify elements of a font-for example, it can boldface them, or slant 
them for an approximation of italics. Print quality on dot-matrix printers (and screen~isplay 
accuracy as well) can be improved, however, by providing extra fonts that are constructed 
with those styles built into them 'FONT' resources typically come in families, so that it is 
possible to display text on the screen (and print it on dot-matrix printers) in several styles, 
most commonly roman, bold, italic, and a bold-italic combination, without taking processor 
time to calculate the way such styles should look. These families can also correspond to 
downloadable PostScript fonts for laser printers and typesetters. 

If you use ResEdit to examine a Fonts fde from a recent Macintosh system software version, 
you will find that it contains three kinds of resources: 'FOND' 'FONT', and 'vers' (a record of 
the version number of the release). The 'FOND' resource ·owns" one or rmre sizes of a 
particular font and contains kerning tables and other important information about the 'FONT' 
resources it owns. The 'FOND' resource has a unique ID number, from which the ID numbers 
of its subsidiary 'FONT's are calculated. To find the ID number of a particular 'FONT' 
resource, take the ID number of the parent 'FOND', multiply by 128, and add the point size of 
the 'FONT'. For example, 'FONT' 10 268 corresponds to New York (family ID 2), in 
12 point size. 

The ID numbers of 'FOND' resources may be from 0 (Chicago, the default System fonO to 255, 
inclusive. Apple reserves ID numbers from 0 through 127. Unfortunately, there are a great 
many bitmap fonts (vastly more, in fact, than 255 of them), so occasional ID number colUsions 
are unavoidable. Version 3.8 and later versions of the FontlDA Mover attempt to resolve such 
collisions, as do some third-party system-enhancer packages. 
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( There is also another, newer kind of font resource, type 'NFNT'. like 'FONT' resources, 
'NFNT' resources are also owned by 'FOND' resources. ID numbering of 'NFNT' fonts is, 
however, not keyed to the ID number of the parent 'FOND'. Arbitrary numbering of 'NFNT' 
resources helps avoid font ID number collisions and facilitates resolution of conflicts when 
they do occur. 'NFNT' fonts, moreover, can contain and display more than 1 bit per pixel and 
can be assigned absolute colors with a corresponding 'fctb' resource, which is a Colotfable 
record. (Font Colotfable records are discussed in Inside Macintosh, Volume V, in the section 
on the Color Manager. The Font Manager is discussed in some detail in Inside MaCintosh, 
Volumes IV and V.) ResEdit cannot edit 'NFNT' fonts, but it can copy and move them, as can 
version 3.8 and later versions of the FontiDA Mover. A third-party editor for 'NFNT' fonts is 
available. 

Editing 'FONT' resources 

Fonts are edited with a bit editor that is a superset of the bit editors for other pictorial 
resources. This editor has several of the tools you are probably familiar with from program; 
like MacPaint 

The editing window for 'FONT' resources is divided into four panels: a character-editing 
panel, a sample text panel, a character-selection panel, and a typical set of graphics tools. 
These panels are shown in Figure 3-17. 

• Figure 3-17 'FONT' resource editor 
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Beauty Is momentary in the 
mind - I The fitfUl tracing of a 
portal I But in the flesh It Is 
immortal. 

- Wallace Stevens 
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The character-edutng panel, on the left side of the window, shows an enlargement of the 
selected character. You can edit it, as with the other bit editors for pictorial resources, by 
clicking bi~ on and off. Drag the black triangles at the bottom of the character-editing panel 
to set the left and right bounds of the character (that is, the character width). Two of the three 
triangles at the left side of the panel control the ascent and descent of characters in the font. If 
you want to increase the ascent or descent, move the appropriate triangle first If yo~ put 
pixels outside the indicated area and then move the triangle, those pixels are wiped out. 

Changing the ascent or descent of a character changes the ascent or 
descent for the entire font • 

The third triangle on the left shows the location of the baseline, which is fIXed and is 
displayed only for reference. Below the panel are the character number (labeled" ASCll"), and 
the character's offset, width, and location, all in decimal notation. 

• Note: The correspondence between the Macintosh character set number and a real ASCII 
number is limited. Strictly speaking, ASCII is a set of 128 characters, numbered from 00 
($00, the NUll character) through 127 ($7F, the DEL character), and is intended to 
represent a basic character set rather than any font or typeface, in a relatively universally 
understood fonn. Because the Macintosh character set is oriented toward electronic 
publishing, which has more (and different) requiremen~, it has twice as many possible 
character numbers. (See the section on the 'KCHR' editor later in this chapter.) For 
ordinary text fon~, characters 0 through 127 of a Macintosh font are the ASCII character 
set For Symbo~ ITC Zapf Dingba~', and the various pictorial fon~, however, the 
correspondence with the ASCII character set is minimal. The Macintosh character set is 
shown in Appendix D. 

The sample text pane~ at the upper right, displays a sample of text in the font currently being 
edited. (You can change this text by clicking in the text panel and using normal Macintosh 
editing techniques.) 

The character-selection panel is below the text panel. You can select a character to edit by 
typing it (using the Shift and Option keys if necessary), or by clicking it in the row of three 
characters shown. To move upward through the character number range, click the right 
character in the row; to move downward, dick the left character. The character you select is 
boxed in the center of the row. (To scroll quickly, click the right or left character and drag the 
pointer ou~ide the selection panel, to the right or left.) 
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( The graphics tools panel, directly below the character-selection panel, offers several familiar 
graphi~-manipulation tools, including the pendl, eraser, docles, and rectangles. The 'FONT 
editor, unlike the other bit editors, includes the marquee tool as a panel selection, and the 
lasso is also available. 

Any changes you make in the character-editing panel are reflected in the text panel and the 
character-selection panel, except on roonitors displaying more than 2 colors or gray levels. 

You can also change the name of a fonl The font name is stored in two places: as the name 
of the 'FOND' resource of that font family, and as the name of the size 0 'FONT resource. To 
change the font name, select the individual 'FOND' resouoce with the name you wish to 
change, and choose Get Info from the File menu. To maintain consistency, you should also 
change the name of the 0 point 'FONT resouoce. This resoun:e does not show up in the 
nonnaI display of all fonts in a me. To display it, hold down the Option key while you open 
the 'FONT type from the me window. You will see a generic list of fonts. Select the font with 
the name you wish to change, and choose Get Info. 
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Chapter 4 Other Resources 

Som: of the ResEdit resource editors are discussed in this chapter. The use 
of the editors not discussed here should be apparent when you run them. 
For information on editing template resoUItes, please see Chapter 5. 

SY24190 
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Using the hexadecimal editor 

The hexadecimal resource editor is invoked if you hold down the Option key while opening 
a resource or choose Open Using Hex Editor from the Resource menu. This editor allows you 
to edit the resource as hexadecimal or ASCII data. The hex editor can edit resources larger 
than 255 KB. If a resource is between 256 KB and 511KB in size, each click in the up or down 
scroll arrow scrolls two lines; if between 512 KB and 767 KB, each click scrolls three lines, 
and so on. (The scroll bars keep tIack of position with an integer, which is a single byte, and 
thus is limited to values between 0 and 255.) 

If you enter hexadecimal text when you are using this editor, the editor maintains byte 
alignment of the incoming data. Thus, if you type 2 into an empty byte, the editor displays 
02. If you then type A, the editor displays 2A. 

The hex editor has a Search menu. It allows you to search for the occurrence of a pattern in 
the resource being displayed and allows you to enter the pattern in either hexadecimal or 
Macintosh character set notation, the latter being loosely described as ASCII, though it is 
actually considerably larger than the true ASQI set. See Appendix D for a chart of the 
Macintosh character set The hex editor also allows you to move to a specified offset from the 
beginning of the resource you're editing. 
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'WIND', 'ALRT',' and 'DLOG' resources 

'WIND' resources display windows on the screen. Figure 4-1 shows the 'WIND' resource 
editor. At the top of the editing window is a pictorial list of the different window styles, from 
which you can choose. Below that is a MiniScreen in which is displayed a small picture of the 
window. You can move and size the window in the MiniScreen. The MiniScreen menu, 
shown in Figure 4-10, lets you choose the size of monitor you want the MiniScreen to 
simulate. It defaults to Mac SE. At the bottom are numeric values (given in pixels) for the 
positions of the edges of the window; these give you another way of changing the window's 
size and position. On the right side are radio buttons that allow you to choose between 
default and custom color, and checkboxes to let you declare the window to be visible when it 
is first drawn, and for the presence of a closebox. 

In Figure 4-1, Custom Color has been selected, and controls that allow you to choose colors 
for various parts of the window are visible. When you choose custom color, ResEdit creates a 
'wctb' resource that corresponds to the 'WIND', 'ALRT', or 'OLOG' you are editing. The first 
tirre you do this in a particular fIle, ResEdit prompts you to rerrember that you are creating a 
new resource, and that if you reIIX>ve the parent resource you should remember to remove 
the extra 'wctb' that is left behind. 

'ALRT' and 'OLOG' resoUltes display, respectively, alert and dialog boxes. Editing 'ALRT ' and 
'OLOG' resources is much like editing 'WIND' resources, except that the corresponding 'om' 
resource is automatically opened if you double-click on the picture of the alert or dialog box 
after opening the resource. (See the next section.) You can choose a particular 'om' to go 
with a given 'ALRT' or 'OLOG', but the default is one that has the same 10 number as the 
parent resource. 'ALRT' resources have a fIXed fonna~ so you don't get to choose a window 
type, nor do you have the options of selecting initial visibility or the presence of a closebox. 
'OLOG' resources do allow you these options. 

Figure 4-4 shows an 'ALRT' open for editing. Just as with the 'WIND' example, the editor 
displays a MiniScreen view of the resource. 

• Note: The first item in the 'om' associated with any 'ALRT' must be a button. The system 
has no way of telling what is where, so it always regards the first item as a button. In the 
alternate view of the 'ALRT', you can specify either item 1 or item 2 as the default. If item 
1 is the defaul~ of course, item 2 need not be a button. There is an informal convention in 
Macintosh programming that item 1 is the "OK- button, and item 2 is the cancel button if 
there is a cancel button. 
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When you display an individual 'WIND', 'ALRT', or'DLOG' resource, a corresponding menu 
appealS. The WIND menu is shown in Figure 4-2, the ALRT menu in Figure 4-5, and the 
DLOG menu in Figure 4-8. These menus are very sinillar. 

·The have the following commands in common: 

Preview at Full Size 

Auto Position 

Displays the resoun:e sized as it is in normal display, though not necessarily 
positioned correctly. 

Allows you to let ResEdit position the resoun:e. 

Show Height & Width 
Shows relative size/position information. 

Show Bottom & Right 

Use Color Picker 

• Figure4-l 

Shows absolute size/position infonnation. 

Lets you use the Color Picker instead of the standald 256-color palette when you set 
the cololS of the various parts of the resoun:e. 

'WIND' resource editor 

Content: D frame:. 

Title teHt: • Highlight: D 
Title bar: • 

Top: lin I BoUom: ~ 

Left: ~ Right: ~ 

I8I1nltl811y ulslble 

181 Close baH 
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( • FJgure4-2 WINDrrenu 
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Set 'WINO' Ch.raeteriltle •••• 
Preulew .t Full Size 
Auto POlltlon ••• 

..... Neuer Use Custom 'WOEF' for Drawing 

..... Show Height It Width 
Show Bottom It Right 

Use Color Pie leer 

The WIND rrenu contains the fonowing commands: 

Set 'WIND' Characteristics 
Brings up a dialog box, shown in Figure 4-4, that allows you to title the window and 
set its refCon and ProcID. 

Never use custom 'WDEF for drawing 
This command defaults to true. It causes the resource to be drawn with the standard 
'WDEF from the System file . 

• Flgure4-3 Setting 'WIND' characteristics 

'WIND' Characteristics 

Window title: I Night Scented StoCIe 

ref Can: L,,;lo ___ --' 

Prod 0: L,,;18;..... __ --' 

Cancel I OK I 
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• FJgure4-4 'ALRT ' resource editor 
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• Flgure4-S ALRTrrenu 
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The ALRT rrenu contains the following conunand: 

Set 'ALRT' Stage Info 
Brings up a dialog box, shown in Figure 4-6, that allows you to set the display 
conditions for the resource at different stages, You can choose the number of beeps 
you wan~ up to threej whether the OK or Cancel button is the default; and whether 
the Alert box is to be drawn for each stage. The stages correspond to successive 
occurrences of the alert condition, though stage 4 is for 4 or more occurrences. 
Please see Inside Macintosh, Volume I, page 409 for further information. 
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• Figure 4-6 'ALRT 'Stage Info dialog box 

'ALRT Sll1gel 
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• Figure 4-7 'DLOG ' resource editor 
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• Figure4-8 DLOGmenu 
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The DLOG menu contains the following commands: 

Set'DLOG' Characteristics 
Brings up a dialog box, shown in Figure 4-9, that allows you to title the resource, and 
to set its refCon and ProeID. 

Never use custom 'WDEF for drawing 

• FIgure 4--9 

This command defaults to true. It causes the resource to be drawn with the standard 
'WDEF from the System ftle. 

setting 'DLOG' characteristics 

'OL06' Chancteristlcs 

Window title: 1 This Is the 88C •• ~ 

ref Con: .... 10 ___ __ 
ProtlD: .... 11 ___ __ 

( Concel I OK I 
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• Figure 4-10 MiniScreen menu 

- Mac Portable 

There are four special items that you can put into static text in a 'om' item or into a 'STR#' 
resource. They are built of a caret (") followed by a number from 0 to 3. Each of these refers 
to one of the items in a global array named OAStrings, maintained by the ~ialog Manager. An 
occurrence of one of these causes the contents of the corresponding entry in that array to be 
substituted via a ParamTe::d call when the resource is displayed. An example of a 'om' with 
these items is shown in Figure 4-11, with one of the items open for editing to show the 
special strings it contains. Please see Inside Macintosh, Volume 1, page 421 for further 
information. 

• Figure 4-11 Special parameter strings 
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'Dm' resources 

The 'om' (dialog item list) resource editor can be invoked directly or from the 'WIND', ALRT 
" and 'OLOG' editor. When you first invoke it, it displays an image of the items from the list 
just as they would be displayed in a dialog or alert box. When you select an item, it is drawn 
with an enclosing rectangle that has a size box appears in its lower-right corner so that you 
can change its size. You can IOOve an item by dragging it with the mouse. 

To create a new item, drag the type you want from the item palette. 

If you open an item within the dialog box, the item editor, shown in Figure 4-12, is invoked. If 
you hold down the Option key while opening a 'CNTL', 'ICON', or 'PIer, the hexadecimal 
editor is invoked. If you hold down the Option and Command keys, the items are drawn with 
solid borders, and their item numbers are displayed. Some dialog items are not editable and 
are listed as User Items. These are defined in the application, rather than in the Oialog 
Manager, and are actually built only when you run the application. 

Because they are linked, the 'om' resource is usually given the same ID number as the 
parent 'OLOG' or 'ALRT'. This is not necessary, however, and you can assign any 'om' 
resource to any 'ALRT' or'OLOG'. 

Figure 4-12 shows the 'om' corresponding to the 'ALRT' from Figure 4-4. Both items in the 
'om' have been selected, and are shown surrounded by dashed borders, 

• Figure 4-12 'om' resource editor 
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60 ResEdit 2.1 Reference 

ijii;'oiij"'j'hiiue's,iire'reii'uneiipecie1l] 
Error. Now I must go away from i 
!you. perhaps neuer to returnll i 
\,: ............................................................. " 

rs'o"iie'rjj'sorr~ ................................. 



( 

( 

The individual item editor, shown in Figure 4-13, has one popup menu, which allows you to 
change the type of the item. 

• Figure 4-13 

Button 
Checlc: BOH 

Radio Button 
Control 
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Icon 
Picture 
User Item 
Help Item 
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• Figure 4-14 om menu 

Top: ~ HeIght: EJ 
Left: EJ Width: ~ 

Rlign To Grid 
Grid Seltings ••• 

Show RII Items 
Use l1err"~ np.I:1clllgJe 

The om menu, shown in Figure 4-14, contains the following commands: 

Renumber Items Allows you to renumber items in the 'om'. Remember that item number 1 must be a 
button. 
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Set Item Number Allows you to specify a new number for a selected item. 

Select Item NumberAllows you to select an item by specifying its number. 

Show Item Numbers Sets the display to show the number of each item in the 'om'. 

Nign to Grid Aligns the item on an invisible grid, the size of which defaults to 1Ox10 pixels. If you 
change the item location while Align to Grid is on, the location is adjusted such that 
the upper-left comer lies on the nearest grid point to the location you gave it If you 
change the item size, it is constrained to be a multiple of the current grid setting in 
each dimension. 

Grid Settings Allows you to set the horizontal and vertical grid quantizations. These both default to 
10 pixels. 

Show All Items Adjusts the window size so that all items in the item list are visible in the window. 
The window size that your program will use when it displays the 'om' is actually 
sto.red in the parent 'ALRT' or 'OLOG' resource; this command is present solely for 
your convenience when you are editing the dialog items. 

Use item's rectangle When enabled, this probably lets you use the rectangle specified by the 'DITL' 
item itself, rather than some rectangle from space. I have not yet seen it enabled, 
however, so I can't figure it out 

View As Brings up a dialog box, shown in Figure 4-15, that allows you to set the typeface and 
size in which textual items are displayed in the editor. As you can see from the 
figure, it does not actually change the resource itself. 

Balloon Help Connects you unambiguously with The Future of Apple Computer. Congratulations! 
Now, when we get around to releasing The Future, it will be ... the future. 

• Figure 4-15 om menu View As dialog box 

·Uiew Rs· only changes the font 
and size when uiewed. It does 
not modify any resources. 

Font:l Chicago 

Size: I 12 "'1 
( Cancel) , OK J 
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( Font and Size menus are also present These menus are provided to allow you to see how 
your 'om' looks when displayed in various typestyles. The font and size you set by using 
these menus are not saved, and must be reset each time you edit the 'om'. 
Figure 4-16 shows the Alignment menu. In this illustration, both of the items in the 'om' have 
been selected. 

• Figure 4-16 Alignment menu 

fii5 Align Top Edges 
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The flfSt six items are only enabled when two or more items are selected. The last two items 
may pertain to one or more items at a time. Use of all of these items is straightforward. 
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'BNDL' resources 

To date, 'BNDL' resources have been mysterious, opaque, and difficult to learn about 

For historical reasons they have a fairly complex set of concepts behind them, but in fact, the 
only thing they do is bring together an application's documents (including the application me 
itself) and their icons for the Fmder. Any application that has a distinct icon on the desktop 
also contains a 'BNDL' resource. For more details on the structure and concept of the 'BNDL' 
resource itself, please refer to Appendix C, "The 'BNDL' Resource." 

The 'BNDL' editor in ResEdit 2.0 helps you create a bundle consisting of the necessary 'BNDL', 
'PREP and FInder icon resources, and saves you the burden of dealing with the internal 
workings of the bundle concept The basic view you get when you flCSt bring up the 'BNDL' 
editor is shown in Figure 4-17. The window appears in the display with the largest available 
number of gray levels or colors. (This is also true of the extended view, shown 
in Figure 4-19.) 

• Figure 4-17 'BNDL' resource editor, simple view 

TeochTeHt 1.2 

The Finder bundles together documents, applications and their icons with a 4 character 
signature, which must be unique for every application. All the necessary resources to do this 
are stored in the so-called Desktop file (or in the desktop database in system software version 
7.0). This signature is shown in the first line of the window. All characters in the Macintosh 
character set (see Appendix D) are allowed in the signature. In order to register a unique 
signature for your own application, please contact Macintosh Developer Technical Support 
at Apple. 
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( This signature is used as the creator code for all flIes that are part of the bundle (the creator 
code is a property of every flIe and can be set USing the Get FileIFolder Info command on the 
File menu). Every file on the Madntosh also has a file type, which is another 4 character field 
(several standard flIe types are defmed: APPL for application, TEXI' for plain text docurnen~ 
PIef for picture flIes, etc.). This flIe type is not only used to differentiate between different 
kinds of flles but is also used to associate distinct icons with different flIes having the same 
creator (i.e. belonging to the same application). This is what the list in the bottom part of the 
'BNDL' editor window does. In order to create a new flIe type and its icon, select Create New 
File Type from the Resource menu. Enter the flIe type in the left column and open the Finder 
Icon field in the right column by selecting Choose Icon from the BNDL menu or by double
clicking on the field. 

Figure 4-18 shows the Icon chooser. Here you can either choose an existing icon for your file 
type, or you can create your own by pressing the KNew" button. Note that even though the 
'BNDL' editor shows the entire Finder icon family, because of screen real estate considerations 
you will only see a list of'ICNI' resources in this window. 

• Figure 4-18 The Icon chooser 

• File Edit Resource Window .II~"'-
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Once you have associated all your file types with distinct icons (remember to include the flIe 
type APPL for your application itselO there are only a few more steps necessary in order to 
make the Finder display your icons. 
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Select the Get FUe/Folder Info command from the File menu and choose your application in 
the upcoming list of files. Now set the file type to APPL and the creator to the signature you 
have entered in the 'BNDL' resource. Then set the Bundle bit and dear the Inited bit This tells 
the Finder that your application contains a 'BNDL' resource and that it hasn't already seen 
your me. If the Ftnder doesn't immediately show your new iCOn, select your application and 
use the Get Info command in the Finder. 

• Note: Once the Finder has seen your 'BNDL' resource and loaded the icons into its 
Desktop me, it will never again look at your 'BNDL', even if you clear the Inited bit. 
In order to change the 'BNDL' resource or to change some icons, you will need to remove 
your 'BNDL' resource from the Desktop ftle manually using ResEdit (this works, but is not 
recommended), or to recreate the Desktop me. To do this, hold down the Option and 
Command keys while restarting your Macintosh. The Finder will then ask you if you want 
to rebuild the Desktop ftle. Remember that when you do this, you lose all comments. you 
may have entered in the Get Info windows in the Finder in system software previous to 
system software version 7.0. 

If you want to move information contained in the 'BNDL' resource from one file to another 
you can do so by using the commands on the Edit menu. For copying operations, all 
necessary information (including the Finder Icons) is copied with the ftle type. If you clear or 
cut a me type in the 'BNDL' resource, please note that for safety reasons the Finder Icons are 
not removed (beautiful icons are so hard to design, it is generally considered better to waste a 
few bytes than acddentally kill one). 

Should you ever have need to tinker with the internal workings of the 'BNDL' resource, you 
can edit all information stored in the 'BNDL' and assodated 'PREP resources by selecting 
Extended View from the BNDL menu. See Figure 4-19. 
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• Figure 4-19 'BNDL' resource editor, Extended view 

• File Edit Resource Window BNOL 
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For historical reasons the third line of the extended view, which displays the contents of the 
signature resouIte, is labeled -e string". This is because in the days before the introduction of 
the Ivers' resource to keep track of version information, the signature resource was used to 
store such information. Today the contents of the signature resouIte are ignored by the 
Finder unless the Ivers' resoUItes are missing. In this case the Finder displays the contents in 
its Get Info window. The Ivers' resource and its editor are described in detaU in this chapter. 
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'elut' and 'pItt' resources 

The 'clut' (color lookup table) and 'pitt' (palette) resources are used to store color and 
gmyscale information. They are largely interchangeable, but the 'pItt' resource contains a 
Usage command in addition to the information contained in a corresponding 'clut' resource. 
Palettes are associated with windows. For more information, see the Palette Manager and 
Color Manager chapters in Inside Macintosh, volume V. ResEdit 2.1 includes an editor for 
'clut' and 'pItt' resources, shown in its 'clut' disguise in Figure 4-20. 

• Figure 4-20 'clut' resource editor 
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The clut menu, shown in Figure 4-21, contains the following commands: 

Blend 

Complement 

lDadColors 

RGBModel 

CMYModel 

HSBModel 

HIS Model 

Generates a ramp or blend between the endpoints of a selected range of colors. If 
only three color patches are selected, the middle color will be set to a value halfway 
between the extremes. If fewer than three color patches are selected, this command 
is gray and cannot be used. 

Allows you to specify a new number for a selected item. 

Brings up a dialog box that allows you to load colors and gray levels from the 
available palettes and tables. These include the standard 8-bit (256-color) set, the 
standard 4-bit set, B&W, Apple's recommended colors for icons, and any others that 
are available in the ResEdit Preferences me or in any other flles you have open. 

These commands allow you to select from one of four models for handling colors. 
The models are: 

RGB: RedlGreenIBlue 
CMY: CyaniMagentalYellow 
HSB: Hue/SaturationlBrightness 
HIS: HuelLightnessiSaturation 

RGB is the default model. 

The sort menu (not shown) allows you to sort by any of the three criteria of the current 
model. That is, if you are using the RGB model, it lets you sort by amount of red, green, or 
blue. 

The background menu (not shown) lets you choose white, gray, or black as the background 
for the area of the editing window where there are no color patches. 
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'INTL', 'idO', and 'idl' resources 

The 'INTI.' resource combines the functionality of the 'idO' and'id1' resources. That is, 'INTL' 
"US" ID - 0 is the same as 'idO' "US" ID - 0 and 'INTI' ·US" ID • 1 is the sarre as 'idl' "US" ID 1 

- O. These resources are ~ in international localization. For further infonnation, see Inside 
Macintosh, Volume V, Chapter 16. Each of these resources (whether you edit them as 'INTL' 
or as 'ittO' and 'id1') is shown as a window with a set of boxes to be filled in and some buttons 
that can be clicked Figures 4-22 and 4-23 show the windows for 'ittO' and 'itt1'. 

• Figure 4-22 Editing an 'ittO' resource 
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( • Figure 4-23 Editing an 'idl' resource 
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'Kom' resources 

The 'KCHR' resoutte controls keyboard mapping. The 'KOIR' editor can be used with any 
Macintosh that runs system software version 5.0 or later. The main 'KCHR' editing saeen is 
shown in Figure 4-24, with Conumnd-option-3 pressed; the dead key editor is shown in 
Figure 4-25. Appendix A contains an in-depth discussion of the 'KCHR' resource itself, and a 
short section of 'KCHR' questions and answers appears in Chapter 6. 

• Figure 4-24 Editing a 'KCHR' resoutte 

- - -- -- --=--=------- =---- =- - ~==------=-=-

The main 'KaIR' editor 

The display for the main 'KCHR' editor (Figure 4-24) is divided into flVe parts, which are 
described in the sections that follow. 
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The character chart 

This chart shows the 256 charactelS that make up the currently selected font It displays the 
chalacter generated by the currently pressed key, by highlighting it You can also display a 
character by clicking with the mouse in either the keyboard region or the virtual keycode 
chart These charactelS can be assigned to keys on the keyboard. To assign a character to a 
key, drag the character either to a keycap in the keyboard region or to the virtual keycode 
chart You cannot assign charactelS to the Command, Option, Shift, Caps Lock, Control, 
Return, or Enter keys. 

The table chart 

The Shift, Caps Lock, Option, Command, and Control keys are considered to be 8modifielS"j 
no combination of modifier keys generates a character code unless some other key is also 
pressed. The table chart shows which table is used by the currently depressed modifier 
key combination. 

Please note that although there are 256 possible combinations of modifier keys, most versions 
of the 'KCHR' resource use only 8 tables, and very few ever use IOOre than 16. This is because 
similar modifier key combinations are frequently mapped to the same table. For example, in 
the U.S. 'KCHR', all combinations involving the Control key point to Table 6. Also, the Caps 
Lock and Shift combination points to Table 1 (which is pointed to by the Shift key) rather than 
Table 2 (which is pointed to by the Caps Lock key on its own). 

To change the table used by a modifier key combination, press that combination of modifier 
keys and click on a different table. The mapping is changed by the editor. This feature is 
probably of very little use, and the infonnation is included here for completeness. Here is a 
listing of the tables as they are pointed to by various modifier key combinations in the U.S. 
'KCHR', as supplied: 

• Table 0 is shown with none of the modifier keys pressed, or with the Command key or 
Command and Shift keys pressed. 

• Table 1 is shown with the Shift key or Caps Lock and Shift keys pressed. 

• Table 2 is shown with the Caps Lock key pressed. 

• Table 3 is shown with the Option key pressed. 

• Table 4 is shown with Shift and Option keys pressed. 

• Table 5 is shown with Caps Lock and Option keys pressed. 

• Table 6 is shown with Option and Command keys pressed. 

• Table 7 is shown with the Control key (and any other keys) pressed. 
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The virtual keycode chart 

This chart shows aU 128 keycodes in the current table, and highlights the keycode that is 
generated if you press a particular key with the current modifier key combination. These 
keycodes come from the keyboard, and are virtual in the sense that further translation has to 
take place before a Macintosh character set number results and a character can 
be displayed. 

The keyboard region 

This area reflects a particular keyboard layout You can choose a different keyboard for 
displaying the virtual keycodes by using the View As command on the KOIR menu. The 
ApplelBl Extended Keyboard and Extended Keyboard n have two sets of modifier keys, and 
you can use the Uncouple Modifier Keys command, also on the KOIR menu, to get access to 
the alternate roodifler keys (the ones on the right side of the keyboard, which are usually 
coupled with the ones on the left side). If you do not have the Apple Extended Keyboard or 
Extended Keyboard II connected to your Macintosh, you cannot choose the Uncouple 
Modifier Keys command. 

Note that the modifier keys shown in the keyboard picture have a gray border. This border 
has two purposes: 

• It reminds you that you cannot drag a character from the character chart onto a 
roodifler key. 

• It helps you fmd the modifier keys in the virtual keycode chart (They have a gray border 
there, too.) 

Note also that if you press the Option key, some keys in the display are shown with solid 
black borders. These are "dead" keys. If you click a dead key, the special editor for dead keys 
is invoked. For more information on editing dead keys, see "Editing Dead Keys," later in 
this chapter. 

Theuuonnatlonregion 

This small chart shows you the character code and virtual keycode, both in hexadecimal fonn. 
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( Editing dead keys 

Some combinations of keys do not immediately specify a character. Because nothing appears 
on the screen and the cwsor does not move when these combinations are pressed, they are 
called -dead" keys. Typically they act to modify the next key that is pressed after the dead key 
is released. The special editor for dead keys is shown in Figure 4-25. 

• Figure 4-25 Editing a dead key 

The dead-key editor 

The display for the dead-key editor is divided into five functional sections. 

The character chart 

This chart displays the character codes and is used to assign a different character code to 
either a completion character, a substitution character, or the no match character; you assign a 
code by dragging the character to its new location. If you drag a character to one of the empty 
slots (displayed in gray) in the completion and substitution character pair list, you 
automatically add a new pair. 
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The nomatch cbatader 

If the character typed after the dead key doesn't fit, a nomatch character is displayed, 
followed by the character you have typed. For example, Option-E must be followed by a 
vowe~ it doesn't make much sense to put an accent mark on a It The nomatch character for· 
the current dead key is shown in the upper-right comer of the window. 

The completion and substitution character pair list 

This list shows the translation rules for the dead key that is currently selected. There are two 
columns, allowing for a total of 32 dead keys. The left half of each column shows all 
completion characters; the right half shows aU substitution characters. If the character typed 
after the dead key is one of the completion chatacters, the matching substitution character is 
actually produced. For example, pressing Option-e and then e produces the character e. 

The Trash 

To re1IX>ve a completion/substitution chatacter pair, just drag either character from that pair in 
the completion/substitution pair list to the ttashcan in the lower-right comer of 
the window. 

The information region 

This area contains the chatacter code in hexadecimal f01lIl whenever you click one of the 
other parts of the editor. It is on the right edge of the window, and contains the word ·Char:". 

The menus 

The 'KCHR' editor has three menus: KCHR, Font, and Size. 

The KOIR menu 

This menu is shown in Figure 4-26. 
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• Figure 4-26 The KCRR menu 
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The KCRR menu contains the following commands. 

View As ... If you have the Key Layout me (which has been part of the system software since 
version 4.2) in your System Folder, you'll be presented with a list of keyboards to be 
used for displaying the virtual keycodes. Note that you are not changing the layout of 
a particular keyboard, but the 'KCRR' resource that is used by all keyboards and is 
based on the ISO (International Standards Organization) ADB keyboard. 

Uncouple Modifier Keys 
This command is enabled when you have an ADB extended keyboard connected to 
your computer. It can be used to uncouple the right modifier keys (see note above) 
and thus edit the tables used by them. Please note that the 'KCHR' editor 
automatically recouples them whenever you bring another window to the front or 
close the editor. 
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• Note: When you select the Uncouple Modifier Keys command, you must also use the View 
As command to set the current keyboard to a keyboard that supports uncoupled modifier 
keys. To avoid confusion, and because not all keyboards support this decoupling, it is 
recommended that you not make use of this command. 

New Table Creates a new empty table. 

Duplicate Table Creates an identical copy of the current table. 

Remove Unused Tables 
Looks for tables that are not used by any modifer key combination, and removes 
them. 

Remove Duplicate Tables 
Checks for tables that are identical, reassigns modifier key combinations as necessary 
to one table, and removes the duplicate(s). 

Edit Dead Key... Displays a dialog box containing a list of all dead keys and lets you choose one to 
edit Note that there is a shortcut to edit dead keys: You can either click a dead key 
on the screen, or press the dead key on the keyboard. In either case the dead-key 
editor will automatically pop up. 

Convert To Dead Key 
Whenever you hold down a key with any combination of modifier keys and choose 
this menu command, the key will be converted to a dead key. You can then use the 
Edit dead key command to define all valid completion and substitution characters for 
the new dead key. 

Remove Dead Key This command is enabled only when a dead-key window is open. It removes the 
dead key currently being edited from the dead-key lis~ converting it into a live key in 
the process. 

The Font menu 

This menu lets you choose a font for displaying the characters in the editors window. 

The Size menu 

This menu lets you choose a size for the characters displayed in the editors window. All 
characters in the window are automatically resized. 
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• Note: If you are editing 'KCHR' resources on a Macintosh SE, Macintosh Plus, or Macintosh 
512K enhanced, the 'KCHR' editor automatically sets the size to 9 points so that the editing 
window fits on the screen. 
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'MENU' resources 

Menus are an important part of the Macintosh user interface and are found in all applications 
and many desk accessories. They are stored in resoun:es of types 'MENU' (regular menus), 
'annu' (MacAppGD temporary menusj these are converted into 'MENU' resoun:es by PostRez 
during the MacApp build process, so you will never fmd one in an application), 'CMNU' 
(MacApp pennanent menus; these will be supported in future versions of MacApp), and 
'mctb' (menu color tables for any of the preceding types). The 'cnmu' and 'CMNU' types differ 
from regular menus in that they have an additional conunand number field stored for each 
item in the menu. ResEdit 2.0 supports editing of all these menu resoun:e types with a new 
editor that automatically integrates the color information stored in the 'mctb' resoun:es and 
thereby allows editing of menus in color. See the inside front cover for a color illustration of 
menu editing. 

The display of the menu editor, shown in Figure +27, is divided into two sections. The left 
side shows the entire menu, and the right side displays detailed information about the item 
selected on the left side. To accommodate menus with many items, the box on the left side 
has a scroll bar. 

• Figure 4-27 'MENU' resoun:e editor 
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If the title of the rrenu is selected, the editor not only allows you to change the title but also 
displays some infonnation about the entire menu. You can enable/disable the entire menu 
and also select colors for the menu's tide, for the item text defaul~ and for the menu 
background. On machines capable of displaying color the color patches pop up like menus 
and let you select a color from a palette corresponding to the pixel-depths of the deepest 
device intersecting the window. Should you, however, need to enter a color in RGB values, 
you can double-click on the color patches and set the color using the standard color picker. 
On monochrome machines the color picker is opened whenever you click the color patch, 
because a palette caMOt be displayed adequately. Since the • Apple" character can't easily be 
generated on sorre keyboards there is also a convenient radio buttonto make the menu tide 
the • Apple" character instead of text entered in the box. If you do enter the • Apple" character, 
the editor automatically chooses the radio button. 

When you create a new rrenu, there are no iterm to select in order to start the editing process. 
You can choose Create New Item from the Resource rrenu, or type Command-K. 

When an individual menu item is selected the display changes to the one shown in 
Figure 4-28. As in the tide's display you can either edit the text of the item directly or you can 
use the radio button to make the item a separation line (which you can also do by entering ._" 
in the text box). You can use the Style rrenu to select a different style (bold, italic, and so on) 
for each item, and you can enable or disable the item with the checkbox in the upper right 
comer. For each item you can assign a command key equivalent (the menu manager is not 
case sensitive, so for esthetic reasons and consistency you should only use uppercase 
characters) and an item mark, which you can choose from an extensible pop-up menu shown 
in Figure 4-29. Both the command key equivalent and the mark character can be displayed in 
color. If you want to do tha~ select a color from the corresponding color palette pop-up 
menus. 

• Figure 4-28 'MENU' line item edit 
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• Figure 4-29 'MENU' mark pop-up 

!II MENU "Knob.· 10 • 132 from BOH 8 for Mac II 

Knob. I Selected Item: 181 Enabled 
Shorter line. X5 IQ 

I I' .,. TeHt: <i> I Longer lines I .0 More Open 
More Packed .P o - (separator line) 
Faster .F 
Slower .6 Color 

o has Submenu T .. llt· IIiiiII 
~ 

Cmd-Key: • I <) 

10 mI None 

Other ••• 

In order to make an important item look unique you can put an icon in front of the item's 
text Select Choose Icon from the MENU menu to get the dialog shown in figure 4-30. 

• Figure 4-30 'MENU' Icon chooser 

• File Edit Resource Window .~':tI"". Style I iZotz I 

The Dwarf Banana I 
.J MENU. from The Dwarf 8 I 

MENU "IZotz Te 
Choose an icon for this menu Item: 

IZoiil :Q • 6etFoobar .. 
Put Foober 
uon't lake me fO 

3CI6 

0 
<i> Normal Icons (ICON) ( New ) ( cancel) 
o Reduced Icons (ICON) 

I ~ o Small Icons (SltN) ( Edit I OK 
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Because of menu manager restrictions, the icon's ID must be in the range of 257 to 511 in 
order for it to be used in a menu. All other icons are displayed in gray. If a regular item seems 
to be too large for your menu, you can select the "Reduced" radio button to shrink the icon to 
a roore convenient 16x16 size or you can add a small icon (resource type 'SICN') instead of a 
regular one. If you later want to remove the icon from an item, choose Remove Icon from the 
MENU menu. In order to reduce clutter, the menu on the left side of the editing window does 
not show icons. 

If you want to see how your menu looks in real life you can try it out at the right edge of the 
menu bar. To show you that this is not a regular menu but a sample of the menu you are 
editing, its title is outlined with a black border. 

Sometimes a menu may become overcrowded with iterm. Thars when you should start to 
think about organizing the items in groups and turning the menu into a hierarchical menu. 
The menu editor helps you create submenus by providing you with the option to turn any 
item into a submenu just by clicking in a checkbox. In order to edit the items of the submenu, 
either select Open Submenu from the Resource menu or double-click on the item's text. 

If you happen to edit a 'crnnu' or 'CMNU' menu for inclusion in a MacApp program, you will 
notice that there is an additional field shown in the item's display that lets you set the 
command number for each item. This is shown in Figure 4-31, bottom center. 

• Figure 4-31 'cmnu' editing 

cmnu ID - 128 from The Dwarf Banana-Tree 

L I Haue You Now I Selected Item: ~Enabled 
I . 

TeHt: <i> I You're My Father111 I 
I o - (separator line) 

I 0 has Submenu 

Color 

TeHt: • 

cmd-Key:D • to Cmd-Num: @:J Mark: 0 • 
The menu editor also lets you rearrange the items in your menu. You can either use the 
standard commands on the edit menu, or you can put an item in a new position by dragging it 
around in the menu on the left side of the window. As you move the item around, a black line 
between items shows you where the item is currently located. 
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Selecting colors from the various pop-up palettes actually modifies an 'mctb' resource (menu 
color table) which is tmnsparently geneIated and changed for you. If you want to get rid of 
the colors you have set, you can reset the 'm:tb' resource by selecting Use Default Colors 
from the MENU menu. 

The 'MENU' resource has two assigned ID numbers. One of these is the resource ID number; 
it is set by getting information on the resource from the picker window, and is the ID number
that always shows up in the picker window. The other is the rrenu ID number; it is set inside 
the editor and is the part of the 'MENU' resource that is returned by the menu manager of the 
Macintosh Toolbox in response to MenuSelect and MenuKey calls. Keeping these two 
numbers the same, while not required, avoids confusion, and in fact they default to the same 
number. See Chapter 6 for rmre information. 

The corresponding 'MDEF ID number is almost always O. This refers to the standard 'MDEF 
in the System FUe, which is geneiaily appropriate. Some menus do, however, need to be 
dIawn differently. (Palettes, for example.) These could use sepaIate 'MDEF resources, and 
hence would not have 0 in this field. Figure 4-32 shows the 'MENU' and'MDEF ID number 
dialog box. 

• Figure 4-32 'MENU' ID dialog 

Pfease enter the Menu 10 and 
the ntsOURe 10 of the MO£F to 
be used below. 

Menu 10: 

MOU 10: ,-10_--, 
( Cencel ) I OK I 
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'TEXT ' and 'sty I' resources 

When styled text is copied to the clipboard or stored in a resource me by the TextEdit 
package, the style infonnation pertaining to the text and the text itself are stored in two 
resources, one of type 'TEXT " and one of type 'styl'. Previous versions of ResEdit have 
allowed template editing of the 'TEXT' resource, but have not allowed access to 'styl' 
infonnation. The 'TEXT'tstyl' editor, shown in Figure 4-33, has menus for Font, Size, and 
Style, and works much as you would expect a text editor to. 

• Figure 4-33 'TEXT ' and 'styl' editor 

• TEHT/styl"Patrlck's Rdmonitlon" 10 ·440 from Ono-Sendal 

Some of the other programs on this disk ace similarly free; 
some, however, ace shareware, which lOU wi~ of course 
pay for if they're of use to you. (Don t be a china. 
H a J?iece of shareware helps you detect and/or cure a virus, 
you ve already gotten more value out of it than the 
Shareware fee can possibly cover.) 

I - Patrick Nielsen Hayden 

K5 
01 F,I!I!l;'i!.'!P.r.1;~Jil ... , .. ;!, , .. ;.lililililimililimmmi!ilml!!ilil!m~m!!mmmmmmlil!!im!!ml!lill1!F,1ii, ;" .. '.' .... ;,; : ... ,;:., .:i!!J!1it .... I'CJ 

If you attempt to open a 'styl' resource, the editor is invoked. A 'styl' resource doesn't make 
much sense without some text to which it can be applied. 
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'vers' resources 

The Ivers' resource is part of a Macintosh application. It is defmed as a general source of 
version information, but currently displays its information in the Finders Get Info window. 

The 'verst editor is shown in Figure 4-34. The Version number is displayed in three parI!, with 
a fourth Non-release part below. The allowable ranges for these numbers are as follows: main 
number: 0-99; second part: 0-9; thUd part: 0-9; Non-reIease: 0-255. The editor will reject 
numbers outside the allowable ranges, even though it appears to accept and save them; if you 
close and reopen the resource, they show up as zero. If your version number has letters in it, 
you should put the letters only in the short and long version strings. The Release and Country 
Code items are popup menus. Release allows you to select from Development, Alpha, Beta, 
and Final; Country Code is a longer list, currently containing 54 countries. The short version 
string should, in general, contain only the ordinary version number (e.g., -2.1a5"), and the 
long version string can also include copyright notices, authors names, release dates, and other 
relevant information. It is displayed in the open area at the bottom of the Fmders Get Info 
window. 

• Figure 4-34 Editing a Ivers' resource 

Derslon number: [:J. [] . [] 

Release~ Deuelopment .. 1 Non-release: I!:J 
Country Code:1 00 - USH .. I 

Short uenion string: IThls is a stickup' 

Long uenlon string (ulslble In Set Info): 

Put an your bits In this bag, and lie down 
behind the disk drlue' 
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Chapter 5 ResEdit Templates 

One generic way of editing a resource is to fill in the fields of a dialog box. 
The contents of the dialog box are specified by a template contained, 
typically, in ResEdit's own resource file or in the Res Edit Preferences me. 
This chapter discusses template editing and tells you how to create your 
own templates. 
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Template characteristics 

If you open an actual resource of any of the types listed in this chapter, you will find yourself 
editing in a dialog box, the contents of which are specified by the template of the same name 
as that resource type. (For example, the 'LA YO' resource, discussed further in Chapter 6, is 
controlled by the 'TMPL' resource named LA YO in ResEdit.) The template specifies the format 
of the resource and also specifies what labels should be put beside the ediffext item; in the 
dialog box used for editing the resource. 

• Note: Templates can contain a maximum of 2048 fields. For the purpose of enumerating, a 
field is defined as any item that is drawn on the screen. That is, a label counts as a field, as 
does a separator, and so on. This limiting number of 2048 is reached rather easily, 
particularly in resources with repeating lists, as for example, 'pItt'. 

The 'TMPL' resource inside ResEdit is recursive, in the sense that the contents of each of these 
named 'TMPL' resources is a template for a template. (There is even, of course, one for 'TMPL' 
itself.) As of late 1990, Res Edit contains 'TMPL' resources for these resource types: 

'actb' 'acur' 'ALRT' 'APPL' 'BNDL' 
'clut' 'CMOK' 'CMNU' 'cmnu' 'CNTI.' 
'detb' 'om' 'OLOG' 'ORVR' 'FBTN' 

'FDIR' 'finP 'fie1#' 'FOND' 'FONT' 
'FRSV' 'fval' 'FWIO' 'GNRL' 'icmt' 

'indm' 'infa' 'infs' 'inpk' 'inra' 
'itlb' 'itlc' 'itlk' 'LAYO' 'MBAR' 

'mctb' 'MENU' 'nret' 'PAPA' 'PICK' 
'pitt' 'posr 'ppat' 'PRCO' 'PRC3' 
'qrsc' Iresi' 'RMAP' 'ROv#' 'RVEW 
'SIGN' 'SIZE' 'STR' 'STR#' 'TEXT 

'TOOL' Ivers' 'wctb' 'WIND' 'wstr' 
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'CTY#' 

'fetb' 

'FREF 

'inbb' 

'insc' 

'mcky' 

'PIer 

'PSAP' 

'scm' 
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Editing 

When you are editing a template, the Tab key moves you forward from field to field within 
the template. Shift-Tab moves you backward. Here, however, the term field means an active 
area with an editable value in it. Fields are shown on the screen as boxes. 

To add a new field to a repeating sequence in a template, select a separator, which is usually 
a set of asterisks ( ............... ), and choose Create New Field from the Resource menu. 

Some templates control windows or resources that contain rectangles. Some of these 
templates will have a Set button that lets you draw a rectangle on the screen to delimit the 
resource. The pixel numbers for the rectangle are automatically copied to the appropriate 
fields in the template. There is a Set button in the 'LA YO' template, which is discussed in 
Chapter 6; another is shown in Figure 5-1. 

Values can be entered into numeric fields in either decimal or hexadecimal notation. You can 
enter a hexadecimal number into any numeric field by preceding it with a dollar sign ($). 

'PIer' editing 

There is no custom editor for 'PIer resources, though there is a custom picker. 'PIer 
resources can, however, be sized with the template that exists for them, which is shown in 
Figure 5-1. If you click the Set button, you can then draw a rectangle on the screen to defme 
the shape and size of the picture. Otherwise, you can enter values in the fields as you would 
in any template. 
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• Figure Soot The template editor for 'PIer 

11 01 01 00 
00 01 56 02 
00 80 01 10 
00 80 01 13 
00110 01 13 
00 00 OR 06 
CO 3F FO FE 
III 01 00 20 
00 08 09 IF 
21 9C 00 66 
III 01 01 30 

OR 00 00 00 
00 98 00 OR 
00 80 01 90 
00 110 01 8R 
00 liD 01 IIR 
IF FO 01 FF 
00 011 09 10 
20 10 00 16 
F8 01 01 30 
00 06 09 10 
2F 01 01 III 

For other examples of template editing, see the description of the 'STR#' resource template in 
this chapter and the description of the 'LA YO' resource in Chapter 6. 

Creating New Templates 

You can generate templates for your own resource types. These templates, which are resources 
of type 'TMPL', need not reside within ResEdit. The ResEdit Preferences file in the System folder 
is a good place to keep them. 

Template example 

The 'TMPL' resource inside ResEdit with name STR# is shown in Figure 5-2. It is shown here as a 
ready example of what 'TMPL' innards look like on the screen. 
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• Figure 5-2 'TMPLI defmition for type ISTR#' 

TMPl "STR#" ID • 256 from RetEdlt 2.0JJ2 

••••• 
Label 

Type 

••••• 
Label I····· 
Type ILSTC 

••••• 
Label \The string 
Type PSTR I 
••••• 
Label 1**··· Type LSTE 

••••• 

Figure 5-3 shows the same template being used to edit an actual ISTR#' resouoce. You can see 
the correspondence between the items in the 'TMPL' resouoce and the resulting display. 

• Figure 5-3 ISTR#' template in use 

• File Edit Resource Window Font 

TellchTeat 1.2 

5TH#' ID • 2DD from TellchTeHt 1.2 

Hu.Slring' 20 

•• *** 
Th •• lrlng 

***** 
Th. string I ... T_eo_c_h_T._x_l ________ ..... 

••••• 
The string It 1986-1988 Rpple Co.puler, Inc. I 
••••• 
Th. string IBryan St.arns 

••••• 
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You can look through the other templates and compare them with the structures of their 
corresponding resoua:es to get a feel for how you might define your own resoua:e template. 
(If you use MPW, note that these templates are equivalent to the resource type declarations 
contained in the {RIncludes} directory-refer also to the DeRez command in the MPW 
Reference, and the appropriate chapte1S of Inside Macintosh.) 

These are the types you may choose from for your editable data fields: 

DBIT, DWRD, DLNG Decimal byte, decimal word, decimal long word. 

HBIT, HWRD, m.NG Hex byte, hex word, hex long word. 

A WRD, ALNG Word align, long align. 

FBIT, FWRD, FLNG Byte fill, word fill, long fill (with 0). 

HEXD Hex dump of remaining bytes in resource. (This can only be the last type 
in a resource.) 

PSTR Pascal string (length byte followed by the characters), 

LSTR long string (length long followed by the characters). 

WSfR Same as ISTR, but a word rather than a long word. 

ESTR, OsfR Pascal string padded to even or odd length (needed for Dm resources). 

CSIR C string (characters followed by a null). 

ECST, OCST Even-padded C string, or odd-padded C string (padded with nulls). 

BOOL Boolean (two bytes). 

BBIT Binary bit. (There must be 8 or an even multiple of 8 of these; if fewer than 8 
bits are defined, you must include placeholder bits.) 

TNAM Type name (four characters, like OSType and ResType). 

CHAR A single character. 

REef An 8-byte rectangle. 

Hnnn A 3-digit hex number; displays nnn bytes in hex fonnat. 

Cnnn A C string that is nnn bytes long. The last byte is always a 0, so the string itself 
occupies the first nnn-l bytes. 
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POnn A Pascal string that is nn bytes long. The length byte is not included in nn, so 
the string occupies the entire specified length. 

• Note: Scrolling can become extremely slow if a template contains many BBIT 
or BooL items. 

ResEdit does the appropriate type checking for you when you put the editing dialog window away. 

The template mechanism is flexible enough to describe a repeating sequence of items within 
a resource, as in 'STRI', 'Om', and 'MENU' resources. You can also have repeating sequences 
within repeating sequences, as in 'BNDL' resources. To tenninate a repeating sequence, put 
the appropriate code in the template as follows. 

LSTZ 

I.STE 

ZOO 

I.STC 

I.STE 

OCNf 

LSTC 

I.STE 

I.STB 

I.STE 

List Zero-List End. Tenrunated by a 0 byte (as in 'MENU' resources). 

Zero CountIList Counl-List End. Terminated by a zero-based word count that starts 
the sequence (as in 'om' resoun::es). 

One CountlList Counl-List End. Terminated by a one-based word count that starts 
the sequence (as in 'STRI' resoun::es). 

Ends at the end of the resoun::e. (As in 'acue' and 'APPL' resources.) 

The "list-begin" code begins the repeating sequence of items, and the LSTE code is the end. 
labels for these codes are usually set to the string ""'''''''''''''". Both of these codes are required. 
It is generally advisable to keep the beginning and ending labels identical to each other, and 
to have them be no more than five characteIS long. 
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Your template does not have to be inside ResEdit; it can be in any open file. (The preferred 
location is the ResEdit Preferences me in your System Folder.) Note that if roore than one 
currently open me contains a template for your resource type, the one in the most recently 
opened me is used when you edit resources of your type. To create a template, follow 
these steps: 

1. Open the me that you want to put your template into. 

2. Open the 'TMPL' type window. Use the Create New Resource command to create the 
'TMPL' type if it doesn't already exist in the me. 

3. Choose Create New Resource from the Resource menu. 

4. Select the list separator (*****) by clicking it 

5. Choose Insert New Field(s) from the Resource menu. You may now begin entering the 
Iabel,t}Pe pairs that define the template. Before closing the template editing window, choose 
Get Info from the Resource menu and set the name of the template to the four-character 
name of your resource type. 

6. Close the me window and save changes. 

The next time you try to edit or create a resource of the new type, you'll get the dialog box in 
the format you have specified. 
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Chapter 6 ResEdit Tips 

As with any other utility, ResEdit takes some getting used to. This chapter 
presents a few handy tips and a few "hints and kinks" to help you become 
more comfortable with the capabilities of the program. 
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Hints and kinks 

• At the risk of being slighdy repetitive, and because these things can be important, it is 
once again suggested that you edit resources in a copy of your target me, rather than 
the original. 

• If you choose Get Info for ResEdit (from the Finder), you will fmd that Application 
MeIIX>ry Size is set to 500 KB. If you are editing large resources 500 KB is not sufficient, 
and you should give ResEdit more memory. 

• The following sequence of steps can be used to copy a 'PIer resource from most drawing 
or painting programs into another me: 

1. Open the file that contains the graphic that you want to tum into a 'PIer. 

2. Select and copy the part of the graphic that you want 

3. Start ResEdit and open the me that you want to contain the 'pier resource. 

4. Open the 'PIer picker for that file. 

5. Choose Paste. 

If you paste with the me window open instead of the 'PIer picker window, you will get both 
the 'PIer and the application's private resource type (for example, 'MDPL' if your 'PIer is 
from MacDraw). . 

• To add a picture to a 'DLOG': 
1. Get a picture. Add it to the 'PIer resources in your me. (See the previous tip.) 

2. Choose the Get Resource Info corrumnd from the Resource menu. 

3. Use Copy to put the ID number of the new 'PIer in the scrap. 

(Instead of steps 2, 3, and 7 here, you can always just read the ID number when you copy the 
'PIer and type it into the 'Dm' item by hand. ResEdit 2.0 displays the ID number of each 
'PIef" resource.) 

4. Go to the 'Dm' that belongs to the 'DLOG' you are adding the picture to. 

5. Choose New Item. 

6. Click the PICf button. 

7. Paste the ID number from the scrap. 

8. Close the Dialog Item Editor. 

9. Choose Use RSRC Rectfrom the menu. 
10. Position the picture. 
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• If you are using the any of the icon editors, and you make a selection with the rmrquee 
and then cut or copy it, you can paste it as a 'PIer resource. First make the type picker of 
your target (this can, of course, be the 'PIer picker) be the active window. If you then 
paste, ResEdit makes the contents of its SCClp into a new 'PIer. The 'PIer resource 
picker does not have to be open when you attempt to perform the 
paste operation. 

• There are keyboard equivalents for rmny operations you would ordinarily perform with 
the muse. Try selecting a me in the me open dialog by typing the fIrst letter or two, then 
opening it with the Return key; you can do the same with resource types, and then with 
individual resources. (With individual resources, you can type the ID number or the 
name.) The arrow keys also work-for example, in a me list, you can go down the list 
with the down-arrow key. 

• There is a hidden Change Color comrmnd in the bit editors. If you hold down the 
Comrmnd key and pick a new color, all pixels of the current foreground (or background) 
color are changed to the new color. 

• In general, it is a good idea to use the sam: ID for an 'ALRT' or'DLOG' and its associated 
'Dm', though this PClctice is not required. 

• Other shortcuts and handy items: 

a In the resource picker: Option-double-click for Open Using Hex. 

a In the resource picker: Option-Cornmanci-double-click for 
Open Using Template. 

a In the resource picker: Option-Cornmand-Shift-double-click (or Shift-Open Using 
Template) displays the template-type dialog box without the list of templates. (You 
can enter the template type you want.) If you are operating from a floppy disk, this 
can be a fast method. 

a Option-Cut and Option-Copy append the cut or copied item to the scrap. At the 
individual item editor level, holding down the Option key does not change the action 
of Cut or Copy. 

a In the 'Dm' editor: Option-Cornmand-double-click on a 'CNTL', 'ICON', or 'PIer to 
open it as a dialog item. 

a Comrmnd-click in a picker for disjoint selection. 

a Shift-click in a picker to extend a selection. (In a pictorial display such as the one for 
'ICON' resources, the selection will extend as a rectangle.) 

a Using Shift-Create New Resource to create a new resource type gives you the "new 
type" dialog box without the list of resources. You must, of course, enter the resource 
type you want rather than selecting it from the list If you are operating from a floppy 
disk, this can be a fast method. 
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[J In the bit editors ('CURS' and 'leN", for example), Shift-drag creates a selection 
rectangle (marquee). Using Shift-drag inside the marquee moves it Releasing the 
Shift key and clicking inside the editing area turns off the marquee, but also inverts a 
bit in the picture. The marquee is also available in the 'FONT' editor. 

• If you hold down the Command, Option, and Shift keys while choosing About ResEdit 
from the Apple menu, you can toggle a special stress-testing mode ("Pig mode"). In this 
roode, ResEdit perforrm a compact-memory operation and a purge-memory operation 
each time it receives an event from the queue, excepting null events. This feature was 
designed as an aid to debugging ResEdit itself, and is clearly something most people will 
never have any use for. It is suggested that you avoid invoking this mode unless you are 
writing an editor and feel a need to stress-test it 

• If the 'om' for a 'OLOG' that is being displayed contains a reference to a 'eNTI' that 
doesn't exist, the editor will hang (in NewDialog) when it tries to draw the dialog box. 
Please be careful! 

• Because 'om' and 'ALRT' resources are ordinarily displayed where you put them in the 
window, there is some chance that they may be mispositioned. That is, if you don't have 
your code display these resources exactly where you want them, they could show up 
where you don 'twant them. To be sure that a dialog box shows up where you want it, 
mark it as invisible and reposition it exactly in your code. Have your code mark it visible 
right after displaying it (This avoids various embarrassments.) 

• If you have Color QuickDraw, but you want to be able to open the 'leN#' editor. by 
doubleclicking a resource of type 'ICN" regardless, you can make a resource of type 

'RMAP' in the ResEdit Preferences file. This resource should look like the one shown in 
Figure 6-1. Notice that the name of the 'RMAP' resource is the name of the resource you 
will be opening, and the Map To field contains the name of the editor you want to invoke. 
Set the name of the 'RMAP' as usual, with the Get Info command. 
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• F1gure6-1 'RMAP' resource 

1Qa. HMHP -ICN#" 10·128 from He.Edit Preferences ... 

napTo ~ Q 

Editor only? ~ 
Exception 0 
count 

• If you hold down the Option and Command keys and choose About ResEdit from the 
Apple menu, you get a list of credits that tells you who has worked on the program 
Under MultiFinder, hold down the Option and Command keys, pull down any menu 
other than the Apple menu, and then move over to the Apple menu. Choose About 
ResEdit 

• Although under ordinary conditions the menu ID number and the 'MENU' resource ID' 
are kept identical to one another, there is one situation in which you may want to make 
them different If you are using an ordinary debugger to disassemble and walk through 
the main event loop of your program, it is convenient to have the menu manager return 
numbers like 1, 2, 3, 4, and 5 for the menus in your program You would therefore set the 
!renu ID fields of your !renus to consecutive integers. Then you might create a 'MBAR' 
resource with ID 128 and list the 'MENU' resource IDs of your menus in it You need only 
call GetNewMBar (128) in your program to install all of the menus. When you are 
debugging, a call to MenuSe lect (for example) returns a value of $00030004 if the 4th 
item in the 3rd menu has been chosen. This is rather more convenient than seeing 
$00820004 and having to translate $82 to 130 decirml, and then remembering that 130 
was your third menu. If you use a high-level debugger this approach is unnecessary. 
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The 'LAYO' resource 

One of the resources inside the Ymder ~ of particular interest, beca~ it controls a number of 
defaults, most of which are part of the layout of your desktop. It is the 'LA YO' resource. To 
open the Finder with ResEdit, you must be running under the Finder itself (rather than under 
MuitiFinder), or you must edit a copy of the Finder. It ~, of cowse, suggested that you edit a 
copy. If MuitiFinder is running and you try to open the currently active Finder, you get an 
error message telling you that the Finder ~ already open from another application. 

If you are in a risk-taking mood (or if you have done this a few hundred times already and 
have become inured to it), boot without MultiF'mder, open the Finder, and choose the 'LA YO' 
resource type. There ~ only one 'LA YO' resource, ID number 128. Open it. 

The fust part of the template is shown in Figure 6-2. 

• FJgure6-2 'LA YO' template, view 1 

'. -- - -~ ~-- LAVO 10. 128 from Finder - -- --- =~-- - - =-=-

Font 10 § Font Size 
i·O j 

ii: 

Screen Hdr 
: j 

Mgt III 
Top line 1-21 . ! 

break il! 
:= 

Datto. line 117 I' 

break :!! 
Printing hdr li2 
hgt ! 

132 
!. 

Printing :i! 

The fust two items control the display font-that is, the font that prints out under the icons on 
your desktop. The default is 9-point Geneva, as shown. If you dislike sans-serif fonts, you can 
easily change the fust two items to 2 and 9, for New York at 9 points, or to 20 and 10 (or even 
12), for Times at 10 or 12 points; the 9-point version of Tunes is very small. 

The line of numbers labeled Window Rect in Figure 6-3 allows you to specify the default 
folder (and disk) window size and location. 
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• Figure6-3 'LA YO' template, view 2 

LAya 10 - 128 from FInder ~--
-~~-----

footer hgt 

Ulndo. Reet ~II" 1~~C!ill 
Line ,pacing 16 

1===-===1 
Tab stop I 20 

1=====1 
Tab stop 2 II .... 
Tab atop 3 FII=8 .. ===I 

Tab slop" 1280 

Tab slop 5 ,:=37===6===1 

Tab ,lop 6 1 .. 2 .. 
1=====1 

Tab alop 7 1 .. 56 

ill 
H! 

,II 

If you like, you can specify these defaults by clicking the Set button and then drawing a 
rectangle on the screen. Please note that if MultiFinder is running when you edit the 'LA YO' 
resource in a copy of the Finder, and you try to start your rectangle in an area of the screen 
that has something other than a ResEdit window in it, you will find youlSelf summarily ejected 
from ResEdit into whatever you have clicked. The cure is straightforward: Move a ResEdit 
window to the area where you want to start drawing your rectangle before you click the Set 
button, or use the number fields instead of the Set button. You can also explicitly set the 
locations of the seven tab stops the Finder uses for displaying information about rues when 
you choose to view by Name, Date, Size, or Kind. 

A bit further down the template are the numbers that control the placement of the icons 
themselves, as shown in Figure 6-4. 
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• FIgure 6-4 'LA YO' template, view 3 

UIYO ID • 128 from Finder 

Reserued 

1::0 
Icon Harz. 
spacing 

Icon Ue .. t. \60 ii 
spacing 

Icon Uert. \15 " , 
phale ,'! 
s •. Icon \101 '!i 

Harz. , ! 
':i 

S •. Icon 118 , 
Ue .. t. .n 

Sotre people dislike having icons with long names overlapping and obscuring the names of 
other icons. One solution to this problem is to change the Icon Vertical phase. Figure 6-3 
shows SOtre modified numbers, rather than the defaults supplied with the system release. 

... Warning Do not set the Icon Vertical phase to exactly half the Icon Vertical 
spacing unless you like system crashes. • 

Figure 6-5 shows some unused bits and three commands, the fhst of which eUse zoom 
Rects") is on by default If you set it to False, the Finder will open and close windows slightly 
faster, because it won't use its 'zoom' visual effect. 
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( • FIgure6-S 'LA YO' template, view 4 

lAYO ID - 128 from finder 
date 

Use zoo. OD (il =1 

Recls :11 
Skip lrash (i0 01 ~ , 
earnings :;1 

.j. 

Aleays grid 00 (il Ii: 
drags .d 

~: Unus.d 1 (1)0 01 
.:: 

Unus.d :3 (i0 01 001 

Unused 2 .0 01 ~!' 
mil Unused 1 (i0 01 ~ .. ~ '""- .... 

Skip trash warnings prevents the system from asking whether you really want to throwaway 
applications or System flles. Since you can avoid the warning by holding down the Option 
key when you throw things into the trashcan, this seems a bit extrerre. Moreover, it can be 
quite dangerous, depending on what you tend to throw out and how attentive you are about 
it. 

If you don't like having to clean up your windows, try turning on Always grid drags. This 
option makes the icons stick in place at the grid spacing specified in the part of the template 
shown in Figure 6-4. Sorre people prefer to be able to put them anywhere and therefore 
eschew this option. 

The Watch Thresh setting (not visible in any of the figures) allows you to adjust how long the 
Finder will wait during lengthy operations such as flle copying before it displays a wristwatch 
cursor with animated hands. The time is expressed in 60ths of a second. If you make it too 
short, the cursor will jitter and change shape too often. Sorre older Finders do not make use 
of this option. 

Figure 6-6 shows a few more unused bits and the end of the template. 
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• FJgute 6-6 'LA YO' template, view 5 

'. -

LOYO 18 - 128 from Finder 
Unu.ed 5 @) 0 0 I 

Unu.ed 1 8 0 0 1 

U.e Phy. 0 0 81 
Icon 

Title Click 00 @)1 

Copy Inherit @)O 01 

H •• Fold 80 01 
Inherit 

Color Style 

nax • of 
.Indo •• 

Use Phys Icon is handy if you have a Macintosh IT or Macintosh SE with two floppy disk 
drives. If this option is on, the icon you get when you insert a floppy disk into your machine 
indicates which drive the floppy disk is in. The disk location is certainly easy enough to recall 
just after you put the disk in, but you may forget it later. Knowing which drive a floppy disk is 
in may not be a major issue, but is certainly a pleasant convenience. This option also includes 
distinctive icons for an external hard disk and a CD-ROM drive. 

TItle Click lets you double-click the title bar of a folder'S window to bring the parent folders 
window to the front (or to open it if it is not already open). This feature can be quite handy. 

When you create folders on an AppleShare' server, New Folder Inherit causes them to get 
their privileges from the parent folder, and when you duplicate existing folders on an 
AppleTalk server, Copy Inherit causes the copies to inherit their privileges from the Originals. 

The Max , of windows field allows you to set the maxinrum number of windows the Finder 
can have open at anyone time. Increasing this number causes the Finder to need more 
memory. Under MultiFinder, you may have to increase the memory allocation for the Finder if 
you make this number nruch larger than the default 

Some of the items in the 'LA YO' template have not been discussed here. Of these, some are 
not yet in use. Others are either arcane or self-evident. 

'KOIR' questions and answers 

• How do I change the character generated by Shift-e? 

104 ResEdit 2.1 Reference 

.. 



( Shift-e normally generates a capital E character. To make this key combination generate a 
different character, simply hold down the Shift key and use the mouse to drag a character 
from the character chart to the e key on the keyboard. 

You will notice that when you press the Shift key, the table that is highlighted in the table list 
changes. (For IOOSt key layouts, the highlight switches from Table 0 to Table 1.) This change 
shows you that any character changes you make will be made in the highlighted table. When 
you make Shift-e generate a different character, you are changing every nxxiifier key 
combination that uses the highlighted table. For example, if Option-Shift used the same table 
as Shift, you would also have changed the character generated by Option-Shift-e. 

• How do I change the behavior of a modifier key combination? 

For example, suppose you wanted Option-Shift-a to generate a different character from that 
generated by Option-Command-Shift-a. If you hold down the Option and Shift keys and then 
press and release the Command key, you will notice that (for most key layouts) the 
highlighted table does not change. If you want these two modifier key combinations to be 
different, you need to create a new table for one of them. To do this, you can use either the 
New Table command or the Duplicate Table command from the KCHR menu. If you want to 
create only a few differences, you should use the Duplicate Table command In our example, 
we only want Option-Command-Shift-a to be different, so we would do the following: 

1. Press and hold down the Option, Command, and Shift keys. 

2. Choose Duplicate Table from the KCRR menu. 

3. Select the new table that was added to the end of the list (while still holding down 
the modifier keys). 

4. Choose OK in the alert box that appears. 
5. Drag the character from the character chart to the key that you want to change 

(while still holding down all of the modifier keys). 

• How do I remove a table that is no longer being used? 

If you have reassigned a modifier key combination so that a table is no longer used, you can 
rermve the table by choosing "Rermve unused tables" from the KCHR menu. If there are 
unused or duplicate tables present when you close the editor, you will be asked whether they 
should be removed. 

• How do I create a dead key? 

You can create a dead key (such as Option-e in rmst key layouts) by choosing "Convert to 
dead key" from the KCHR menu while holding down the key. For example, follow these steps 
to make Option-k into a dead key: 

1. Press and hold down the Option and k keys. 

2. Choose "Convert to dead key" from the KCRR menu. 

3. Release the keys. 
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4. Once again, press Option and k to activate the dead-key editor. 
• How do I remove a dead key? 

Follow these steps: 

1. Select the dead key to display the dead-key editor. 
2. Choose -Remove dead key" from the KCHR menu. 

• How do I create a new completion/substitution pair in the dead-key editor? 

When the dead-key editor is active, you can drag characters from the character chart to the 
completion/substitution pair list The character on the left in the list is the completion 
character, and the character on the right is the substitution character. For example, Option-E 
produces the E character. 

n How do I delete a completion/substitution pair in the dead-key editor? 

To delete a completion/substitution pair, drag either character from that pair in the 
completion/substitution pair list to the tclshcan in the lower-right comer of the window. 
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Chapter 7 The Programmatic Interface 

You may want to create and edit your own types of resources. You can 
write pickers and editors as extensions to ResEdit in Pascal or C, and put 
them in the ResEdit Preferences fIle in your System Folder. This chapter 
describes this process and discusses necessary and optional functions 
and procedures. 
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Pickers and editors 

Pickers and editors are separate from ResEdit's main code and hence may be supplied by 
user-written software. 

The picker is the part that displays aU the resources of yoUr type in the resource type window. 
It is given the resource type and should display aU resources of that type in the current 
resource me, using a suitable display format If the picker is given an open call and there is a 
suitable editor, it should launch that editor. You need not supply your own picker; if a custom 
picker is not available, the standard picker is used to show a list of your resources with their 
names and IDs. 

The editoris the code that displays and lets you edit a particular resource. The editor is given 
a handle to the resource object and should open an edit window for you. 

Note that pickers and editors can be opened from anywhere in ResEdit or in your code. For 
instance, a dialog editor may open an icon picker so that you can choose an appropriate icon. 

Code-containing resources in the ResEdit release 

ResEdit includes three different types of resources that contain code. Much of the code is in 
the'normal'COOE' resources. The editors and pickers are found in the 'RSSC' resources, and 
the IDEF (or list defmition) procedures are found in the 'LDEF resources. The resource 
names of the pickers and editors are very important. The resource name of the 'RSSC' 
resource for a picker should be the resource type that the picker will pick. The resource name 
for an editor should be the resource type that the editor will edit, with a commercial "at" sign 
(@) in front of it Subeditors (described in the section "Launching routines" later in this 
chapter) should have a dollar sign ($) in front of the resource type name. For example, the 
'om' picker can be found in an 'RSSC' resource with the name om. The 'om' editor can be 
found in an 'RSSC' resource with the name @om, and the 'om' subeditor in an 'RSSC' 
resource with the name $Om. 
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( Samples 

A sample resource editor, picker, and LOEF are included with ResEdit The samples are 
provided in both C and Pascal and use the MPW 3.1 environment, the MPW C or Pascal 
Compiler, and the MPW Assembler. The appropriate build files and makefiles are 
also provided. 

Sample editor 

A sample ResEdit editor is provided in the file XXXXEdit In this sample, XXXX represents 
your resource type. The sample editor will simply display a window and invert its contents. 
Since the details of editing your resource are known only to you, it is up to you to fill in the 
code necessary to make this sample into a real editor. 

The sample editor is initialized by means of the Edi tBirth procedure when a resource of 
type XXXX must be edited. EditBirth is passed two handles: a handle to the resource to 
be edited (the same handle that would be received by using a GetResource call) and a 
handle back to the picker that launched the editor. 

The editor then creates a window and sets up any data structures needed to operate. Because 
it may be loaded in and out of memory during any given session and because it doesn't have 
access to global variables, it creates a handle to a data structure to hold all data that needs to 
be preserved between calls. It stores the handle in the edit data structure rXXXXRec. Note 
that the handle to the edit data structure is stored in the window's ref Con parameter. 
ResEdit uses this data structure to identify which editor or picker is to receive a given event. 

ResEdit detennines which editor should receive which events, so you need to worry only 
about events that affect your editor. During an update event, the BeqinUpdate and 
EndUpdate calls are done by ResEdit, not by the extension program. 

Sample picker 

A sample ResEdit picker is provided in the file ICON. Pick. The sample picker is the actual 
'ICON' picker from ResEdit. The 'ICON' LOEF (in the file ICON.IDEF) is included with this 
example so that you can see the interaction between a picker and its IDEF. 
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SampleLDEF 

A sample ResEdit LDEF is provided in the file ICON.LDEF. An LDEF is a list definition 
procedure used to customize the way the List Manager draws and highlights cells. For rmre 
information, see Inside Macintosh, Volume IV, Chapter 30, and Technical Introduction to the 
Macintosh Family, Chapter 3. In ResEdit, LDEFs are used to customize the look of the picker 
windows. LDEFs are generally vesy simple procedures that draw or highlight a single cell of a 
list The sample LDEF is the 'ICON' LDEF from ResEdit 11lis LDEF is used to display a 
ftle's Icons. 

Building the examples 

You can bulld the examples by using the build scripts provided in the folder appropriate to 
the language that you are using. The build scripts assume that ResEdit and the Examples 
folder will be found in the directosy {boodResEdit:. If these ftles are located elsewhere, the 
bOOd script ftles should be modified accordingly. 

If ResEdit is successfully located, the MakeFile instructions will install the editor, picker, and 
LDEFs directly into ResEdit When you experiment with changing any of these ftles, you may 
want to build into a copy of ResEdit If anything goes wrong, you can then get a fresh copy of 
ResEdit to continue your experiments. 

Using ResEd 

The program you write must be a Pascal unit or C header ftle and library. Its interface with 
ResEdit is established by the MPW unit ResEd, contained in the ftle ResEd.p or ResEd.h. If 
your unit is written in PASCAL, it nrust begin with a USES declaration for this unit. 

The assembly-language code that "opens up" ResEdit and activates your program is contained 
in the file RSSC.a. It nrust be linked with your Pascal or C module. When you open a resource 
of your type, ResEdit will call this code. 

If your bulld script does not automatically install your editor or picker, place it in ResEdit's file 
by using ResEdit itself, with the type 'RSSC' and a unique ID number. Please use an ID 
number greater than 10,000 to avoid future conflicts. Your editor's name in the ResEditftle 
must be of the form @ABCD, where ABCD is the name you have assigned to the new type it 
edits. Install your picker (also of type 'RSSC') with the name ABeD (without the commercial 
"at" sign). 
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Writing a ResEdit extension 

Here are two things to remember when writing a ResEdit extension: 

• Always know which resource you are requesting and where it will come from. Many 
resource files may be open at any given time. Whenever a resource is needed, make sure 
which resource file you are accessing by using UseResFile or similar operations. 

• Your editor may be called with an empty handle in oroer to create an entirely new 
instance of the type you edit 

In all of these procedures, remember to lock any handle that is going to be dereferenced (for 
example, in a Pascal with statement). For example, in Pascal, the fust instructions in the 
DoEvent procedure should be 

BubbleUp(Handle(object»; 
HLock(Handle(object»; 

It is important to caU the BubbleUp procedure to avoid heap fragmentation. Remember to 
unlock the object at the end of the procedure! 

If any of these procedures will need access to the current port, especially Edi tBirth, 
DoEvent, and DoMenu, caU 

SetPort (objectAA.wind) 

if you are writing in Pascal, or 
SetPort «*object)->wind) 

if you are writing in C. 
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ResEdit 2.0 changes 

Here's what you have to do to upgrade an editor to ResEdit 2.0: 

• Change the name field c:i your parent record from STR64 to STR255. 

• Add AbleMenu for the Resource menu on activate: 

AbleMenu (rsrcMenu, rsrcEditor); 

• Change AbleMenu for the File menu to 
AbleMenu (fileMenu, fileAll); 

• Add Print Item to the DoMenu procedure: 

print Item: 
PrintWindow (NIL); 

• In DoMenu, change Revert Item to rsrcRevertItemand GetInfoItem to 
rsrcGetInfoItem. Move them from the File menu to the Resource menu. 

• Add the IsThisYours function and be sure to make it public. See the example code 
for details. 

• EditorWindSetup now requires a windowKind parameter and a dloqID 
parameter; windowKind should be the resource ID of the editor or picker (returned by 
ResEdID), and dloqID should be NoDialog or the resource ID of a dialog to be used for 
the window. 

• WindOr iqin now takes a P arentHandle parameter and requires that the 
windowKind field of the argument window be set to the resource ID of the editor. 

ResEd changes for the 2.0 release 

• P ickRec was changed to remove some unused fields and add other fields for the 
View menu. 

• P arentRec was changed to include an SfR255 instead of STR64. 

• Menu and string constants were changed. 

Several procedures have Interface changesj these are the new interfaces: 

FUNCTION EditorWindSetup (dloqID: INTEGER; color: BOOLEAN; width, 
height: INTEGER; VAR windowTitle, windowName: STR255; addFrom: BOOLEAN; 
windowKind: INTEGER; father: ParentHandle): WindowPtr; 

PROCEDURE WindOrigin (w: WindowPtr; dad: ParentHandle); 

112 ResEdit 2.1 Reference 



PROCEDURE PickMenu (tossOnClose: BOOLEAN; menu, item: INTEGER; 

pick: PickHandle); 
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The following routines are no longer available: 
CWindSetup 
WindSetup 
RevertResource 
pickStdRows 
CallEBirth 
CallEvent 
CallMenu 
CallPBirth 
CopyRes 
DOKeyScan 
DoListEvt 

Required routines 

Each picker and editor must contain a set of required procedures. Some of these procedures 
are appropriate only for editors, and others are appropriate only for pickers, but all of them 
must appear in all editors and pickers. 

EditBirth 
PROCEDURE EditBirth (theResource: Handle; dad: ParentHandle): 

This procedure should initialize the editor data structure and create an editor window for the 
given resource type. In a picker, this procedure will do nothing and should be 
defined as 

PROCEDURE EditBirth (theResource: Handle; dad: ParentHandle): 
BEGIN 
END; 

PlckBitth 
PROCEDURE PickBirth (theType: ResType; dad: ParentHandle); 

This procedure should initialize the picker data structure and create a picker window for the 
given type. PickBirth is very similar to EditBirth except that it takes a resource type as 
a parameter instead of a resource handle. The DoPickBirth procedure can usually be used 
to take care of most initialization for a picker. In an editor, this procedure will do nothing and 
should be dermed as 

PROCEDURE PickBirth (theType: ResType; dad: ParentHandle); 
BEGIN 
END; 
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DoEvent 

PROCEDURE DoEvent(VAR evt: EventRecord; object: ParentHandle); 

DoEvent handles all events for the picker or editor. The object parameter can be locally 
defined as whatever type is appropriate (such as a P ickHandle) instead of the generic 
ParentHandle. 

Editors will normally handle all of the events (except those described in the next paragraph) 
themselves, whereas pickers should simply call P ickEvent. 

Many events are handled by the min part of the ResEdit code before the DoEvent 
procedure is called. For mouse-down events, ResEdit handles the following events: pulling 
down menus, dragging windows, Switching between windows, and converting doubleclicks 
to open commands. Update events call BeqinUpdate and EndUpdate around the call to 
DoEvent. For key-down events, the DoMenu procedure is called if the Command key was 
down (unless the key was Return, Enter, or an arrow), DoEvent is called otherwise. 
MultiFinder suspend and resume events are converted into the appropriate activate or 
deactivate events. 

DoInfoUpdate 

PROCEDURE DolnfoUpdate(oldID, newID: INTEGER; object: ParentHandle); 

This procedure is called when inforrmtion about a resouoce-for example, its ID number-is 
changed in a Get Info window. (See the Show Info procedure, discussed later in this chapter 
in the section KMiscellaneous utilities.") For editors, the DoInfoUpdate procedure should 
recalculate the window title and the name stored in the ParentHandle and pass the update 
on to its father by using the CallInfoUpdate procedure as follows: 

CallInfoUpdate(oldID, newID, objectAA.fatherAA.windA.refCon, 
objectAA.fatherAA.windA.windowKind); 

Pickers should simply call 
PickInfoUp (oldID, newID, object); 

DoMenu 

PROCEDURE DoMenu(menu, item: INTEGER; object: ParentHandle); 

DoMenu handles all menu events for the picker or editor. The object parameter can be locally 
defined as whatever type is appropriate (such as a P ickHandle) instead of the generic 
ParentHandle. 
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The main part of the ResEdit code takes care of several of the menu-handling details. All 
selections from the Apple menu are handled so that the editors and pickers do not need to 
know anything about desk accessories. All commands in the Ftle menu are also handled for 
you. The Quit command displays the Save Changes dialog box and may pass a Close 
command to all editors and pickers. If your editor needs to do some cleaning up before the 
Quit command completes, it should do so when it receives a Close or deactivate command. If 
ano• is chosen in the Save File dialog box, the frontmost window receives a deactivate event 
No events are passed to any other window. When your editor receives a Close command, it 
can call CloseNoSave to see whether edit checking should be perfonned. If the current fIle 
is being closed but the changes are not being saved, CloseNoSave will return TRUE, and 
edit checking should not be performed. 

Pickers can simply call 
PickMenu (tossOnClose, menu, item, object); 

If your picker has loaded all of the resources, it should call P ickMenu with tossOnClose 
set to TRUE so the resources are released when a Close command is received. 

Using custom IDEFs 

You will typically want to write your own picker Simply to display the resource list in a more 
meaningful way (such as dJawing the icons thermelves in the 'ICON' picker, instead of listing 
their names). You can easily accomplish this task by providing a simple picker and a custom 
IDEF that is used for dJawing the picker list When you call OoP ickBirth in your 
PickBirth procedure, pass the resource 10 of your picker as the PickerResIO parameter. 
You can get the resource 10 by calling ResEdIO. The resource ID is passed on to the LNew 
procedure. You should then provide a custom IDEF with the same resource 10. The LDEF will 
be called whenever the list needs to be updated. Please refer to the chapter on the List 
Manager in Inside Macintosh, Volume IV, for details of the workings of the 
drawProc mechanism. 

In roost cases, the DrawLDEF procedure takes care of most of the tasks required of an LDEF. 
All you have to do is provide a procedure to dJaw your resource type. 
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( The ResEd interface 

The ResEd unit contains data structures, procedures, and functions that you can access from 
your extension program They are described in the remainder of this chapter. 

Data structures 

The ResEd unit declares the data structures described in this section, which provide 
colIlJIllnication between extension programs and ResEdit. Each editor or picker has its own 
object handle. The data structure has to start with a handle to its parent's objec~ followed by 
the naIre distinguishing the father. This name will be part of the son's window tide. The next 
field should be the window of the object that may be used by the son to get back to the father 
through the ref Con in the windowRec record. The next field is the rebuild flag, which is 
used to indicate that a window's data (for example, a picker's list) must be recalculated at the 
next opportunity. For editors, the rest of the handle can have any format; pickers have 
additional data, as described in this chapter. Editors and pickers typically declare additional 
fields following the rebuild field, and can store in these additional fields global data that they 
need to access from the DoEvent, DolnfoUpdate, and DoMenu procedures. 

The naIre (in the parentRecord) for a picker should be the naIre of the file, folder, or 
disk. For editors, the name should be the complete naIre (not the window's tide), preceded 
by an editorNameChr character. An example of a complete name would be"ALRT 10· -
1234 from AFilelt• This name is used to uniquely identify a window. The window's tide is 
created by GetWindowTitle or EditorWindSetup, described later in this chapter. 

• Note: It is important for editors and pickers to follow these conventions for name and 
window tide. For pickers, it is more important that the window's tide be unique, and for 
editors, that the name be unique. The AlreadyOpen procedure uses the window's 
name and tide to determine whether the window is open. Please refer to the description 
of AlreadyOpen later in this chapter in the section "Wmdow manageIrent routineslt for 
complete information about how the name and tide are used. 
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The parent record 
ParentPtr - AParentRec; 
ParentHandle - AParentPtr; 
ParentRec - RECORD 

father: ParentHandle; 
name: Str255; 

{ Back ptr to dad } 

wind: WindowPeek; 
rebuild: BOOLEAN; Flaq set by son to indicate that } 

world has chanqed so father should 
rebuild list } 

END; 

The picker record 

The record for pickers is slightly different from the standard parent record. The first four fields 
are the same as those in the parent record The rest of the fields are specific to pickers. 

PickPtr - APickRec; 
PickHandle - APickPtr; 
ViewTypes - (viewByld, viewByName, viewBySize, 

viewByOrder, viewBySpecial); 
PickRec - RECORD 

father: 
fName: 
wind: 
rebuild: 

pickID: 
rType: 
rNum: 
rSize: 
nlnsts: 
instances: 
drawProc: 
scroll: 
viewBy: 
ldefType: 
theViewMenu: 
showAttributes: 
viewMenuMask: 
cellSize: 

END; 
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ParentHandle; 
STR255; 
WindowPtr; 
BOOLEAN; 

INTEGER; 
ResType; 
INTEGER; 
LONGINT; 
INTEGER; 
ListHandlei 
Ptr; 
ControlHandle; 
ViewTypes; 
ResTypei 
MenuHandle; 
BOOLEAN; 
LONGINT; 
Cell; 

Back ptr to dad } 

Directory window } 
Flaq set by son to 
indicate that father 
should rebuild list 
ID of this picker 

{ Type for picker } 
{ Resfile number } 
{ Size of a null resource 
{ Number of instances } 

List of instances 
List draw proc } 
Scroll bar } 
Current view type 
Which LDEF to use 
The picker view menu 
Show attrs in window? } 
Which items are enabled? 
Cell size for special view. 
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Other routines 

The required routines are called by ResEdit itself. Here are otheIS you can use. These are 
called by the editor or picker. 

launching routines 

PROCEDURE GiveEBirth (resHandle: Handle; pick: PickHandle); 

GiveEBirth starts an editor. This routine is used when a picker wants to start an editor or 
when an editor wants to start another editor (as when the 'OLOG' editor starts the 'om' 
editor). If Open Using Template was chosen or an editor is not found, the 'GNRL' (template) 
editor is started. If Open Using Hex Editor is chosen or neither an editor nor a template is 
found, the hexadecimal editor is started. A call to the appropriate editor's EditBirth 
procedure is then generated, as follows: 

EditBirth (resHandle, pick) 

In this call, ResHandle is the handle of the resource that is to be edited, and pick is the 
caller's ParentHandle. 

• Note: When an editor is starting another editor, it is important to remember that 
pick"'''' • rType and pick"'''' • rNum must be set before this routine is called. The 
editor's ParentRecord will need to be equivalent to a PickRec, at least down to the 
rNum field. The Gi veEBirth procedure looks into the P ickHandle parameter for 
information (for example, the resource type) that it needs to start up an editor. 

PROCEDURE GiveThisEBirth (resHandle: Handle; pick: PickHandle; 
openThisType:ResType); 

Gi veThisEBirth is similar to Gi veEBirth, except that it lets the caller specify the type 
of editor to open. The specified editor is opened even if Open Using Template or Open Using 
Hex Editor is chosen. If an editor of the specified type is not found, a template of the specified 
type is opened. If a template is not found, the hexadecimal editor is opened. 
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PROCEDURE GiveSubEBirth (resHandle: Handle; pick: PickHandle): 

Gi veSubEBirth starts an editor that edits a part of another type of resoun::e. For example, 
the 'om' editor uses Gi veSubEBirth to start the Oialog Item Editor. Gi veSubEBirth 
behaves exactly Uke Gi veEBirth except that the name of the resource that it looks for 
begins with a dollar sign ($) instead of a conunen::ial-at" sign (@). For example, the name of 
the 'om' editor resource is @om and the name of the 'om' subeditor resoun::e is $OITL. 
This distinction allows an editor to use the standard method for editing multiple occurrences 
of a subtype within the resoun::e. For example, a dialog item list ('om') typically contains 
several dialog items. Calling Gi veSubEBirth lets the user open multiple dialog items and 
treat them in the same way as any other windows. 

information-passing routines 

PROCEDURE CallInfoUpdate (oldID, newID: INTEGER: 
refcon: LONGINT: id: INTEGER ); 

CallInfoUpdate passes an information update command to the specified window. After 
updating its own window and data structures, each editor's DoInfoUpdate procedure 
should call this routine to pass the information update along to its parent window. This call is 
necessary since the parent may be displaying data (such as the ID or name in a picker 
window) that has been changed. An editor could pass this information along by making the 
following call: 

CallInfoUpdate (oldid, newid, fatherAA.windA.refcon, 
fatherAA.windA.windowkind); 

PROCEDURE PassMenu (menu, item: INTEGER; father: 
ParentHandle) ; 

PassMenu passes menu commands on to any son pickers or editors that you have started. 
For example, when your editor receives a Close command, it should pass that command 
along to any subeditors or information windows that it has opened by making the following 
call: 

PassMenu (fileMenu, closeItem, myObj) 

WIndow management routines 

FUNCTION AlreadyOpen (VAR windowTitle, windowName: STR255; 
dad: ParentHandle): BOOLEAN; . 

AlreadyOpen looks to see if the window is already open. If the window is open, 
AlreadyOpen activates it and returns TRUE. windowT it Ie and windowName are as 
defmed in the note immediately below. You don't need to call this function if you are using 
the PickerWindSetup or EditorWindSetup procedure. 
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• Note: You should call AlreadyOpen, to avoid opening the same resource twice. 
AlreadyOpen depends on your setting windowTitle and windowName correctly. 
For pickers, the window's title must uniquely identify the window. For editors, the name 
stored in the parentRec data structure must uniquely identify the window. The name is 
used for editors so that the window title can be simple and short. For example, the 
window title fora dialog item might be Edit DITL item #3, whereas its name would 
beEdit DITL item #3 • DITL "<resource name>" id - <num> from 
<file name>. 

PROCEDURE GrowMyWindow (minWidth, minHeight: INTEGER: 
windPtr: Windowptr: Ih: ListHandle); 

This procedure is used by pickers to grow their windows. The minWidth and minHeight 
parameters detennine the minimum size of the window; windPtr is the window to be 
grown; Ih is the list that is in the window. 

The GrowMyWindow procedure takes care of everything that is necessary to grow a picker's 
window. If necessary, the list is resized and redrawn. Two-dimensional lists (such as those 
used by the icon picker) are updated to fit as many cells as possible in the window without 
requiring horizontal scrolling. 

PROCEDURE GetWindowTitle (VAR windowTitle, windowName: STR2SS; 
addFrom: BOOLEAN; dad: ParentHandle); 

Get WindowT i t Ie constructs the window title and name for an editor. This routine should 
always be called in the DolnfoUpdate procedure, and should be called in the EditBirth 
procedure if Edi torWindSet up is not called. windowT i tIe should be used for the 
window's title. AddF rom determines whether or not the name of the file is added to the title. 
WindowName should be saved in the name field of the editor's data structure. This name is 
used later to identify the window uniquely. On input, windowTitle should contain only 
the title or the resource (for example, 'ALRT'), and windowName should contain the resource 
type (for example, 'ALRT'). If Edi torWindSet up is not used, the following code fragment 
can. be used to assure that the name and title are correct: 

GetResInfo(myResource, theID, theType, windowTitle); 
TypeToString (theType, windowTitle); 
SetETitle(myResource, windowTitle); 
windowName :- windowTitle; 
GetWindowtitle (windowTitle, windowName, TRUE, parent); 

PROCEDURE SetETitle (resHandle: Handle; VAR title: STR2SS); 
Extended Resource Manager 

SetETitle concatenates the resource's ID with its name and places the result into title. 
The res Handle paraxreter is the handle to the resource. You can use this routine when you 
are constructing a window's name or title. 
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FUNCTION WindAlloc: WindowPtr; 

WindAlloc returns a pointer to a window recoro to be used by your editor or picker. Using 
this routine instead of allocating your own window pointer can help reduce heap 
fragmentation. Because windows are pointers and must be nonrelocatable objects in the 
heap, ResEdit uses this procedure to try to allocate windowPt r pointers as low in the heap 
as possible. When this procedure is called, it usually returns a WindowPtr that it has 
previously allocated low in the heap. 

PROCEDURE WindReturn (w: WindowPtr); 

WindReturn returns a window pointer that W3S allocated by WindAlloc. Use this 
procedure when you terminate your editor or picker and you are fInished with its window. 
WindRet urn makes the memory used by the window available to another picker or editor 
for use as a new window. This helps keep the nonrelocatable window pointers as low in the 
heap as possible. 

FUNCTION WindList (w: WindowPtr; nAcross: INTEGER; 
cSize: Point; drawProc:INTEGER): ListHandle; 

WindList creates a new empty list and returns a handle to that list This procedure should 
be used by pickers to allocate their lists. W:lndList calls the LNew procedure to allocate a 
list w is the window in which the list will be created. nAcross specifIes the number of cells 
across that the list should contain. The list is allocated with 0 rows. cSize is the cSize 
parameter to LNew. drawProc is the P roc parameter to LNew. For more infonnation on 
lists and a description of the LNew pararreters, see the chapter on the Ust Manager in Inside 
Macintosh, Volume IV. Please refer to the section ·Using custom IDEFs," earlier in this 
chapter, for infonnation on specifying custom draw procedures. 

PROCEDURE WindOrigin (w: WindowPtr; dad:ParentHandle); 

WindOrigin moves the window pointed to by w to the flfSt available position in the set of 
offset poSitions; this is usually a position immediately below and to the right of the front 
window. If w is a color window, the window is positioned on the deepest available display 
device. This routine guarantees tha~ if possible, the entire window will be visible. 
WindOrigin requires the windowkind fIeld of w be set to a ResEdit value (for example by a 
call to ResEdId), and that the window size be set If you are USing the P ickerWindSet up 
or EditorWindSetup procedure, you don't need to call this procedure. 

FUNCTION PickerWindSetup(color: BOOLEAN; width, 
height: INTEGER; VAR windowTitle: STR255; 
windowKind: INTEGER; dad: ParentHandle): WindowPtr; 

PickerWindSetup should be called by pickers from the PickBirth procedure. It is similar to the 
EditorWindSetup procedure. 
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FUNCTION EditorWindSetup (dlogID: INTEGER; col9r: Boolean; 
width, height: INTEGER; VAR windowTitle, 
windowName: STR255; addFrom: BOOLEAN; 
windowKind: INTEGER; dad: ParentHandle): WindowPtr; 

EditorWindSetup should be called by editors from the EditBirth procedure to set up 
their windows. If the color pmmeter is TRUE, a color window is returned. C~lor windows 
are positioned on the deepest available display. WindowTitle, windowName, and 
addFromare passed directly to GetWindowTitle. Refer to the description of 
GetWindowTitle for details about these parameters. WindowName is returned with the 
string that should be used for the name in the ParentRecord. This routine also takes care 
of constructing the windowTitle and windowName correctly so that the window can be 
uniquely identified If dlogID is not set to noDialog, the width and height parameters should 
be set to 0 if you want to use the size stored in the DLOG resource. Use the dlogID 
parameter if you want your window to be a dialog; for nonnal windows, pass the constant 
noDialog. The windowkind parameter is used to initialize the window. Pass the result of 
a ResEdIdcall here. 

• Note: NIL is retumed if the window can't be allocated for some reason or the window is 
already allocated (that is, an editor is already open). If NIL is returned, the EditBirth 
routine should be aborted. 

Resource utDities 

FUNCTION AddNewRes (hNew: Handle; t: ResType; idNew: INTEGER; 
s: str255): BOOLEAN; 

AddNewRes has the same parameters and peIforms the same actions as the Madntosh 
procedure AddResource. The only difference is that if an error is detected, an alert is 
displayed and FAlSE is returned; TRUE is retumed otherwise. 

FUNCTION BeautifulUniquelID (t: ResType): INTEGER; 

This routine should be used instead of the toolbox procedure Unique1ID. It will return the 
fll'St unused resource ID starting with ID 128. 

FUNCTION CurrentRes: INTEGER; 

CurrentRes returns the ID number of the current resource me. This routine is the same as 
the CurResFile trap except that if CurResFile returns SysMap, this routine returns 0 
(for the System me). 
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A typical use of this routine is to save the current resource file so that it can be restored later. 
For example: 

savedResFile :- CurrentRes: 
UseResFile(someOtherRes); 

UseResFile{savedResFile); 

FUNCTION Get 1 Index (t: ResType: index: INTEGER): Handle: 

Get 1 Index is similar to the Get 1 IndResource trap. The only difference is that if the 
resource is not found, this routine will set ResError to the resourceNotFound error and 
return NIL. 

FUNCTION GetlRes (t: ResType: id: INTEGER): Handle: 

GetlRes is similar to the GetlResource trap. The only difference is that if the resource is 
not found, this routine will set ResError to the resNotFound error and return NIL. 

PROCEDURE GetlMapEntry (VAR theEntry: ResMapEntry; 
t: ResType: id: INTEGER): 

Get IMapEntry accesses the current resource map for a resource of type t and ID number 
id, placing the result in theEntry. For a desCription of resource maps, see "Format of a 
Resource File" in Inside Macintosh, Volume I, Chapter 5. 

PROCEDURE GetlIMapEntry (VAR theEntry: ResMapEntry; 
t: ResType: index: INTEGER); 

GetlIMapEntry is similar to GetlMapEntry, except that it refers to its resource by index 
instead of by ID number. 

FUNCTION NeedToRevert (my Window: windowPtr; theRes: Handle): 
Boolean: 

The NeedToRevert function should be called by all editors before they revert their 
resource. If the editor'S window is the frontmost window and the resource has been changed, 
an alert is displayed asking the user to verify that he or she really wants to revert the resource. 
If the user does want to revert the resource, the function returns a value of TRUE. Otherwise it 
returns a value of FALSE. The my Window parameter is a pointer to the editor'S window. The 
theRes parameter is the handle of the resource that is to be reverted. 
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FUNCTION NewRes (s: LONGINT; t: ResType; 1: ListHandle; 
VAR n: INTEGER): Handle; 

Given a size, s, NewRes allocates a new handle, dears it, adds it to the current resource me 
as a resource of type t with a unique ID, adds it to the list 1 (unless 1 is NIL), and returns a 
handle to the new resource. The parameter n is the item number in the list 1. If this function 
fails, it returns a NIL handle. 

FUNCTION ResEditGetlResource (theType: ResType; ID: INTEGER; 
VAR wasLoaded: BOOLEAN; VAR error: INTEGER): Handle; 

ResEditGetlResource should be used in place of the toolbox routine GetlResource. 
It's equivalent to Get lResource except for the fact that it returns a was Loaded variable to 
indicate whether the resource is already in use. If wasLoaded is returned TRUE, the caller 
should NEVER free the resource with the ReleaseResource procedure. 

PROCEDURE ResourceIDHasChanged (theObj: ParentHandle; 
theType: ResType; theOldId, theNewId: INTEGER); 

Call this procedure if you have changed the ID of a resource. If you change a resource ID and 
don't call this routine, revert won't work properly. 

FUNCTION RevertThisResource (theObj: ParentHandle; 
res: Handle): BOOLEAN; 

RevertThisResource restores a resource being edited to the state it was in before editing 
started. The parameter res is a handle to the resource. The parameter theObj is the 
ParentHandle from the current window. It is needed to determine whether the resource 
was newly added. The RevertThisResource function returns a value of FALSE if the 
resource was newly added by Res&iit (and, therefore, no longer exists after the reversion), 
and TRUE otherwise. If the resource has not been changed (its resChanged flag is not set), 
nothing is done. 

PROCEDURE RemoveResource (theRes: Handle); 

This procedure should always be used in place of the toolbox call RmveResource. It 
correctly handles resources that have the protected attribute set, by unprotecting them before 
rerooving them. The function of this routine is otherwise the same as that of the 
RmveResource toolbox procedure. 

FUNCTION SysResFile: INTEGER; 

This function returns the resource me ID of the System me. It is often necessary to take special 
precautions when accessing the System me. This function allows you to take these 
precautions without hard-coding a value for the system resource me ID, which may change in 
the future. 
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MJsce11aneous utilities 

PROCEDURE Abort: 

Abort sets the abort flag, which will stop any command that is in progress. The most 
comroon use of this command is in stopping the Quit command. For example, if an error is 
detected in a template when its window is being closed, the template editor calls Abort SO 
that processing of the Quit command will stop and the error can be corrected. 

FUNCTION WasAborted: BOOLEAN: 

WasAborted returns the state of the aborted flag (set by the Abort procedure just 
described). This function is usefu~ for example, if you have just called PassMenu with a 
Close command and you want to know if any of the windows that were closed encountered 
a problem 

PROCEDURE AbleMenu (menu: INTEGER: enable: LONGINT): 

AbleMenu enables or disables menu items. Ablemenu differs from the Resource Manager 
routines Enable Item and Disable Item in that it acts on the entire menu. The parameter 
menu is a menu IDj enable is a mask. Values used for the mask can be found in the 
ResEdfile. 

PROCEDURE BubbleUp (h: Handle); 

BubbleUp sets up the correct heap zone and then performs the Memory Manager routine 
MoveHHI. For information about MoveHHi, see Inside Macintosh, Volume II, Chapter 1. 
This routine should always be called, to avoid heap fragmentation, before the Madntosh 
procedure HLock is called for any handle. Remember to unlock any handle that you lock! 

FUNCTION BuildType (t: ResType; 1: ListHandle): INTEGER: 

Given a list that has been initialized with no rows, BuildType builds a list of all resources of 
type t from the current resource file. (See the WindList routine described earlier in this 
chapter.) If SetResLoad (FALSE) has not been called, all of the resources will be loaded 
into memory. BuildType returns a count of the number of instances that it adds to the list. 

A picker that doesn't use P ickerWindSetup can set up its window with this sequence: 
myList := WindList(myWindow, myListWidth, myCellSize, ResEdid); 
LDoDraw(FALSE, myList): {draw it later} 
Nlnsts := BuildType(myType, myList); 
LSetSelect(TRUE, Cell(O), myList); {automatically select first cell} 
LDoDraw(TRUE, myList); {ok to draw it next time} 
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PROCEDURE CenterDialog (theType: ResType; dialog: INTEGER); 

This procedure centefS dialogs or alerts on the same screen as the current port, which is 
assumed to be a window. If the dialog is in color, it is centered on the screen with the most 
colofS on which any portion of the current port appealS. Res Type can be 'DLOG' or 'ALRT; 
dialog is the resource ID of the dialog or alert. The 'DLOG' or 'ALRT' resource is loaded 
into meroory and its boundsRect is centered. When you use the dialog or alert (for example, 
in GetNewDialog) the resource will be found in memory with the correct boundsRect. 

FUNCTION CheckError (err, msgID: INTEGER): BOOLEAN; 

CheckError displays an error alert if err is nonzero. This routine has built-in alert 
messages for several errofS (such as disk write-protected, out of meroory, and so on). If 
msgId is negative, a fatal error message is retrieved from the 'STR#' resource with ID of 128. 
This resource is preloaded into meroory, and may be accessible even if a serious error has 
occurred. If msgID is nonnegative, an error message from the 'STR#' resource with ID of 129 
is displayed. If the error is not one that is built in, the string with an ID of msgID is displayed 
in the alert. TRUE is returned if err was zero, FALSE otherwise. When adding a new string 
for use by CheckError, be sure to add it to the end of the existing list in the 
'sm#' resource. 

FUNCTION CloseNoSave: BOOLEAN; 

CloseNoSa ve returns a Boolean value that indicates whether data checking should be 
performed before closing. A return value of TRUE indicates that checking should not be 
performed. For example, if the user is editing a template and there are errors in the template 
when the Quit command is chosen, the template editor should not perform edit checking if 
"no" was clicked in the Save Changes dialog box. 

FUNCTION ColorAvailable (needColorQD: BOOLEAN): BOOLEAN; 

ColorAvailable returns TRUE if color QuickDraw is available. If the needColorQD 
parameter is TRUE, an alert is displayed if color QuickDraw is not available. 

PROCEDURE ConcatStr (VAR strl: STR255; str2: STR255); 

ConcatStr concatenates str2 to strl,leaving the result in strl. 

~ Warning This routine does not check for aggregate string lengths in excess of 255 
characters. Please be carefull .. 
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FUNCTION OefaultListCellSize:INTEGER: 

Oefaul tListCellSize returns the height of a list cell with the application font (ascent + 
descent + leading). This function should be used by picketS that display resources as text 
strin~ when setting up their window. 

FUNCTION OisplayAlert (which: AlertType; id: INTEGER): 
INTEGER; 

OisplayAlert displays an alert with the given id. This routine assures that the alert 
resource is loaded from ResEdit and that the culSOr is reset to an arrow. The which 
parameter determines the kind of alert that is displayed. 

AlertType - (displayTheAlert, displayStopAlert, displayNoteAlert, 
displayCautionAlert); 

FUNCTION OisplaySTRAlert(which: AlertType; STRName: STR255: 
STRIndex: INTEGER): BOOLEAN: 

This procedure is similar to OisplayAlert except that a standard alert box is used and the 
text is retrieved from a 'STR#' resource. If you want to display an alert, just create a 'STR#' 
resource in ResEdit and call this routine with the 'STR#' resource name and the index in the 
string list of the string to be used. Whenever possible, this routine should be used instead of 
OisplayAlert. 

FUNCTION OoPickBirth(color: BOOLEAN: buildList: BOOLEAN; 
wWidth, wHeiqht, columns: INTEGER; pickerResId: INTEGER: 
pick: pickHandle): BOOLEAN: 

OoPickBirth takes care of just about everything needed to initialize a picker. If 
buildList is TRUE, the list of all of the resources will be created. Pick is the handle to a 
partially initialized P ickHandle. The fields that should be initialized before this procedure 
is called are: father, rType, viewBy, cellSize, and ldefType. The example picker 
shows how these fields should be initialized. 

PROCEOURE OrawLOEF (messaqe: INTEGER; lSelect: BOOLEAN: 
lRect: Rect; theRes: Handle: id: INTEGER: 
title: STR255: maxH, maxV: INTEGER: 
OrawResource: ProcPtr: lh: ListHandle): 

OrawLOEF is a general purpose drawing routine for graphical LDEFs like 'ICON', 'den', and 
so on. It should be called from an LDEF that is used by a picker. If title is an empty string, 
id is converted to a string and used as the tide. The dra wP roc is of the fonn: PROCEOURE 
OrawResource (lRect: Re¢t: theRes: Handle). 
Use of this procedure is shown in the example picker LDEF. 
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( PROCEDURE DrawMBarLater (forceItNow: BOOLEAN); 

DrawMBarLater should be used instead of the toolbox DrawMenuBar procedure. It will 
collect updates to the menubar but actually draw the menubar only when no other events are 
pending. Using this procedure avoids flashing the menubar as menus are added and 
rermved. If forceItNow is TRUE, the menubar is drawn immediately and any pending 
updates are cleared 

FUNCTION FindOwnerWindow (theRes: Handle): WindowPeek; 

FindOwnerWindow checks aU of ResEdit's windows to see if an editor is open for the 
specifIed resource. If you're writing an editor that uses a resource that may be in use by 
another editor (for example, two 'OLOG' resources may share the saine 'Om'), call 
FindOwnerWindow to detennine whether the resource should be released. 

PROCEDURE FixHand (s: LONGINT; h: Handle); 

FixHand makes sure that the object to which h is a handle is s bytes long. If it is longer, 
F ixHand shrinks it; if it's shorter, F ixHand expands it and fills the extension with zeros. 

PROCEDURE GetNamedStr(index: INTEGER; name: STR255; 
VAR str: STR255); 

GetNamedStr returns in str the indexth string in the 'STR#' resource named name. All 
strin~ should be stored in either 'STR#' or 'STR ' resources to maintain the international 
localizability of ResEdil 

PROCEDURE GetStr (num, list: INTEGER; VAR str: STR255); 

GetStr returns, in str, string number num from ResEdit's 'SI'R#' resource with 10 of list. 
All strings should be stored in either 'SI'R#' or 'STR ' resources to maintain the international 
localizability of ResEdil 

PROCEDURE FlashDialoqItem (dp: DialoqPtr; item: inteqer); 

FlashDialoqItemflashes (inverts) a dialog button for 8 ticks to indicate that the button 
was selected This procedure should be called from a dialog's fdter procedure. 

PROCEDURE FrameDialoqItem (dp: DialoqPtr; item: inteqer); 

FrameD ia log-Item draws a frame around a dialog button to indicate that it is the default 
button (the button that will be selected when either the Return or the Enter key is pressed). 
This procedure should be called when an update event is received by a dialog's 
fdter procedure. 
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FUNCTION GetQuickDrawVars: pQuickDrawVars; 

This function returns a pointer to the QuickDraw variables that are normally available to 
Macintosh progranuners. Because of the way that pickers and editors are implemented, they 
do not normally have access to these variables. The following types are used with 
this function: 

pQuickDrawVars - AQuickDrawVars; 
QuickDrawVArs - RECORD 

randSeed: LONGINT; 
screenBits: BitMap; 
arrow: Cursor; 
dkGray: Pattern; 
ltGray: Pattern; 
qray: Pattern; 
black: Pattern; 
white: Pattern; 
thePort: GrafPtr; 

END: { QuickDrawVars 

FUNCTION HandleCheck (h: Handle; msqID: INTEGER): BOOLEAN; 

HandleCheck checks to see if the handle h is NIL or empty. If it is either, HandleCheck 
returns FAlSE and displays an error alert, using string msqIO from ResEdit's 'STR#' resource 
ID 129. If the handle id is OK, HandleCheck returns TRUE. 

PROCEDURE MetaKeys (VAR cmd, shift, opt: BOOLEAN): 

MetaKeys returns the values of the modifier keys from the last event. Some menu 
commands that have shortcut key combinations simulate the shortcut modifier keys when the 
menu command is selected. For example, when Open Using Template is selected, 
MetaKeys indicates that the Command and Option modifier keys were pressed. Because of 
these transfonnations, MetaKeys should always be used to get the modifier values. 

PROCEDURE PickEvent (VAR evt: EventRecord; pick: PickHandle): 

P ickEvent handles an event contained in evt for a standard picker referenced by pick. 
P ickEvent should be called from your picker's DoEvent procedure. It is usually sufficient 
to call only this routine from DoEvent, with no other special processing at all. 

PROCEDURE PickInfoUp (oldID, newID: INTEGER: 
pick: PickHandle); 

P icklnfoUp handles the update necessary when a resource's ID is changed in the Get Info 
window. PickInfoUp should be called from your picker's DoInfoUpdate procedure. It is 
usually sufficient to call only this routine from DoInfoUpdate, with no other special 
processing at all. 
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PROCEDURE PickMenu (tossOnClose: Boolean; menu, item: INTEGER; 
pick: PickHandle); 

P ickMenu handles menu commands for a standard picker referenced by pick. P ickMenu 
should be called from your picker's DoMenu procedure. This routine handles all of the 
standard menu commands. If tossOnClose is TRUE, all of the resources displayed by the 
picker are released when it receives a Close command. It is usually sufficient to call only this 
routine from DoMenu. 

FUNCTION pickStdWidth: INTEGER; 

This function returns the width in pixels that should be used when creating picker windows. 
This value is obtained from the Preferences dialog box. A window of the specified width is 
guaranteed to fit on the screen. 

FUNCTION PickStdHeiqht: INTEGER; 

This function returns the height in pixels that should be used when creating picker windows. 
This value is obtained from the Preferences dialog box. A window of the specified height is 
guaranteed to fit on the screen. P ickStdHeiqht replaces the old 
PickStdRowsprocedure. 

FUNCTION PrintSetup: Handle; 

Use PrintSetup if you are doing your own printing instead of using PrintWindow. 
Return type is actually TIIPrint. The following code can be used to set up your own 
printing loop: 

myPrintHandle :- PrintSetup; 
IF myPrintHandle <> NIL THEN 

BEGIN 
PrOpen; 
IF PrError - noErr THEN 

BEGIN 
IF PrJobDialoq( myPrintHandle ) THEN 

BEGIN 
printinqPort :- PrOpenDoc(myPrintHandle, NIL, NIL ); 
IF PrError - noErr THEN 

BEGIN 
{do the usual printing loop here (see TechNote *161) 
{Warning: be careful NOT to chanqe the current resfile 
{ or the printing manager will fail 

PrCloseDoc( printingPort ); 
END; 
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END; 
PrClose; 
END; 

END; 

PROCEDURE PrintWindow (toPrint: ·PicHandle); 

PrintWindow does just that. If you pass it NIL, it will print an image of the current window. 
If you pass it a PicHand1e, it will print the picture. 

FUNCTION ResEdID: INTEGER; 

ResEdID returns the resource ID of the calling picker or editor. For editors, this value should 
be saved in the windowKind field of the editor's window. For pickers, this value should be 
saved in the P ickId field of the picker's P ickRec as well as in the windowKind field of 
the window. 

PROCEDURE SetResChanqed (h: Handle); 

SetResChanqed sets the resChanqed attribute for the specified resource and also sets 
the mapChanqed attribute for the resource fIle that contains the resource. SetResChanqed 
should be called whenever a resource is changed 

PROCEDURE SendRebuildTopickerAndFile (theType: ResType; 
parent: ParentHandle); 

This procedure sends a rebuild (sets the rebuild flag in the window's parentRecord) to all 
open picker windows of the specified type. A rebuild is also sent to the me picker in case a 
new resource type is being added This routine is useful if an editor creates a resource of 
another type. This routine should be called to make sure that the resource picker and the me 
picker are updated to reflect the addition of the new resource. For example, this routine is 
called from the 'ALRT', 'OLOG', and 'om' editors. 
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PROCEDURE SendRebuildToPicker (theType: ResType; 

parent: ParentHandle); 

This procedure is similar to SendRebuildToP icke rAndF i le except that it doesn't send 
the rebuild on to the file (what a surpriseO. 

PROCEDURE SetTheCursor (whichCursor: INTEGER); 

Set TheCursor changes the cuoor to the specified cuoor resource. The constant 
arrowCursor defined in the ResEd me should be used to set the cursor to the arrow. This 
routine makes sure that the resource me is set to ResEdit before loading the cursor, so that the 
cuoor will be loaded from either ResEdit or the System me. The most common use of this 
routine is to set the cursor to a watch (watchCursor) while something is being done that 
may take a while. 

PROCEDURE ShowInfo (h:Handle; dad: ParentHandle); 

ShowInfo puts up a Get Info window for the resource referenced by h that belongs to the 
father object referenced by dad Show Info should be called by your editor when Get Info is 
selected from the File menu. 

PROCEDURE TypeToString (t: ResType; VAR s: Str255); 

TypeToString returns a string consisting of the four chatacters that make up 
the ResType t. 

PROCEDURE UseAppRes; 

The UseAppRes procedure sets the current resource file to be the ResEdit Preferences file. 
This is necessary if you need to get a resource from ResEdi~ such as a menu, string, alert, or 
dialog box. Be sure to restore the original resource me when you are done with ResEdit's 
resource me. For example: 

SavedResFile :- CurrentRes; 
UseAppRes; 

UseResFile(SavedResFile); 
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FUNCTION Was ItLoaded: BOOLEAN; 

WasItLoadedShouJd be calJed by evety editor in the EditBirth procedure. The return 
value should be saved in the ParentRec data structure. When a Close command is received, 
the resource being edited should be released only if Was ItLoaded returned FALSE. A return 
value of TRUE means the teSOwte may already be in use by ResEdit or the System and 
therefore shouldn't be released. 

PROCEDURE WritePreferences (prefType: ResType; 
prefId: INTEGER; prefName: STR255; prefHandle: Handle); 

You can use WritePreferences to add your own preference resource to the ResEdit 
preferences me. P ref Type is the resource type that you have chosen for your preference 
resource. PrefId and prefName are the ID and name for the resource. PrefHandle is a 
handle to the preference data itself. To read your preferences you can use this code: 

myPrefs:- GetlNamedResource(prefType, prefName); 

Internal routines 

The following routines are used internally within ResEdit and may be useful in 
other circumstances. 

FUNCTION DupPick (h: Handle; c: cell; pick: PickHandle): 
Handle; 

DupP ick is called from P ickMenu and should nonnally not need to be called from any 
other procedures. 

PROCEDURE GetErrorText (error: INTEGER; VAR errorText: 
STR255); 

GetErrorText will return an error string for the given error. If no specific error text is 
found, an VO error is returned. 

FUNCTION Get Type (templatesOnly: BOOLEAN; VAR s: STR255): 
BOOLEAN; 

Get Type displays a dialog box containing a list of the types of resources that can be edited. 
The list contains all types for which there are templates. If templatesOnly is FALSE, the 
list also contains all the types for which there are editors. The selected type is returned in s. 

- TRUE is returned if a type was selected; FAlSE is returned otherwise. 

PROCEDURE KillCache; 

KillCache flushes all caches for all volumes (bitmap, control, and so on). 
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FUNCTION MapResourceType (editor: BOOLEAN; theRes: Handle; 
origResType: ResType): ResType; 

This function checks the 'RMAP' resources in ResEdit and the ResEdit preferences file to see if 
the specified resource type should be treated as if it were a different type. 

PROCEDURE MyCalcMask (srcPtr,dstPtr: Ptr; srcRow, dstRow, 
height, words: INTEGER); 

MyCalcMask calculates a mask for the given source bit image and puts it into the destination 
bit image. The pararreters srcPtr and dstPtr reference the source and destination bit 
images; srcRow, dstRow, height, and words define the area on which 
MyCalcMask operates. 

PROCEDURE NoDoubleClickHere; 

Call this procedure in your mouse-down processing code if you don't want ResEdit to convert 
a doubleclick at this location to an Open command. This should be used if a double-dick 
makes sense only in part of your window. 

FUNCTION PlaySyncSound(which: INTEGER; sndHandle: Handle): 
BOOLEAN; 

P la ySyncSound is used by the 'snd ' picker to play sounds. 

FUNCTION ResEditRes: INTEGER; 

The ResEditRes procedure returns the resource file ID of ResEdit This routine will rarely 
be needed You can use this routine if you don't want to release a resource that you have 
been editing, if the resource came from ResEdit 

FUNCTION RestoreRemovedResources (pick: PickHandle): BOOLEAN; 

This function reverts all resources of the type handled by the picker (Pick"" . rType). It 
returns true if the list needs to be rebuilt 

PROCEDURE ScrapCopy ( VAR h: Handle ); 

ScrapCopy copies the handle h into the ResEdit scrap. A different handle will be returned. 

PROCEDURE ScrapErnpty; 

ScrapEmpty empties the ResEdit and desktop scrap. 
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PROCEDURE ScrapPaste (pasteAll: BOOLEAN; typeToPaste: ResType; 
resFile: INTEGER); 

ScrapPaste pastes the resources from the ResEditscrap to the file identified by the ID 
number resFile. If pasteAll is TRUE, all resources found in the scrnp are pasted. If 
pasteAll is FAlSE, only resources oftype typeToPaste are pasted. 

The next four routines implement the color palette pop-up menu used by 
the 'MENU' editor. 

PROCEDURE InstallColorPalettePopup( whichWindow: WindowPtr; 
CQDishere, isActive: Boolean ); 

InstallColorPalettePopup sets up a palette for the window containing the system 
colors for the deepest available device. Call this procedure immediately after opening your 
window and whenever you receive an update event. whichWindow is the window 
containing the pop-up menu, CQDishere is TRUE when Color QuickDrnw is available, and 
isActi ve is TRUE when the window is the frontroost one. 

PROCEDURE DrawColorPopup( whichWindow: Windowptr; 
itemBox: Rect; whichColor: RGBColor; 
CQDishere: Boolean ); 

DrnwColorPopup draws the color patch and a drop shadow indicating that this is actually a 
pop-up menu. Call this procedure for every pop-up palette whenever you need to update the 
window contents. whichWindow is the window containing the pop-up palette, i temBox is 
the Rect to be used to drnw the color patch, whichColor is the RGBColor to be drnwn 
and CQDishere is TRUE when Color QuickDrnw is available. 

FUNCTION ColorPalettePopupSelect( whichWindow: windowPtri 
itemBox: Rect; VAR whichColor: RGBColor; 
CQDishere: Boolean ): Boolean; 

ColorPalettePopupSelect handles mouse-down events in the color palette pop-up 
menu. Call this procedure whenever you receive a mouse-down event in one of your color 
patches. whichWindow is the window containing the pop-up, i temBox is the Rect to be 
used to drnw the color patch, whichColor is the RGBCoior to be used as default and 
CQDishere is TRUE when Color QuickDraw is available. On exi~ whichColor contains 
the RGBCoior selected by the user. 

PROCEDURE DeinstallColorPalettePopup( whichWindow: WindowPtr; 
CQDishere: Boolean ); 

DeinstallColorPalet tePopup removes the palette from the window. Call this 
procedure before closing the window. 
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( Obsolete routines 

The following routines are obsolete and should no longer be used. They are no longer 
available in the current version of ResEdit 

FUNCTION CWindSetup (width, height: INTEGER; t, s: STR255): 
WindowPtr; 

Use P ickerWindSetup or EditorWindSetup instead. 

FUNCTION WindSetup (width, height: INTEGER; myType, name: 
STR255): WindowPtr 

Use PickerWindSetup or EditorWindSetup instead 

FUNCTION PickStdRows: INTEGER; 

No longer supported. Use PickStdHeight instead. 

PROCEDURE CallPBirth (theType: ResType; parent: ParentHandle; 
id: INTEGER ); 

PROCEDURE CallEBirth (resHandle: Handle; parent: ParentHandle; 
id: INTEGER ); 

PROCEDURE CallEvent( VAR evt: EventRecord; refcon: LONGINT; 
id: INTEGER ); 

PROCEDURE CallMenu (menu, item: INTEGER; refcon: LONGINT; 
id: INTEGER): 

FUNCTION CopyRes (VAR h: Handle: makeID: BOOLEAN: 
resNew: INTEGER): Handle; 

PROCEDURE DOKeyScan (var evt: EventRecord; offset: integer; 
Ih: ListHandle): 

PROCEDURE DoListEvt (e: EventRecord; 1: ListHandle); 
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Appendix A The 'KCHR' Resource 

This appendix contains more infonnation about the 'KCRR' resowte, its 
structure, and its function. The 'KCHR' resource controls mapping from the 
keyboaro to the resulting characters. This mapping process involves several 
areas of the Macintosh architecture. 
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Basic theory of keyboard operation 

In order to appreciate fully the workings of the 'KCHR' editor, you really should be aware of 
the process that it controls. Here is a summary. 

Generat1ng the virtual keycode 

Whenever a key on any type of keyboard is pressed, the operating system polls the key 
infonnation from the device. It then translates each raw keycode generated by the keyboard 
into a virtual keycode and a combination of modifier keys by means of the 'KMAP' resource. 
The resulting virtual keycode is infonnation about the key being depressed that is 
independent of the keyboard type. 

Exceptions to the rule 

Some countries have different layouts for different keyboards, lOOStiy for historical reasons. 
To deal with those exceptions, the 'itlk' resource contains a table of translation rules from a 
virtual keycode generated by the actually connected keyboard to a virtual keycode on the ISO 
ADB keyboard or to whatever keyboard is supported by the 'KCHR' resource for that country. 

Generat1ng the character code 

When the operating system has generated a virtual keycode, the KeyTrans () procedure 
then translates the virtual keycode and the concurrently pressed modifier keys into a 
Macintosh character set number based on the tables in the 'KCHR' resource. That character 
number and the virtual keycode infonnation are then stored in the event queue and can be 
accessed by calling GetNextEvent ( ) . 
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Dead keys 

When you press a dead key, the first thing you'll notice is that nothing happens immediately 
(that is, no event is fed into the queue). When you then press another key, the Event Manager 
uses the character number generated by this new key and the previously pressed dead key to 
determine which character number should be put in the event queue. This process is used, 
for example, to generate the Gennan characters with umlauts A,b,U,a,o, and U. You have to 
press the dead key for a diaeresis (which is Option-u in the u.s. 'KCHR') and then press one 
of the keys that generate the characters A,O,U,a,o, oru. (You can also generate i, and e, 
which do not exist in Gennan, but, depending on the font, possibly not their uppercase 
equivalents.) If you press a key that generates none of the dermed character numbers for this 
dead key, the Event Manager generates the nomatch character (which is, in the case discussed 
here, the umlaut alone). 

The Dead Array contains a list of dead keys. For each dead key it dermes the virtual keycode 
and the table that is used to trigger the deaD-key mechanism. It then lists pairs of completion 
characters and substitution characters and, ftnally, the nomatch characters. The whole 
deaD-key mechanism can be described as follows: 

1. Press a dead key on the keyboard. 

2. Press any key that generates a character number that corresponds to a valid 
completion character. 

You get the corresponding substitution character in the event queue. (If you didn't press a 
valid completion character in step 2, you get the nomatch character.) 
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The structure of a 'KaIR' resource 

Here is the defmition of a 'KCHR' for the resource compiler Rez. (This information can also be 
found in the fUe SysTypes.r in the folder {RIncludes) in MPW.) 

type 'KCHR' { 

} ; 

integer; 
wide array [$100] 

byte; 

1* Version 
1* Indexes 

} ; 

integer - $$CountOf(TableArray); 
array TableArray { 

wide array [$80] { 1* ASCII characters 

} ; 

char; 
} ; 

integer - $$CountOf(DeadArray); 
array DeadArray ( 

byte; 1* Table number 
byte; 1* Virtual keycode 

*/ 
*/ 

integer - $$CountOf(CompletorArray); 
wide array CompletorArray { 

char; /* Completing char 
char; 1* Substituting char 

} ; 

char; 
char; 

} ; 

1* No match char1 
1* No match char2 

*/ 
*/ 

*/ 
*/ 

*1 

*1 

Each table in the Table Array describes the virtual keycode-to-character number translation 
for one complete layer of the keyboard (that is, for all 128 possible keys). The Index Array 
defmes the mapping of modifier key combinations to tables. The high byte of the modifier 
flag (described in Inside Macintosh, Volume V, Chapter 10) is used as an index to detennine 
the number of the table to be used for translation. The information in Inside Macintosh is, 
however, not complete, because the alternate modifier keys (the Shift, Option, and Control 
keys on the right side of the ADB extended keyboard) are not mentioned. Those keys are 
normally coupled with the corresponding keys on the left side. It is possible to uncouple 
them by sending a command to the keyboard. (See "Reassigning Right Key Code" in Inside 
Macintosh, Volume V, Chapter 10.) The correct bit layout of the high byte is shown in 
Figure A-I. 
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• Figure A-I Modifier flag high byte 

1 if alternate Command key down 
1 if alternate Option key down 

1 if alternate Shift key down 

1 if Control key down 

1 if Option key down 

1 if Caps Lock down 

1 if Shift key down 

1 if Command key down 

Suppose you hold down the Option key. This keypress will result in a value of 8 (bit 3 is set) 
in the high byte of the modifier flag. Thus the Toolbox Event Manager takes the value stored 
in IndexArray [8] , which is 3 in the current U.S. 'KCRR', and therefore uses Table 3 to 
translate the keycodes to character numbers. 

Appendix A The 'KCRR' Resource 143 





Appendix B The 'BNDL' Resource 

The 'BNDL' resource bundles together icons (resource types 'ICN#, 'ics#', 
'icI4', 'idS', 'ics4', 'ics8'), me type references (resource type 'FREP), and the 
·signature" resource (whose resource type is identical to the creator field of 
the application me) for the Finder. This enables the Finder to display distinct 
icons for an application and its documents, and also enables it to launch the 
appropriate application when the user double-clicks a document. 
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The structure of a 'BNDL' resource 

The 'BNDL' resource contains a reference to the signature resource type and ID (for historical 
reasons the ID must be 0) as well as a list of resource types (almost always only 'FREP and 
'ICN", although other things are theoretically possible) and localID to resourceID mapping 
tables. The term "local" ID is used, because this ID is used within the 'BNDL' resource itself to 
tie together the flle reference and its icons. When the Finder copies the 'BNDL' resource and 
all its bundled resources to the Desktop file (or the desktop database in System 7.0), it 
actually has to change the resource ID numbers to avoid ID conflicts within the Desktop. The 
local ID numbers remain unchanged. 

The signature resource can contain anything you want, although, for historical reasons, it 
typically contains some version and copyright infonnation. The resource ID of the signature 
resource needs to be O. If you use the 'BNDL' editor in ResEdit 2.0 this resource is 
transparently created and maintained for you. 

For every file type that should be displayed with a distinct icon in the Finder there need to be 
two entries in the 'BNDL' resource, which in tum refer to one 'FREF resource, and one 'ICN#' 
resource (or an entire Finder icon family for system software version 7.0). The 'FREP resource 
contains the 4 character flle type and a reference to a local ID for an icon to be used for this 
flle type. Even if you plan to include an entire Icon Family, you only need to list the 'ICN#' 
resource in the 'BNDL' resource. The System 7.0 Finder automatically recognizes and loads all 
the other parts of the Finder Icon Family. The relationship of local ID numbers and resource 
ID numbers is shown in Figure B-1. 
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• FigureJ.l 

Fie type 

Six resources and their relationships 

mer 
o 

FREF 

Local ID Resource ID 

Resource ID 

Icon's Local ID '--________ -' '--__ --===-____ Aka Local ID 1 

In order for the Finder to recognize a 'BNDL' resource these conditions must be met: 

1) The bundle must be complete; that is, aU the resources listed here must exist and their 
relationships must be defined. If you use the 'BNDL' resource editor built into ResEdit 2.0 
you can be sure that this condition is mel 

Appendix B The 'BNDL' Resource 147 



2) The me's aeator must be identical to the signature specifted in the 'BNDL' resource and 
the fUe's fUe type must be one listed in the 'BNDL' (i.e., it must have its own 'PREP and 
corresponding 'ICNI'). Typically the fue type will be 'APPL' for application, although any 
fUe can contain 'BNDL' resources. Speciftc examples other than 'APPL' are 'INl'r and 
'CDBV'. Use the Get FilelFolder Info cornrmnd in the File menu to change the me's ft1e 
type or aeator. 

3) The fUe's Bundle bit must be set and the Inired bit must be cleared. The Finder always sets 
the Inired bit whenever it fmds a new me and reads in som: infonmtion about it By 
clearing this bit you tell the Finder to reread that infonmtion. Use the Get FileIFolder Info 
command in the rUe menu to change the Bundle and Inired bits. 

4) There must not already be a 'BNDL' resource with the same signature in the Desktop me 
(or desktop database in System 7.0). If you want to change an existing bundle (to roodify 
the icons, for example) you will need to recreate the Desktop fUe by rebooting while 
holding down the Option and Command keys. Note that by doing so you will lose all 
comments you may have entered in the Get Info windows in the rtnder in system 
software before version 7.0. 

Definitions of the 'BNDL' and 'F'REF resources 

Here are the definitions of the 'BNDL' and 'PREP resources from the MPW Types.R me: 

I*-------------------------BNDL • Bundle------------------------------*/ 
type 'SNDL' 

literal longint; 
1* Signature 

integer; 
1* Version IO 

integer - $$CountOf(TypeArray) - 1; 
array TypeArray { 

literal longint; 

*1 

1* Type *1 

*1 

integer - $$CountOf(IOArray) - 1; 

} ; 
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wide array IOArray { 
integer; 

1* Local IO 
integer; 

1* Actual IO 
} ; 

*1 

*1 



) i 

/*-------------------FREF • File Reference----------------------------*/ 
type 'FREF' ( 

) ; 

literal longinti 
/* File Type 

integer; 
/* Icon IO 

pstringi 
/* Filename 

*/ 

*/ 

*/ 
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Appendix C Resource Types Defmed for 
Rez and ResEdit 

This appendix contains a list of some resource types in use at Apple 
Computer, Inc., current as of miD-l990. An attempt has been made to give 
pertinent information about what each type is, how it is handled by the 
resource compiler, Rez, and how it is handled by ResEdit This list is neither 
formal nor exhaustive! 
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• TableCl Resource types deftned for Rez and ResEdit 

Type 

actb 
acur 
ADBS 
ALRT 

APPL 

atpl 
bmap 
BNDL 
CACH 

cctb 
CDEF 
cicn 
clut 
CMDO 

cmnu 
CNTL 
CODE 0 
CODE 
crsr 
ctab 

CTY' 
CURS 

dctb 
DICL 
DITL 
DLOG 
DRVR 
DSAT 

FBTN 
fctb 

Deftoitfoa Rez 

Alert Color Lookup Table Types.r 
Animated cursor resource Types.r 
ADB driver loaded before INIT 31 -----
Alert Template Types.r 
Application list (Desktop) 
AppleTalk Resource 
BitMap 
Bundle 
RAM Cache Control Code 
Control Color Lookup Table 
Code for drawinq controls 
Color Icon 
Generic Color Lookup Table 
For MPW commando interface 
MacApp temporary menu resource 
Control Template 
Jump Table 
Application Code 

Types.r 

Types.r 

Types.r 
Types.r 
Cmdo.r 

Types.r 

Color Cursor Types.r 
Cache Tab <list of possible cache sizes> 

City list from MAP CDEV 
Cursor 
Dialoq Color Lookup Table 
<for MacWorkstation> 
Dialoq Item List 
Dialoq Template 
Driver 
Startup alerts & code to 

MiniFinder button 
Font Color Lookup Table 

Types.r 
Types.r 

Types.r 
Types.r 
SysTypes.r 

display them 

Types.r 
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Template 
Template 

Template, Editor 
Template 

Template, Editor 

Template 

-----, Editor 
Template 

-----, Editor 
Template 

Template 
-----, Editor 
Template 

Template, Editor 
Template, Editor 
Template 

Template 
Template 

(Continued) 
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( • TableCl Resource types defmed for Rez and ResEdit (continued) 

Type 

FCMT 

FDIR 
finf 
FKEY 
fldt 

FMTR 
FOBJ 
FOND 
FONT 
FREF 
FRSV 
FWID 
gama 

GNRL 

ICON 
ICNt 
ictb 
INIT 

insc 

l)efJokfoa 

Getlnfo comments from Desktop file 

MiniFinder button directory ID 
Font information 
Function Key Code 

SysTypes.r 

List of folder names for folder msg 

Format Record 
Information about Folders 
Font Family Description 
Font Description 
File Reference 
ROM Font resources 
Font Width Table 

SysTypes.r 

SysTypes.r 
SysTypes.r 
Types.r 

SysTypes.r 
Gamma Table (color correction for screen) 

NBP Timeout and retry info for AppleTalk 

Icon 

item list 

Types.r 
Types.r Icon List 

Color dialog 
Code that is run at system startup time 

Installer Script SysTypes.r 
INTL 0 International Formatting Information 

SysTypes.r 
(-- itlO; no longer used) 

itlO International Formatting Information 
SysTypes.r 

INTL 1 International Date/Time Information 
SysTypes.r 

(-= itll; no longer used) 

ResEd1t 

Template 
Template 
Template 

Template 

Template 
Template, Editor 
Template 
Template 
Template 

, Editor 
, Editor 

Template 

-----, Editor 

Editor 

Editor 

(Continued) 
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• Tab1eC-l Resource types defined for Rez and ResEdit (condnued) 

itl1 

J)effaftloa 

International Date/Time Information 
SysTypes.r 

itl2 Intl Str Comparison package Hooks 

itl4 
itlb 
itlc 
itlk 

KCAP 
KCHR 
KEYC 

KMAP 

kscn 
KSWP 
LAYO 

LDEF 
mach 
MACS 
MBAR 
MBDF 

mcky 
mctb 
meod 
mcict 
MDEF 
mem! 
MENU 

minf 
mitq 

International Tokenize 
International Script Bundle 

SysTypes.r 
SysTypes.r 
SysTypes.r 

International Configuration SysTypes • r 
Intl exception dictionary for kchar 

SysTypes.r 
Physical Layout of Keyboard SysTypes.r 
ASCII Mapping (software) SysTypes.r 
old keyboard layout <used by old INIT 0+1> 

Keyboard Mapping (hardware) 
Keyboard/Script icon 
Keyboard Swapping 
Finder layout resource 
Code for drawing lists 
cdev filtering 
version t in system file 

SysTypes.r 
Types.r 
SysTypes.r 

SysTypes.r 

Menu Bar Types.r 
Menu bar definition procedure <Code> 

Mouse Tracking 
Menu Color Lookup Table 
MacroMaker information 
MacroMaker information 
Code for drawing menus 
MacApp memory utilization 
Menu 
Macro info (MacroMaker) 

SysTypes.r 
Types.r 

Types.r 

Default queue sizes for MakeITable 
SysTypes.r 
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BtsEdJt 

-----, Editor 

Template 
Template 
-----, Editor 

Template 

Template 
Template 

Template 
Template 

Template 
-----, Editor 

Template, Editor 
Template 
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• TableCl Resource types defmed for Rez and ResEdit (continued) 

Type 

mntb 

mppc 
NBPC 

))e6nftfno 

MacApp menu table(relate command' to menu) 

MPP Configuration Resource 
NBP configuration <AppleTalk> 

SysTypes.r 

ncts List of constants 
NFNT 

nrct 
PACK 

PAPA 

PAT 
PAT' 
PDEF 
PlCT 
pltt 
POST 

ppat 
ppt' 
PREC 

PRCO 

PRC3 
PSAP 
PTCH 
qrsc 
ROv' 
scrn 
seg! 
SERD 
SlCN 
SIGN 

Font Description SysTypes.r 
Rectangle position list SysTypes.r 
Packages of code used as ROM extensions 

Printer Access Protocol Address (AppleTalk) 

Quickdraw Pattern 
Quickdraw Pattern List 
Code to drive printers 
Quickdraw Picture 
Color Palette 
Postscript - found in Laser 

Pixel Pattern 
Array of ppats 

Types.r 
Types.r 

Types.r 
Types.r 

Prep file 

Types.r 

Printer driver's private data storage 

Default page setup info for printer 
(PRED id - 0) 

Print record (PREC id - 3) 
Just a string 
ROM Patch 
System 7.0 query resource 
ROM Resource Override 
Screen Configuration 
MacApp 
RAM serial driver 
Small Icon 

SysTypes.r 
SysTypes.r 

Types.r 

ResEdit 

Template 

Template 
, Editor 

-----, Editor 

Template 
Template 

Template 
Template 

Template 
Template 
Template 

Template 
Template 
Template 

, Editor 
Template 

(Continued) 
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• TableC·l Resource types defmed for Rez and ResEdit (continued) 

Type 

SIZE 
snd 
STR 
STRt 
styl 
TEXT 

tlst 
TMPL 

vers 
wctb 
WDEF 
WIND 
wstr 

Definition 

MultiFinder Size Information 
Sound 
PascalStyle String 
PascalStyle String List 
Style information for TextEdit 
Unlabeled string. (Same as minf) 

Title list 

ResEdit template 

Types.r 
SysTypes.r 
Types.r 
Types.r 

Version SysTypes.r 
Window Color Lookup Table Types.r 
Code for drawing windows 
Window Template Types.r 
Query str used by qrsc resource 
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ResEdit 

Template 

----- (player) 
Template 
Template 

-----, Editor 

Template 

Template 
Template 
Template 

Template, Editor 
Template 
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Appendix D The Macintosh Character Set 

This appendix contains a chart that displays the regular character set for 
Macintosh fonts. The fU'St 128 characters correspond to the standard ASCII 
character set. Please remember that not all fonts for the Macintosh have 
these standard characters in them. Specific examples are Symbol and ITC 
Zapf Dingbats; there are also many pictorial fonts avai1able as bitmaps for 
dot-matrix printing. 
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• FigureD-l Macintosh character set 
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nb!p non-breaking space (option-space on US keyboard) 
1be key labeled Delete on the US keyboard actually 
generates bs (OB) character. 

1be shaded characters cannot normally be generated 
from the Macintosh keyboard or keypad 
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( characters Display using old method 52 
Option-space 2 DisplayAlert function 117 
unprintable 2 DisplaySTRAlert function 117 

Index CheckErra function 116 Dmmenu37 
'cicn' resource editor 29, 42-45 'Dm' resource editor 28, 35-37, 87 
'cicn' resource type 3, 42 'Dm' resource type 32, 35,86, 87 
Clear 21 associated with 'ALRT' or'DLOG' 
Oose 14 32 

-83 CloseNoSave functioo 116 'DLOG' resource editor 32-34 
'annu'resource editor 69-73 'DLOG' resource type 32, 35, 86, ffl 24-bit mooitors, using ResEdl with 29 
'annu' resource type 3, 69 DoEvent procedure 101,104 @ABCD101 
'CN'It' resource editor 35 DoInfoUpdate procedure 104 

A 'CN'It' resource type 35, ffl DoMenu procedure 101, 104 
code, as resource 2 DoPickBirth function 117 

AbleMenu procedure 115 'CODE' resource type 2, 19, 98 DrawColorPopup procedure 125 
Abort procedure 115 color icon editor 29 DrawIDEF procedure 117 
AddNewRes function 112 color-dropper tool 42, 48 DrawMBarLater procedure 118 
Align to Grid 37 Color Available functioo. 116 'DRVR' resource type 25 
AlreadyOpen function 109 CoIorPalettePopupSelect function 125 Duplicate 21 
'ALRT' resource editor 32-34 CoIorTable record 55 Duplicate Table 68 
'ALRT' resource type 32, 35,87 commands, menu See individual DupPick function 123 
APDAxili command name 
Apple Developer Programs xiv ConcatStr procedure 116 E 
Applk:ation Memory size 29, 86 Convert to dead key 68 Edit dead key ••• 68 ascent 56 Q)py21 Edit menu 17 

I ASCII character set 56 corrupted resource 9 EditBirth procedure 101, 103 '- B 
CurrentRes function 113 editors 
CURS menu 46 'ALRT' 32-34 

BeautifulUnique lID function 112 'CURS' resource editor 46 bil29,87 
bit editor 3, 28, 29, ffl 'CURS' resource type 46 'B~L'38-41, 135 
bit editor tools See tools CUl21 'cicn29 
black-and-white resource 28 'cicn' 42-45 
'B~L' resource editor 38-41, 135 D 'annu' 69-73 
'BNDL' resource type 3, 38, 134-137 damaged resource 9 'CN1t' 35 
Bring to Front 37 Data -> Mask 46, 52 color icon 29 
BubbleUp procedure 115 data fork 2, 12 'CURS'46 
BuUdType function 115 default System foot 54 'Dm' 28,35-37, 87 
Bundle bit 40 DefaultListCellSize function 117 'DLOG' 32-34 
bundle resource editor 29 DeinstallColorPalettePopup procedure 'FONT' 29,54-57,87 

125 hexadecima13 
C DeRez5 'ICN" 51-52,87 
CallInfoUpdate procedure 109 descent 56 'ICON' 50, 87 
'CDRV' resource type 136 Desktop P"tie 11 'IN11! 6().61 
CenterDialog procedure 116 rebuilding 40 'illO' 6().61 
character set Developer Programs, Apple xiv 'illl' 6().61 

ASCII 56 dialog box 4 'KCHR' 62-69 
MacintQ;h 2, 56 User Items in 35 'KOIR' dead key 62 

character-editing panel 56 dialog item list 35 'MENU' 69-73 
character-selection panel 56 Dialog Manager 35 monochrome 28 

('" 
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'PAT'58 BuildType 115 GetQuickDrawVatS procedure 119 
'PAT" 59 CheckEmx' 116 GetStr procedure 118 
'SIeN' 53 CIoseNoSave 116 GetType function 123 
template 3 ColorAvaiiabie 116 GetWmOOwT1lle procedure 110 
'WIND' 30-31 ColorPa1ettePopupSelect 125 GiveEBirth procedure 108 
bundle 29 CurrenlRes 113 GiveSubEBirth procedure 100 
P'mder icon family 29,47-49,51 De&ultListCel1Size 117 GiveThisEBirth procedure 108 
menu 29 DisplayAlett 117 graphic resource 4 

EditorWindSetup function 112 DispJaySTRAlert 117 graphical resource editor 28 
eraser too142 DoPickBirth 117 graphk:s tools panel 57 
extensibilky ofResEdil4 DupPick 123 GrowMyWIOdow procedure 110 

EditorW~tup 112 HandleCheck procedure 119 
F P'wK>wnerWIOdow 118 hardware requirements xii 

'fctb' resource type 55 Getllndex 113 hexadecimal editor 4, 30 

P'J1e menu 13-}6 GetlRes 113 

file type 39,136 GetQuickDrawVatS 119 J,J 
file window 12 GetTypel23 'icl4' resource type 3, 47 
mes HandleCheck 119 'icl8' resource type 3, 47 

Desktop 11 Is'IhisYours 102 ICN#menu52 
ICON.IDEP 99, 100 MapResourceType 124 'ICN" resource editor 51-52, ff1 
ICON.Pick 99 NeedToRevert 113 'ICN" resource picker 20 
ResEdil Preferences 83 NewRes 114 'ICN" resource type 3, 39,47, 51, 134 
Types.Rl36 PkketWmdSetup 112 icon 4 
XXXXEdit99 PickStdHeigh1120 'ICON' resource editor 50, 87 

Finder 11, 89 PkkStdWidth 120 'ICON' resource type 29, 35, 50,87 
Finder icon family 47 PlaySync50und 124 Icon Vertical phase 91 
Finder icon family resource editor 29, PrinlSetup 120 ICON.IDEP me 99, 100 / 

47-49,51 ResEdID 121 ICON.Pick f.de 99 
P'mdOwnerW'1Odow function 118 ResEdilGetlResource 114 icons 
P'lXHand prcx:edure 118 ResEdilRes 124 folder 51 
FlashDiaIogItem procedure 118 RestoreRemovedResoues 124 monochrome 48 
folder kon 51 Reverl1bisResou 114 trasbcan 51 
Font Manager 55 SysResFUe 114 'ies#' resource type 3, 47 
FONT menu 68 WasAborted 115 'k:s4' resource type 3, 47 
FontIDA Mover 54, 55 WasitLoaded 123 'ics8' resource type 3, 47 
'FOND' resource type 54 WIIldAI10c 111 IDnumber 
'FONT' editor: ascent of character 56 WIl1dList 111 loc:all34 
'FONT' editor: descent of character 56 

G 
resource 134 

'FONT'resource editor 29, 54-57, ff1 ID number restriction 25 
'FONT' resource type 25, 54 general editor See hexadecimal editor 'JNrr resource type 136 
fork Get FUeIFoider Info ... 14 Inited bil40 

data 2 Get Info for This FRe 14 InstallColorPalettePopup procedure 
resource 2 Get Info window 20 125 

FrameDialogItem procedure 118 Get1IMapEnUy procedure 113 'INTL' resource editor 60-61 
'PREP' resource type 38, 134 Get1Index functial113 'IN11.' resource type 60 
functions GetlMapEnUy procedure 113 IsThisYours functk>n 102 

AddNewRes 112 GetlRes function 113 'illO' resource editor 60-61 
AlreadyOpen 109 GetEmxTeXl procedure 123 'itlO' resource type 60 
BeautifulUniqueUD 112 GetNamedStr procedure 118 'itl1' resource editor 60-61 
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. 'ill1' resoulCe type 60 W"mdow22 PickInfoUp procedure 119 
menus: ICN# 52 PickMenu procedure 105, 120 

IC MeraKeys procedure 119 PickStdHeight function 120 

KCHR menu 66, 94, 95 monochrome editor 28 PickStdWtdth function 120 

'KCIR' dead key edita 62 monochrome icon 48 pictaial resource 3 

'KCIR' resource edita 62.09 MPW DeRez command 81 pictaial resource editor 28 

'KCIR' resource type 62, 94·95, 128- MPW resource compiler and Pictorial resoulCe type 28 

131 decompiler 5 'PIer resource type 12, 35, 50, 77, 86, 
'KCIR' with MacintOOl SE, Macintosh MultiFinder 11, 89 87 

Plus, a Macinlosh 512K MyCalcMask procedure 124 Pig mode 88 

enIw1ced68 pixel editor 28 

KillCache procedure 123 N PlaySyrx:Soundfunction 124 

'KMAP' resource type 128 NeedToRevert function 113 pastRez69 

New 53 Preferences ..• 14 

L New Table 68 PrintSetup function 120 

'LA YO' resource type 4, 76, 89-93 NewOialog 88 PrintW"mdow procedure 121 

NewRes function 114 Print ... 14 
'IDEF' resource type 98 

New ... 13 procedures 
list separator 83 

'NJIN'r resource type 3, 54 AbleMenu 115 
local ID number 134 

NoDoubleClickHere procedure 124 Abort 115 

M nonexistent 'CNTL' 88 BubbleUp 115 
QlllInfoUpdate 109 

MacApp 0 CenterDialog 116 
permanent menu 69 

obsolete routine 126 
Qxx:atStr 116 

tempcnry menu 69 DeinstallColorPalettePopup 125 
,( Madntash character set 2, 56 Open Special 13 DoEvent 101, 104 
'~ MacintOOl Programmer's Workshop 5 Open Using Template 21 DoInfoUpdate 104 

MapResoUtCeType function 124 Open ... 13 DoMenu 101, 104 
marquee too128, 29 Option key 30, 35 DrawColorPopup 125 
mask 42, 48, 52 Option-space character 2 OrawlDEF 117 
'MBAR' resource type 88 oval-drawing tool 48 OrawMBarlater 118 
'mctb' resoUtCe type 3, 69 

P 
EditBirth 101,103 

'MDEF' resource type 72 P'1XHarui 118 
'MOPL' resource type 12, 86 Page Setup ... 14 FlashDialogItem 118 
memory requiremenrs xii paint bucket tool 42 PrarneOialogJtem 118 
'MENU' resource editor 29, 69-73 ParamText 32 Get1IMapEntry 113 
'MENU' resource ID 88 parent record definition 106 Get1MapEntry 113 
'MENU' resource type 3, 69 PassMenu procedure 109 GetErrorText 123 
menus Paste 21 GetNamedStr 118 

CURS 46 'PAT' resource editor 58 GetStr 118 
om 37 'PAT' resource type 58 GetWmdowTttle 110 
Edit 17 'PAT" resource editor 59 GiveEBirth lOB 
P'ue 13-16 'PAT" resource type 59 GiveSubEBirth 109 
FONT 68 pencil too128, 48 GiveThisEBirth lOB 
KCHR 66,94, 95 PickBirth procedure 103 GrowMyW"mdow 110 
Resource 17·21 picker record definition 107 InstallColorPalettePopup 125 
SIZE 68 picketS 98 KillCache 123 
Style 70 picketS: 'leN" 20 MeraKeys 119 
Transform 43, 48 PickerW"mdSetup function 112 MyCalcMask 124 
V'lew22-24 PickEvent procedure 104, 119 NoDoubleCllckHere 124 

f~ 
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PassMenu 109 'ALRI" 32, 35, ~ ResourceIDHasChanged procedure 
PickBhth 103 'BNDL' 3, 38,134-137 114 ~J 

PickEvent 104, 119 'CDEV'I36 resources 2 
PickInfoUp 119 'den'3,42 COlTUpted9 
PickMenu 105, 120 'cmnu'3,69 damaged 9 
PrlntW'mdow 121 'CNTI.' 35, ~ pictoria13 
RemoveResource 114 'CODE' 2, 19, 98 signature 41 
ResourceIDlbsChanged 114 

'CURS'46 
RestCl'eRemovedResources function 

SaapCopy 124 124 
SaapEmpty 124 'om' 32, 35, 86, ~ Revert file 14 
SaapPaste 125 'DLCX3'32,35,86,87 Revert'IhisResource function 114 
SendRebuildl'oPicker 122 'ORVR'25 Rez5 
SendRebuildfoPickerAndFde 121 'fctb'55 ROM requirements xii 
SetETJde 111 'FOND'54 'RSSC' resource type 98, 101 
SetResChanged 121 'FONT 25, 54 
SeaheCursa 122 'FREF' 38, 134 S 
ShowInfo 122 'icl4' 3, 47 sample text panel 56 
TypeToString 122 'ielS' 3, 47 Save 14 
UseAppRes 122 'ICN#' 3, 39, 47, 51, 134 SaapCopy procedure 124 
W'mdOrigin 111 'ICON' 29, 35, SO, ~ SaapEmpty procedure 124 
W'mdRetum111 
Wri1ePreferences 123 'iCs#' 3, 47 SaapPaste procedure 125 

'ics4' 3,47 Selea Item Number 37 

Q 'ics8' 3, 47 Send to Back 37 

'INrr 136 SendRebuildfoPicker procedure 122 
Qul14 

'INl1.'60 
SendRebuildfoPickerAndPi1e 

/"'" 

R 'itlO' 60 
procedure 121 

Set Item Number 37 

RAM requirements xii 
'itJl' 60 SetETllle procedure 111 

rebuilding a Desktop file 40 1CCJiR'62,~95, 1~131 SetResChanged procedure 121 

Remove dead key 68 'KMAP'I28 SetTheCursor procedure 122 

Remove duplicate tables 68 'LA~()'4, 76,~93 Shift key 29 

Remove unused tables 68 'LDEF98 ShowInfo procedure 122 

RemoveResource procedure 114 'MBAR'88 'SIeN' resource editor 53 

ResEd5,100 'mctb' 3,69 'SIeN' resource type 53, 71 

ResEdID function 121 'MDEF72 signature resource 41 

ResEdit Preferences fde 83 'MDPL'1286 SIZE menu 68 , 
software requirements xii ResEditGetlResource function 114 'MENU' 3,69 

ResEditRes function 124 'NFNr 3, 54 
'STRI' resource type 32, 81 

resource 4 'PAT'58 
straight quotation mark 2 

resource category 3 'PAT#' 59 
Style menu 70 

resource editors 27 'PIer 12, 35, SO, 77, 86, ~ 
SysResFUe function 114 

resource fde checking 9 
resource fork 2 'RSSC 98,101 T 
resource ID number 25, 134 'SICN' 53, 71 template 4, 21 
Resource menu 17-21 'sm#' 32, 81 template editor 3 
resource picker 20 'TMPL'76,BO 'TMPL' resource type 76, 80 
resource type 20 'vers' 41, 54 tool palette 29 
resource type name 2 'WIND' 30 tools 
resource types color~pper 42, 48 
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( eraser 42 
marquee 28, 29 
oval-drawing 48 
paintbucket 42 
penci128,48 

Transform menu 43, 48 
tr2Shcan icon 51 
Try Cursor 46 
24-bil monitors, using ResEdit with 29 
type checking 82 
Types.R file 136 
TypeToString procedure 122 

U 

Uncouple modif1el' keys 67 
Undo 21 
unpriJUble character 2 
Use Pull Window 37 
Use RSRe Rectangle 37 
UseAppRes procedure 122 
UseResPUe 101 
USES declar2tk>n 100 

V 

,4 Verify Resource PUe 10 , Verify Resource PUe .•. 14 
'vers' resource type 41, 54 
Vrewas ••• 67 
Vrew menu 22-24 

W 

WasAbortedfunction 115 
WasltLoaded function 123 
WIND 30 
WindAlloc function 111 
WmdList function 111 
WindOrigin procedure 111 
Window menu 22 
windows 

file 12 
Get Info 20 

'WIND' resource editor 30-31 
'WIND' resource type 30 
W"mdRetum procedure 111 
WritePreferences procedure 123 

X, Y,Z 
XXXXEdit file 99 

(, 
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1lIE APPLE pUBIJSHJNG SYSTEM 

This Apple manual was written. edired, and 
composed on a ~ publishing system using 
Apple Macintosh- computers and Microsoft- Wad 
software. Proof and final pages were created on Apple 
1aserWmerGD printers. Line art was created using 
Adobe DlustJata .... ~. the page
description language for thel:.lserWrker, was 
developed by Adobe Systems Incorporated. Saeen 
shors were taken with FIashIt. 

Text type and display type are Apple's corpaate font, 
a condensed ~ion of Garamond. BuI1ets are rrc 
Zapf Dingbats-. Some elemetts, such as progmm 
listings, are set in Apple Courier. 

Writer:Jon Singer 
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